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Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

401 5850 23074 16DA 5A22

402 5552 20250 15B0 4F1A
403 12589 14629 312D 3925

404 23008 29175 59E0 71F7
405 27636 13943 6BF4 3677

406 17600 11072 44C0 2B40
407 17000 29492 4268 7334

408 21913 5719 5599 1657
409 30320 7347 7670 1CB3

410 28240 12156 6E50 2F7C
411 7260 25623 1C5C 6417

412 17906 27725 45F2 6C4D
413 5882 28870 16FA 70C6

414 22080 31478 5640 7AF6
415 12183 28530 2F97 6F72

416 23082 24834 5A2A 6102
417 17435 9075 441B 2373

418 18527 32265 485F 7E09
419 31902 3175 7C9E 0C67

420 18783 17434 495F 441A
421 20027 12178 4E3B 2F92

422 7982 25613 1F2E 640D
423 20587 31692 506B 7BCC

424 10004 25384 2714 6328
425 13459 18908 3493 49DC

426 13383 25816 3447 64D8
427 28930 4661 7102 1235

428 4860 31115 12FC 798B
429 13108 7691 3334 1E0B

430 24161 1311 5E61 051F
431 20067 16471 4E63 4057

432 2667 15771 0A6B 3D9B
433 13372 16112 343C 3EF0

434 28743 21062 7047 5246
435 24489 29690 5FA9 73FA

436 249 10141 00F9 279D
437 19960 19014 4DF8 4A46

438 29682 22141 73F2 567D
439 31101 11852 797D 2E4C

440 27148 26404 6A0C 6724
441 26706 30663 6852 77C7

442 5148 32524 141C 7F0C
443 4216 28644 1078 6FE4

444 5762 10228 1682 27F4
445 245 23536 00F5 5BF0

446 21882 18045 557A 467D
447 3763 25441 0EB3 6361

448 206 27066 00CE 69BA
449 28798 13740 707E 35AC

450 32402 13815 7E92 35F7

. . . continued on next page
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Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

451 13463 3684 3497 0E64

452 15417 23715 3C39 5CA3
453 23101 15314 5A3D 3BD2

454 14957 32469 3A6D 7ED5
455 23429 9816 5B85 2658

456 12990 4444 32BE 115C
457 12421 5664 3085 1620

458 28875 7358 70CB 1CBE
459 4009 27264 0FA9 6A80

460 1872 28128 0750 6DE0
461 15203 30168 3B63 75D8

462 30109 29971 759D 7513
463 24001 3409 5DC1 0D51

464 4862 16910 12FE 420E
465 14091 20739 370B 5103

466 6702 10191 1A2E 27CF
467 3067 12819 0BFB 3213

468 28643 19295 6FE3 4B5F
469 21379 10072 5383 2758

470 20276 15191 4F34 3B57
471 25337 27748 62F9 6C64

472 19683 720 4CE3 02D0
473 10147 29799 27A3 7467

474 16791 27640 4197 6BF8
475 17359 263 43CF 0107

476 13248 24734 33C0 609E
477 22740 16615 58D4 40E7

478 13095 20378 3327 4F9A
479 10345 25116 2869 621C

480 30342 19669 7686 4CD5
481 27866 14656 6CDA 3940

482 9559 27151 2557 6A0F
483 8808 28728 2268 7038

484 12744 25092 31C8 6204
485 11618 22601 2D62 5849

486 27162 2471 6A1A 09A7
487 17899 25309 45EB 62DD

488 29745 15358 7431 3BFE
489 31892 17739 7C94 454B

490 23964 12643 5D9C 3163
491 23562 32730 5C0A 7FDA

492 2964 19122 0B94 4AB2
493 18208 16870 4720 41E6

494 15028 10787 3AB4 2A23
495 21901 18400 558D 47E0

496 24566 20295 5FF6 4F47
497 18994 1937 4A32 0791

498 13608 17963 3528 462B
499 27492 7438 6B64 1D0E

500 11706 12938 2DBA 328A

. . . continued on next page
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Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

501 14301 19272 37DD 4B48

502 23380 29989 5B54 7525
503 11338 8526 2C4A 214E

504 2995 18139 0BB3 46DB
505 23390 3247 5B5E 0CAF

506 14473 28919 3889 70F7
507 6530 7292 1982 1C7C

508 20452 20740 4FE4 5104
509 12226 27994 2FC2 6D5A

510 1058 2224 0422 08B0
511 12026 6827 2EFA 1AAB
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FRU Optimization/ATP Test Matrix

Usage & Background

Periodic maintenance of a site may also may mandate re–optimization of
specific portions of the site. An outline of some basic guidelines is
included in the following tables.

NOTE Re–optimization steps listed for any assembly detailed in the
tables below must be performed anytime an RF cable associated
with it is replaced.

BTS Frame

Table C-1: When RF Optimization is required on the BTS

Item Replaced Optimize:

C–CCP Shelf All sector TX and RX paths to all
Combined CDMA Channel Processor
(C–CCP) shelves.

Multicoupler/
Preselector Card

The three or six affected sector RX paths for
the C–CCP shelf in the BTS frames.

BBX board RX and TX paths of the affected C–CCP
shelf / BBX board.

CIO Card All RX and TX paths of the affected
CDMA carrier.

Any LPA Module The affected sector TX path.

LPA Backplane The affected sector TX path.

LPA Filter The affected sector TX path.

Ancillary Frame 

Item Replaced Optimize:

Directional Coupler All affected sector RX and TX paths to all
BTS frame shelves.

Site filter All affected RX sector paths in all shelves
in all BTS frames.

Any RFDS component
or TSU.

The RFDS calibration RX & TX paths
(MONFWD/GENFWD).

C



FRU Optimization/ATP Test Matrix68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP C-3

Inter-frame Cabling

Optimization must be performed after the replacement of any RF cabling
between BTS frames.

Table C-2: When to Optimize Inter–frame Cabling

Item Replaced Optimize:

Ancillary frame to BTS
frame (RX) cables

The affected sector/antenna RX
paths.

BTS frame to ancillary frame
(TX) cables

The affected sector/antenna TX paths.

Detailed Optimization/ATP Test Matrix

Table C-3 outlines in more detail the tests that would need to be
performed if one of the BTS components were to fail and be replaced. It
is also assumes that all modules are placed OOS–ROM via the LMF
until full redundancy of all applicable modules is implemented.

The following guidelines should also be noted when using this table.

NOTE Not every procedure required to bring the site back on line is
indicated in Table C-3. It is meant to be used as a guideline
ONLY. The table assumes that the user is familiar enough with
the BTS Optimization/ATP procedure to understand which test
equipment set ups, calibrations, and BTS site preparation will be
required before performing the Table # procedures referenced.

Various passive BTS components (such as the TX and RX directional
couplers, Preselector IO, CIO; etc.) only call for a TX or RX calibration
audit to be performed in lieu of a full path calibration. If the RX or TX
path calibration audit fails, the entire RF path calibration will need to be
repeated. If the RF path calibration fails, further troubleshooting is
warranted.

Whenever any C–CCP BACKPLANE is replaced, it is assumed that
only power to the C–CCP shelf being replaced is turned off via the
breaker supplying that shelf.

Whenever any DISTRIBUTION BACKPLANE is replaced it is assumed
that the power to the entire RFM frame is removed and the Preselector
I/O is replaced. The modem frame should be brought up as if it were a
new installation.

NOTE If any significant change in signal level results from any
component being replaced in the RX or TX signal flow paths, it
would be identified by re–running the RX and TX calibration
audit command.

When the CIO is replaced, the C–CCP shelf remains powered up. The
BBX boards may need to be removed, then re–installed into their
original slots, and re–downloaded (code and BLO data). RX and TX
calibration audits should then be performed.
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Table C-3: SC 4812T BTS Optimization and ATP Test Matrix
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Table 2-1 2-3
Initial Boards/Modules Install,
Prelimnary Operations, CDF
Site Equipage; etc.

D D D D D D D D D D D D D D D D D
D
** D D

Table 2-2
Table 2-5

2-6
2-14

DC Power Pre-Test Physical
Inspect

D D

Table 2-7 2-15 Initial Power-up D D D
D
** D

Table 3-11 3-34 Ping the Processors D D D D D D

Table 3-13 3-38 Download/Enable MGLIs D D D

Table 3-13 3-38 Download/Enable GLIs D D D

Table 3-14 3-39 Download CSMs D D D D

Table 3-14 3-39 Download MCCs D D D D

Table 3-14 3-39 Download BBXs D D D

Table 3-16 3-41 Enable CSMs D D

Table 3-17 3-42 Enable MCCs D D

Table 3-20 3-49 GPS Initialization /
Verification

D D D

Table 3-21 3-53 LFR Initialization /
Verification

D D

Table 3-22 3-55 HSO Initialization/Verification D D

D Required

** Replace power converters one card at a time so that power to the C–CCP or LPA shelf is not lost. If power to
the C–CCP shelf is lost, all cards in the shelf must be downloaded again.
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Table C-3: SC 4812T BTS Optimization and ATP Test Matrix
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Table 3-37 3-92 TX Path Calibration 4 4 4 1 1 4 * 3 3 4 7

Table 3-38 3-94 Download Offsets to BBX 4 4 1 4 *

Table 3-39 3-96 TX Path Calibration Audit 4 4 4 1 1 4 * 3 3 4 7

Table 3-48 3-107
RFDS Path Calibration
Procedure (see Note [) 6 6 5 4 1 1 6 * 3 3 4 6

[
RFDS Path Calibration should be performed at initial BTS installation AND after replacement of the RFDS FRU. 
RFDS Path Calibration is NOT required for other FRU replacement but may be used as an additional fault isolation tool.

Table 4-1 4-9 Spectral Purity TX Mask ATP 4 4 1 4 * * * * *

Table 4-1 4-9 Waveform Quality (rho) ATP 4 4 * 1 4 * * * * * *

Table 4-1 4-9 Pilot Time Offset ATP 4 4 * 1 4 * * * * * *

Table 4-1 4-9 Code Domain Power / Noise
Floor

4 4 1 4 8 8 8 8 * * * *

Table 4-1 4-9 FER Test 5 5 5 5 2 2 5 8 8 8 8 * 7

* Perform if necessary for additional fault isolation, repair assurance, or site certification.

1 Perform on all carrier and sector TX paths to the C–CCP cage.

2 Perform on all carrier and sector RX paths to the C–CCP cage.

3 Perform on all primary and redundant TX paths of the affected carrier.

4 Perform on the affected carrier and sector TX paths. (BBXR replacement affects all carrier and sector TX
paths.)

5 Perform on the affected carrier and sector RX paths. (BBXR replacement affects all carrier and sector RX
paths.)

6 Perform on all RF paths of the affected carrier and sector (RFDS replacement affects all carriers.)

7 Perform with redundant BBX for all sectors on all carriers.

8 Verify performance by performing on one sector of one carrier only.
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BBX Gain Set Point vs. BTS Output Considerations

Usage & Background

Table D-1 outlines the relationship between the total of all code domain
channel element gain settings (digital root sum of the squares) and the
BBX Gain Set Point between 33.0 dBm and 44.0 dBm. The resultant RF
output (as measured at the top of the BTS in dBm) is shown in the table.
The table assumes that the BBX Bay Level Offset (BLO) values have
been calculated.

As an illustration, consider a BBX keyed up to produce a CDMA carrier
with only the Pilot channel (no MCCs forward link enabled). Pilot gain
is set to 262. In this case, the BBX Gain Set Point is shown to correlate
exactly to the actual RF output anywhere in the 33 to 44 dBm output
range. (This is the level used to calibrate the BTS).

Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

dBm’

Gainb
44 43 42 41 40 39 38 37 36 35 34 33

541 – – – – – – – 43.3 42.3 41.3 40.3 39.3

533 – – – – – – – 43.2 42.2 41.2 40.2 39.2

525 – – – – – – 44 43 42 41 40 39

517 – – – – – – 43.9 42.9 41.9 40.9 39.9 38.9

509 – – – – – – 43.8 42.8 41.8 40.8 39.8 38.8

501 – – – – – – 43.6 42.6 41.6 40.6 39.6 38.6

493 – – – – – – 43.5 42.5 41.5 40.5 39.5 38.5

485 – – – – – – 43.4 42.4 41.4 40.4 39.4 38.4

477 – – – – – – 43.2 42.2 41.2 40.2 39.2 38.2

469 – – – – – – 43.1 42.1 41.1 40.1 39.1 38.1

461 – – – – – 43.9 42.9 41.9 40.9 39.9 38.9 37.9

453 – – – – – 43.8 42.8 41.8 40.8 39.8 38.8 37.8

445 – – – – – 43.6 42.6 41.6 40.6 39.6 38.6 37.6

437 – – – – – 43.4 42.4 41.4 40.4 39.4 38.4 37.4

429 – – – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3

421 – – – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1

413 – – – – 44 43 42 41 40 39 38 37

405 – – – – 43.8 42.8 41.8 40.8 39.8 38.8 37.8 36.8

397 – – – – 43.6 42.6 41.6 40.6 39.6 38.6 37.6 36.6

389 – – – – 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4

 . . . continued on next page
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Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

dBm’

Gainb
333435363738394041424344

381 – – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3

374 – – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1

366 – – – 43.9 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9

358 – – – 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7

350 – – – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5

342 – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3

334 – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1 35.1

326 – – 43.9 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9

318 – – 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7

310 – – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5

302 – – 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2

294 – 44 43 42 41 40 39 38 37 36 35 34

286 – 43.8 42.8 41.8 40.8 39.8 38.8 37.8 36.8 35.8 34.8 33.8

278 – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5 33.5

270 – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3 34.3 33.3

262 44 43 42 41 40 39 38 37 36 35 34 33

254 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7 33.7 –

246 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4 35.4 34.4 33.4 –

238 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 –

230 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9 33.9 – –

222 42.6 41.6 40.6 39.6 38.6 37.6 36.6 35.6 34.6 33.6 – –

214 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 – –
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Operating Frequency – North American PCS Bands

Introduction

Programming of each of the BTS BBX synthesizers is performed by the
BTS GLIs via the CHI bus. This programming data determines the
transmit and receive transceiver operating frequencies (channels) for
each BBX.

1900 MHz PCS Channels

Figure E-1 shows the valid channels for the North American PCS
1900 MHz frequency spectrum. There are 10 CDMA wireline or
non–wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-1: North American PCS 1900 MHz Frequency Spectrum
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Calculating 1900 MHz Center Frequencies
Table E-1 shows selected 1900 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

S TX = 1930 + 0.05 * Channel#
Example: Channel 262
TX = 1930 + 0.05*262 = 1943.10 MHz

S RX = TX – 80
Example: Channel 262
RX = 1943.10 – 80 = 1863.10 MHz

Actual frequencies used depend on customer CDMA system frequency
plan.

Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard band on
both sides of the carrier.

Minimum frequency separation required between any CDMA carrier and
the nearest NAMPS/AMPS carrier is 900 kHz (center-to-center).

Table E-1: 1900 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1931.25 1851.25

50 0032 1932.50 1852.50

75 004B 1933.75 1853.75

100 0064 1935.00 1855.00

125 007D 1936.25 1856.25

150 0096 1937.50 1857.50

175 00AF 1938.75 1858.75

200 00C8 1940.00 1860.00

225 00E1 1941.25 1861.25

250 00FA 1942.50 1862.50

275 0113 1943.75 1863.75

300 012C 1945.00 1865.00

325 0145 1946.25 1866.25

350 015E 1947.50 1867.50

375 0177 1948.75 1868.75

400 0190 1950.00 1870.00

425 01A9 1951.25 1871.25

450 01C2 1952.50 1872.50

475 01DB 1953.75 1873.75

500 01F4 1955.00 1875.00

525 020D 1956.25 1876.25

550 0226 1957.50 1877.50

575 023F 1958.75 1878.75
. . . continued on next page

E



Operating Frequency – North American PCS Bands 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPE-4

Table E-1: 1900 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal       Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

600 0258 1960.00 1880.00

625 0271 1961.25 1881.25

650 028A 1962.50 1882.50

675 02A3 1963.75 1883.75

700 02BC 1965.00 1885.00

725 02D5 1966.25 1886.25

750 02EE 1967.50 1887.50

775 0307 1968.75 1888.75

800 0320 1970.00 1890.00

825 0339 1971.25 1891.25

850 0352 1972.50 1892.50

875 036B 1973.75 1893.75

900 0384 1975.00 1895.00

925 039D 1976.25 1896.25

950 03B6 1977.50 1897.50

975 03CF 1978.75 1898.75

1000 03E8 1980.00 1900.00

1025 0401 1981.25 1901.25

1050 041A 1982.50 1902.50

1075 0433 1983.75 1903.75

1100 044C 1985.00 1905.00

1125 0465 1986.25 1906.25

1150 047E 1987.50 1807.50

1175 0497 1988.75 1908.75
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800 MHz CDMA Channels

Figure E-2 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non–wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-2: North American Cellular Telephone System Frequency Spectrum
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Calculating 800 MHz Center Frequencies

Table E-2 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

S Channels 1–777
TX = 870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03*262 = 877.86 MHz

S Channels 1013–1023
TX = 870 + 0.03 * (Channel# – 1023)
Example: Channel 1015
TX = 870 +0.03 *(1015 – 1023) = 869.76 MHz

S RX = TX – 45 MHz
Example: Channel 262
RX = 877.86 –45 = 832.86 MHz

Table E-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

1 0001 870.0300 825.0300

25 0019 870.7500 825.7500

50 0032 871.5000 826.5000
. . . continued on next page
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Table E-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

75 004B 872.2500 827.2500

100 0064 873.0000 828.0000

125 007D 873.7500 828.7500

150 0096 874.5000 829.5000

175 00AF 875.2500 830.2500

200 00C8 876.0000 831.0000

225 00E1 876.7500 831.7500

250 00FA 877.5000 832.5000

275 0113 878.2500 833.2500

300 012C 879.0000 834.0000

325 0145 879.7500 834.7500

350 015E 880.5000 835.5000

375 0177 881.2500 836.2500

400 0190 882.0000 837.0000

425 01A9 882.7500 837.7500

450 01C2 883.5000 838.5000

475 01DB 884.2500 839.2500

500 01F4 885.0000 840.0000

525 020D 885.7500 840.7500

550 0226 886.5000 841.5000

575 023F 887.2500 842.2500

600 0258 888.0000 843.0000

625 0271 888.7500 843.7500

650 028A 889.5000 844.5000

675 02A3 890.2500 845.2500

700 02BC 891.0000 846.0000

725 02D5 891.7500 846.7500

750 02EE 892.5000 847.5000

775 0307 893.2500 848.2500

NOTE
Channel numbers 778 through 1012 are not used.

1013 03F5 869.7000 824.7000

1023 03FF 870.0000 825.0000
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Operating Frequency – Korean Bands

1700 MHz PCS Channels

Figure E-3 shows the valid channels for the 1700 MHz PCS frequency
spectrum. The CDMA channels are spaced in increments of 25 (25, 50,
75, . . . 575) across the CDMA band.

Figure E-3: 1700 MHz PCS Frequency Spectrum

 FREQ (MHz)
RX              TX

575

CHANNEL
1751.2525

1778.75

1841.25

1868.75
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Calculating 1700 MHz Center Frequencies
Center frequency for channels may be calculated as follows:

Direction Formula Example

TX 1840 + (0.05 * Channel#) Channel: 1840 + (0.05 + 25) = 1841.25

RX 1750 + (0.05 * Channel#) Channel: 1750 + (0.05 + 25) = 1751.25

– Actual frequencies used depend on customer CDMA system
frequency plan.

– Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard
band on both sides of the carrier

– Minimum frequency separation required between any CDMA
carrier and the nearest NAMPS/AMPS carrier is 900 kHz (center to
center).

Table E-3: 1700 MHz TX and RX Frequency vs. Channel (Korean Bands)

Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1841.25 1751.25

50 0032 1842.50 1752.50

75 004B 1843.75 1753.75

100 0064 1845.00 1755.00

125 007D 1846.25 1756.25

150 0096 1847.50 1757.50

175 00AF 1848.75 1758.75

200 00C8 1850.00 1760.00

225 00E1 1851.25 1761.25

250 00FA 1852.50 1762.50

275 0113 1853.75 1763.75

300 012C 1855.00 1765.00

325 0145 1856.25 1766.25

350 015E 1857.50 1767.50

375 0177 1858.75 1768.75

400 0190 1860.00 1770.00

425 01A9 1861.25 1771.25

450 01C2 1862.50 1772.50

475 01DB 1863.75 1773.75

500 01F4 1865.00 1775.00

525 020D 1866.25 1776.25

550 0226 1867.50 1777.50

575 023F 1868.75 1778.75
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Test Equipment Preparation

Purpose

This appendix provides information on pre–testing set–up for the
following test equipment items (not required for the Cybertest test set):

S Agilent E7495A test equipment setup

S Agilent E4406A transmitter test set

S Agilent E4432B signal generator

S Advantest R3267 spectrum analyzer

S Advantest R3562 signal generator

S Agilent 8935 analyzer (formerly HP 8935)

S HP 8921 with PCS interface analyzer

S Advantest R3465 analyzer

S Motorola CyberTest

S HP 437 power meter

S Gigatronics 8541C power meter

S GPIB adapter

Pre–testing set–up information covered includes verification and setting
GPIB addresses, inter–unit cabling, connectivity testing, pre–test control
settings, and equipment calibration for items which are not calibrated
with the Calibrate Test Equipment function of the LMF.

The following procedures cover verification and changing GPIB
addresses for the various items of CDMA test equipment supported by
the LMF.
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Agilent R7495A Test Equipment Setup

This test equipment requires a warm-up period of at least 30 minutes
before BTS testing or calibration begins.

Using the Agilent E7495A with the LMF

The Agilent E7495A does not require the use of the 19MHz frequency
reference; if connected, it will be ignored. The Even Sec SYNC
connection is required.

The Agilent E7495A signal generator is only calibrated down to –80db.
In order to achieve accurate FER testing, be sure the RX setup includes
at least 40db of attenuation. This will ensure the signal generator will
output sufficient power to operate in the calibrated range.

Set the IP Address as described in Table F-1.

Table F-1: Set IP Address on Agilent E7495A test set

n Step Action

1 Use the System Button > Controls >IPAdmin to set an
IP address on the E7495A as 128.0.0.49, and Netmask to
255.255.255.128.

 

Connections

It is recommended that you use a hub with BNC and RJ–45 connections.
[Suggested models: Netgear model EN104 (4 port) or EN108 (8 port).
Do NOT use model numbers ending with “TP”; those have no BNC
connectors.]

The LMF will connect to the hub which in turn is connected to the BTS
and to the Agilent E7495A.

Agilent E7495A to Hub – This is an Ethernet cable, RJ–45 to RJ–45.

LMF to Hub – Use one of the following cables to connect the LMF to
the Hub:

– Ethernet cable, RJ–45 to RJ–45 (be sure that the LAN card is set for
either AUTO or to use the RJ–45 only).

– Coax cable between LAN card and Hub.  (Use a “T” on the hub and
connect a cable between the other end of the “T” and the BTS LAN
connection).

Hub to BTS – Use BNC “T” connector on the hub. [If your hub doesn’t
have BNC ports, use a BNC to UTP adapter.]
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Detecting Test Equipment

Check that no other equipment is connected to the LMF. Agilent
equipment must be connected to the LAN to detect it. Then perform the
procedures described in Table F-2.

Table F-2: Detecting Agilent E7495A Test Equipment

n Step Action

1 Click the Tools Menu.

2 Choose Options.

3 Check Agilent E7495A option in non–GPIB Test Equipment and enter its IP number.

4 Click Apply and wait a moment.

5 Click Dismiss.

 

Power Sensor Calibration

Table F-3 describes the E7495A Power Sensor Calibration.

Table F-3: E7495A Power Sensor Calibration

n Step Action

1 Display the power meter screen.

2 Zero the power meter. Make sure you are connected as shown in Figure F-1.

– Press the Zero softkey.

– Press the Continue softkey.

3 Calibrate the power meter:

– Press Ref CF.

– Enter the reference cal factor, reading it off the label on the power sensor head.

– Press Calibrate.

– Connect the power sensor (see Figure F-2).

– Press Continue.

– Press Cal Factor.

– Enter the cal factor from the label on the power sensor  head. Select a cal factor that’s within
the operating frequency of the base station.
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Figure F-1: Agilent E7495A Pre–Power Sensor Calibration connection

Use only
Agilent supplied
power adapter

GPS

GPIO

Serial 1

Serial 2

Power REF
50 MHz

Sensor

Ext Ref
In

Even Second
Sync In

Antenna

Port 1
RF Out / SWR

Port 2
RF In

POWER SENSOR
NOT CONNECTED

Figure F-2: Agilent E7495A Power Sensor Calibration connection

Use only
Agilent supplied
power adapter

GPS

GPIO

Serial 1

Serial 2

Power REF
50 MHz

Sensor

Ext Ref
In

Even Second
Sync In

Antenna

Port 1
RF Out / SWR

Port 2
RF In

POWER SENSOR
CONNECTED

Cable Calibration

Follow the directions in the WinLMF program to calibrate cables.

– Calibrate the short cable (see Figure 3-15 on page 3-64) and two 10
dB pads to get a base line and then calibrate the TX and RX setup.
Since you need at least 40 dB of loss when doing the FER test, the
setup for RX is the same as TX.

ATP Setup

TX Path Calibration setup is shown in Test Equipment Setup (see
Figure 3-18 on page 3-67).
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Verifying and Setting GPIB Address

Agilent E4406A Transmitter Tester GPIB Address
Refer to Figure F-3 and follow the procedure in Table F-4 to verify and,
if necessary, change the Agilent E4406A GPIB address.

Figure F-3: Setting Agilent E4406A GPIB Address

System Key

Bk Sp Key

Enter Key

Data Entry KeypadSoftkey Buttons

Softkey Label Display AreaActive Function Area

ti-CDMA-WP-00085-v01-ildoc-ftw

Table F-4: Verify and Change Agilent E4406A GPIB Address

Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.

– The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Config I/O softkey button to the right of the instrument screen.

– The softkey labels will change.

– The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 18, perform the following to change it:

3a Press the GPIB Address softkey button. In the on–screen Active Function Area, GPIB Address will
be displayed followed by the current GPIB address.

3b On front panel Data Entry keypad, enter the communications system analyzer GPIB address of 18.

– The GPIB Address label will change to Enter.

– Characters typed with the keypad will replace the current GPIB address in the Active Function
Area.

NOTE
To correct an entry, press Bk Sp key to delete one character at a time.

3c Press the Enter softkey button or the keypad Enter key to set the new GPIB address.

– The Config I/O softkey labels will reappear.

– The new GPIB address will be displayed under the GPIB Address softkey label.

 

F



Verifying and Setting GPIB Address68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP F-7

Agilent E4432B Signal Generator GPIB Address
Refer to Figure F-4 and follow the procedure in Table F-5 to verify and,
if necessary, change the Agilent E4432B GPIB address.

Figure F-4: Setting Agilent E4432B GPIB Address

Numeric
Keypad

Softkey
Buttons

Softkey Label
Display Area

Active Entry
Area

Backspace
Key

Utility
Key

Table F-5: Verify and Change Agilent E4432B GPIB Address

Step Action

1 In the MENUS section of the instrument front panel, press the Utility key.

– The softkey labels displayed on the right side of the instrument screen will change.

2 Press the GPIB/RS232 softkey button to the right of the instrument screen.

– The softkey labels will change.

– The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 1, perform the following to change it:

3a Press the GPIB Address softkey button.

– The GPIB Address label and current GPIB address will change to boldface.

– In the on–screen Active Entry Area, Address: will be displayed followed by the current GPIB
address.

3b On the front panel Numeric keypad, enter the signal generator GPIB address of 1.

– The GPIB Address label will change to Enter.

– Characters typed on the keypad will replace the current GPIB address in the Active Entry display.

NOTE
To correct an entry, press the backspace key at the lower right of the keypad to delete one character at
a time.

3c Press the Enter softkey button to set the new GPIB address.

– The new GPIB address will be displayed under the GPIB Address softkey label.
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Advantest R3267 Spectrum Analyzer GPIB Address
Refer to Figure F-5 and perform the procedure in Table F-6 to verify
and, if necessary, change the Advantest R3267 spectrum analyzer GPIB
address.

Figure F-5: Setting Advantest R3267 GPIB Address

�� REMOTE
LED

LCL Key

CONFIG
Key

Softkey Lable
Display Area

Softkey
Buttons

Keypad BS
Key

ENTR
Key

Table F-6: Verify and Change Advantest R3267 GPIB Address

Step Action

1 If the REMOTE LED is lighted, press the LCL key.

– The LED extinguishes.

2 Press the CONFIG key.

– CONFIG softkey labels will appear in the softkey label display area of the instrument display.

– The current GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 18, perform the following to change it:

3a Press the GPIB Address softkey. A GPIB Address entry window will open in the instrument display
showing the current GPIB address.

3b Enter 18 on the keypad in the ENTRY section of the instrument front panel.

– Characters typed on the keypad will replace the address displayed in the GPIB Address entry
window.

NOTE
To correct an entry, press the BS (backspace) key at the lower right of the keypad to delete one
character at a time.

3c Press the ENTR key to the lower right of the keypad to set the new GPIB address.

– The GPIB Address entry window closes.

– The new address is displayed in the bottom portion of the GPIB Address softkey label.
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Advantest R3562 Signal Generator GPIB Address

Set the GP–IB ADDRESS switch on the rear of the Advantest R3562
signal generator to address 1 as shown in Figure F-6.

Figure F-6: Advantest R3562 GPIB Address Switch Setting

1 2 3 4 5 6 7 8

5 4 3 2 1

GP–IP ADDRESS

1

0

GPIB Address set to “1”
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Agilent 8935 Series E6380 (formerly HP 8935) Test Set GPIB Address

Refer to Figure F-7 and follow the procedure in Table F-7 to verify and,
if necessary, change the Agilent 8935 GPIB address.

Figure F-7: Agilent 8935 Test Set

FW00885

Preset

Cursor ControlShift

Inst Config

Local

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-7: Verify and/or Change Agilent 8935 (formerly HP 8935) GPIB Address

Step Action

1 NOTE
The HP I/O configuration MUST be set to Talk & Listen, or no device on the GPIB will be
accessible. (Consult test equipment OEM documentation for additional information as required.)

To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the Agilent 8935.

– The current HP–IB address is displayed at the top of the screen.

NOTE
HP–IB is the same as GPIB.

2 If the current GPIB address is not set to 18, perform the following to change it:

2a – Press Shift and Inst Config.

2b – Turn the Cursor Control knob to move the cursor to the HP–IB Adrs field.

2c – Press the Cursor Control knob to select the field.

2d – Turn the Cursor Control knob as required to change the address to 18.

2e – Press the Cursor Control knob to set the address.

3 Press Preset to return to normal operation.
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Hewlett Packard HP8921A and HP83236A/B GPIB Address
Refer to Figure F-8 and follow the procedure in Table F-8 to verify and,
if necessary, change the HP 8921A HP 83236A GPIB addresses.

Figure F-8: HP 8921A and HP 83236A/B

Preset

Cursor Control

Shift

Local

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-8: Verify and/or Change HP 8921A and HP 83236A GPIB Addresses

Step Action

1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP 8921A.

– The current HP–IB address is displayed at the top of the screen.

NOTE
HP–IB is the same as GPIB.

2 If the current HP–IB address is not set to 18, perform the following to change it:

2a – Turn the Cursor Control knob to move the cursor to More and press the knob to select the field.

2b – Turn the Cursor Control knob to move the cursor to I/O Config and press the knob to select the
field.

2c – Turn the Cursor Control knob to move the cursor to Adrs and press the knob to select the field.

2d – Turn the Cursor Control knob to change the HP–IB address to 18 and press the knob to set the
address.

2e – Press Shift and Preset to return to normal operation.

3 To set the HP 83236A (or B) PCS Interface GPIB address=19, set the DIP switches as follows:

– A1=1, A2=1, A3=0, A4=0, A5=1, HP–IB/Ser = 1
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Advantest R3465 Communications Test Set GPIB Address

Refer to Figure F-9 and follow the procedure in Table F-9 to verify and,
if necessary, change the GPIB address for the Advantest R3465.

Figure F-9: R3465 Communications Test Set

BNC
“T”

REF UNLOCK EVEN
SEC/SYNC IN

CDMA
TIME BASE IN

POWER

OFF ON

REF FW00337LCL Shift Preset

GPIB and others

Vernier
Knob

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-9: Verify and/or Change Advantest R3465 GPIB Address

Step Action

1 To verify that the GPIB address is set correctly, perform the following:

1a – Press SHIFT then PRESET.

1b – Press LCL.

1c – Press the GPIB and Others CRT menu key to view the current address.

2 If the current GPIB address is not set to 18, perform the following to change it:

2a – Turn the vernier knob as required to select 18.

2b – Press the vernier knob to set the address.

3 To return to normal operation, press Shift and Preset.
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Motorola CyberTest GPIB Address

Follow the steps in Table F-10 to verify and, if necessary, change the
GPIB address on the Motorola CyberTest. Changing the GPIB address
requires the following items:

S Motorola CyberTest communications analyzer.

S Computer running Windows 3.1/Windows 95.

S Motorola CyberTAME software program “TAME”.

S Parallel printer port cable (shipped with CyberTest).

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-10:  Verify and/or Change Motorola CyberTest GPIB Address

Step Action

1 On the LMF desktop, locate the CyberTAME icon. Double click on the icon to run the CyberTAME
application.

2 In the CyberTAME window taskbar, under Special, select IEEE.488.2.

3 CyberTAME software will query the CyberTest Analyzer for its current GPIB address. It then will
open the IEEE 488.2 dialog box. If the current GPIB address is not 18, perform the following
procedure to change it:

3a – Use the up or down increment arrows or double–click in the field and type the number to set the
address to 18.

3b – Click on the OK button.
–– The new address will be written to the CyberTest through the parallel port and saved.

4 Verify that the address has been set by repeating steps 2 and 3.

– The new address should now appear in the IEEE 488.2 dialog box Address field.
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HP 437 Power Meter GPIB Address

Refer to Figure F-10 and follow the steps in Table F-11 to verify and, if
necessary, change the HP 437 GPIB address.

Figure F-10: HP 437 Power Meter

ENTER

PRESETSHIFT (BLUE) PUSHBUTTON –
ACCESSES FUNCTION AND

DATA ENTRY KEYS IDENTIFIED
WITH LIGHT BLUE TEXT ON
THE FRONT PANEL ABOVE

THE BUTTONS

FW00308REF

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-11: Verify and/or Change HP 437 Power Meter GPIB Address

Step Action

1 Press Shift and PRESET.

2 Use the y arrow  key to navigate to HP–IB ADRS and press ENTER.

The HP–IB address is displayed.

NOTE
HP–IB is the same as GPIB.

3 If the current GPIB address is not set to 13, perform the following to change it:

– Use the y b arrow keys to change the HP–IB ADRS to 13.

– Press ENTER to set the address.

4 Press Shift and ENTER to return to a standard configuration.

 

F



Verifying and Setting GPIB Address68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP F-15

Gigatronics 8541C Power Meter GPIB Address

Refer to Figure F-11 and follow the steps in Table F-12 to verify and, if
necessary, change the Gigatronics 8541C power meter GPIB address.

Figure F-11: Gigatronics 8541C Power Meter Detail

MENU ENTER ARROW
KEYS

1

REF FW00564

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-12: Verify and/or Change Gigatronics 8541C Power Meter GPIB Address

Step Action

1 ! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

Press MENU.

2 Use the b arrow key to select CONFIG MENU and press ENTER.

3 Use the b arrow key to select GPIB and press ENTER.

The current Mode and GPIB Address are displayed.

4 If the Mode is not set to 8541C, perform the following to change it:

Use the a ’ arrow keys as required to select MODE.

Use the by arrow keys as required to set MODE to 8541C.

5 If the GPIB address is not set to 13, perform the following to change it:

Use the ’ arrow key to select ADDRESS.

Use the by arrow keys as required to set the GPIB address to 13.

6 Press ENTER to return to normal operation.
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RS232 GPIB Interface Adapter

Be sure that the RS–232 GPIB interface adapter DIP switches are set as
shown in Figure F-12.

Figure F-12: RS232 GPIB Interface Adapter

RS232–GPIB
INTERFACE BOX

S MODE

DATA FORMAT

BAUD RATE

GPIB ADRS

ON

DIP SWITCH SETTINGS

G MODE
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Test Equipment Set-up

Purpose

This section covers other test equipment and peripherals not covered in
Chapter 3. Procedures for the manual testing are covered here, along
with procedures to calibrate the TX and RX cables using the signal
generator and spectrum analyzer.

Equipment Warm up

NOTE Warm-up BTS equipment for a minimum of 60 minutes prior to
performing the BTS optimization procedure. This assures BTS
site stability and contributes to optimization accuracy. (Time
spent running initial power-up, hardware/
firmware audit, and BTS download counts as warm-up time.)

CAUTION If any piece of test equipment (i.e., test cable, RF adapter) has
been replaced, re-calibration must be performed. Failure to do so
could introduce measurement errors, resulting in incorrect
measurements and degradation to system performance.

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment  after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

Prerequisites

Prior to performing any of these procedures, all preparations for
preparing the LMF, updating LMF files, and any other pre-calibration
procedures, as stated in Chapter 3, must have been completed.
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HP8921A System Connectivity Test

Follow the steps in Table F-13 to verify that the connections between the
PCS Interface and the HP8921A are correct, and cables are intact. The
software also performs basic functionality checks of each instrument.

NOTE Disconnect other GPIB devices, especially system controllers,
from the system before running the connectivity software.

Table F-13: System Connectivity

Step Action

NOTE
– Perform this procedure after test equipment has been allowed to warm–up and stabilize for a

minimum of 60 minutes.

1 Insert HP 83236A Manual Control/System card into memory card slot.

2 Press the [PRESET] pushbutton.

3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.

4 Position the cursor at Select Procedure Location and select by pressing the cursor control knob.

In the Choices selection box, select Card.

5 Position the cursor at Select Procedure Filename and select by pressing the cursor control knob.

In the Choices selection box, select SYS_CONN.

6 Position the cursor at RUN TEST and select it.

The software will prompt you through the connectivity setup.

7 When the test is complete, position the cursor on STOP TEST and select it; OR press the [K5]
pushbutton.

8 To return to the main menu, press the [K5] pushbutton.
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Manual Cable Calibration using HP8921 with HP PCS Interface (HP83236)
NOTE

This calibration method must be executed with great care. Some
losses are measured close to the minimum limit of the power
meter sensor (–30 dBm).

Prerequisites
Ensure the following prerequisites have been met before proceeding:

S Test equipment to be calibrated has been connected correctly for cable
calibration.

S Test equipment has been selected and calibrated.

Refer to Figure F-13 for location of the components on the PCS
Interface and Communications Test Set.

Test Equipment Set-up
Perform the procedure in Table F-14 to calibrate the test equipment
using the HP8921 Cellular Communications Analyzer equipped with the
HP83236 PCS Interface.

Table F-14: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

NOTE
Verify that GPIB controller is turned off.

1 Insert HP 83236A Manual Control System card into memory card slot (see Figure F-13).

2 Press the Preset pushbutton.

3 Under Screen Controls, press the TESTS pushbutton to display the TESTS (Main Menu) screen.

4 Position the cursor at Select Procedure Location and select it. In the Choices selection box, select
CARD.

5 Position the cursor at Select Procedure Filename and select it. In the Choices selection box, select
MANUAL.

6 Position the cursor at RUN TEST and select it. HP must be in Control Mode Select YES.

7 If using HP 83236A:
Set channel number=<chan#>:

– Position cursor at Channel
Number and select it.

– Enter the chan# using the numeric
keypad; press [Enter] and the
screen will go blank.

– When the screen reappears, the
chan# will be displayed on the
channel number line.

If using HP 83236B:
Set channel frequency:

– Position cursor at Frequency Band and press Enter.

– Select User Defined Frequency.

– Go Back to Previous Menu.

– Position the cursor to 83236 generator frequency and
enter actual RX frequency.

– Position the cursor to 83236 analyzer frequency and
enter actual TX frequency.

8 Set RF Generator level:

– Position the cursor at RF Generator Level and select it.

– Enter –10 using the numeric keypad; press [Enter] and the screen will go blank.

– When the screen reappears, the value –10 dBm will be displayed on the RF Generator Level line.

. . . continued on next page

F



Test Equipment Set-up 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPF-20

Table F-14: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

9 Set the user fixed Attenuation Setting to 0 dBm:

– Position cursor at Analyzer Attenuation and select it
– Position cursor at User Fixed Atten Settings and select it.

– Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Record the HP83236 Generator Frequency Level:

Record the HP83236B Generator Frequency Level:

– Position cursor at Show Frequency and Level Details and select it.
– Under HP83236 Frequencies and Levels, record the Generator Level.
– Under HP83236B Frequencies and Levels, record the Generator Frequency Level

(1850 – 1910 MHz for 1.9 GHz or 1750 – 1780 for 1.7 GHz).

– Position cursor at Prev Menu and select it.

12 Click on Pause for Manual Measurement.

13 Connect the power sensor directly to the RF OUT ONLY port of the PCS Interface.

14 On the HP8921A, under To Screen, select CDMA GEN.

15 Move the cursor to the Amplitude field and click on the Amplitude value.

16 Increase the Amplitude value until the power meter reads 0 dBm ±0.2 dB.

NOTE
The Amplitude value can be increased coarsely until 0 dBM is reached; then fine tune the amplitude
by adjusting the Increment Set to 0.1 dBm and targeting in on 0 dBm.

17 Disconnect the power sensor from the RF OUT ONLY port of the PCS Interface.

NOTE
The Power Meter sensor’s lower limit is –30 dBm. Thus, only components having losses ≤30 dB
should be measured using this method. For further accuracy, always re-zero the power meter
before connecting the power sensor to the component being calibrated. After connecting the
power sensor to the component, record the calibrated loss immediately.

18 Disconnect all components in the test setup and calibrate each one separately by connecting each
component, one-at-a-time, between the RF OUT ONLY PORT and the power sensor (see Figure F-13,
Setups A, B, or C). Record the calibrated loss value displayed on the power meter.

S Example: (A) Test Cable(s) = –1.4 dB
(B) 20 dB Attenuator = –20.1 dB
(B) Directional Coupler = –29.8 dB

19 After all components are calibrated, reassemble all components together and calculate the total test
setup loss by adding up all the individual losses:
S Example: Total test setup loss = –1.4 –29.8 –20.1 = –51.3 dB.

This calculated value will be used in the next series of tests.

20 Under Screen Controls press the TESTS button to display the TESTS (Main Menu) screen.

21 Select Continue (K2).

22 Select RF Generator Level and set to –119 dBm.

. . . continued on next page
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Table F-14: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

23 Click on Pause for Manual Measurement.

24 Verify the HP8921A Communication Analyzer/83203A CDMA interface setup is as follows (fields
not indicated remain at default):

S Verify the GPIB (HP–IB) address:

– under To Screen, select More

– select IO CONFIG

– Set HP–IB Adrs to 18

– set Mode to Talk&Lstn

S Verify the HP8921A is displaying frequency (instead of RF channel)

– Press the blue [SHIFT] button, then press the Screen Control [DUPLEX] button; this switches to
the CONFIG (CONFIGURE) screen.

– Use the cursor control to set RF Display to Freq

25 Refer to Table 3-31 for assistance in manually setting the cable loss values into the LMF.
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Figure F-13: Calibrating Test Setup Components
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HP PCS Interface Test Equipment Setup for Manual Testing

Follow the procedure in Table F-15 to setup the HP PCS Interface Box
for manual testing.

Table F-15: HP PCS Interface Test Equipment Setup for Manual Testing

n Step Action

NOTE
Verify GPIB controller is turned off.

1 Insert HP83236B Manual Control/System card into the memory card slot.

2 Under Screen Controls, press the [TESTS] push-button to display the TESTS (Main Menu)
screen.

3 Position the cursor at Select Procedure Location and select. In the Choices selection box, select
CARD.

4 Position the cursor at Select Procedure Filename and select. In the Choices selection box, select
MANUAL.

5 Position the cursor at RUN TEST and select OR press the K1 push-button.

6 Set channel number=<chan#>:

– Position cursor at Channel Number and select.

– Enter the chan# using the numeric keypad and then press [Enter] (the screen will blank).

– When the screen reappears, the chan# will be displayed on the channel number line.

NOTE
If using a TMPC with Tower Top Amplifier (TTA) skip Step 7.

7 S Set RF Generator level= –119 dBm + Cal factor

Example: –119 dBm + 2 dB = –117 dBm

S Continue with Step 9 (skip Step 8).

8 Set RF Generator level= –116 dBm + Cal factor.

Example: –116 dBm + 2 dB = –114 dBm

9 Set the user fixed Attenuation Setting to 0 dB:

– Position cursor at RF Generator Level and select.

– Position  cursor at User Fixed Atten Settings and select.

– Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Select Quit, then select Yes.
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Calibrating Test Cable Setup using Advantest R3465

NOTE Be sure the GPIB Interface is OFF for this procedure.

Perform the procedure in Table F-16 to calibrate the test cable setup
using the Advantest R3465. Advantest R3465 Manual Test setup and
calibration must be performed at both the TX and RX frequencies.

Table F-16: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

NOTE
– This procedure can only be performed after test equipment has been allowed to warm–up and

stabilize for a minimum of 60 minutes.

1 Press the SHIFT and the PRESET keys located below the display.

2 Press the ADVANCE key in the MEASUREMENT area of the control panel.

3 Select the CDMA Sig CRT menu key.

4 Select the Setup CRT menu key.

5 Using the vernier knob and the cursor keys set the following parameters:

NOTE
Fields not listed remain at default.

Generator Mode: SIGNAL

Link: FORWARD

Level Unit: dBm

CalCorrection: ON

Level Offset: OFF

6 Select the return CRT menu key.

7 Press FREQ key in the ENTRY area.

8 Set the frequency to the desired value using the keypad entry keys.

9 Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.

10 Verify that the Output CRT menu key is highlighting OFF; if not, press the Output key to toggle it
OFF.

11 Press the LEVEL key in the ENTRY area.

12 Set the LEVEL to 0 dBm using the key pad entry keys.

13 Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.

14 Press the Output CRT menu key to toggle Output to ON.

15 Record the power meter reading  ________________________

16 Disconnect the power meter sensor from the R3561L RF OUT jack.

. . . continued on next page
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Table F-16: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

NOTE
The Power Meter sensor lower limit is –30 dBm. Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re–zero the power meter before
connecting the power sensor to the component being calibrated.  Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 Disconnect all components in the the test setup and calibrate each one separately.  Connect each
component one–at–a–time between the “RF OUT” port and the power sensor (see Figure F-14,
“Setups A, B, and C”). Record the calibrated loss value displayed on the power meter for each
connection.

Example: (A) 1st Test Cable =  –0.5 dB
(B) 2nd Test Cable =  –1.4 dB
(C) 20 dB Attenuator =  –20.1 dB
(D) 30 dB Directional Coupler =  –29.8 dB

18 Press the Output CRT menu key to toggle Output OFF.

19 Calculate the total test setup loss by adding up all the individual losses:

Example: Total test setup loss  =  0.5 + 1.4 + 20.1 + 29.8  =  51.8 dB

This calculated value will be used in the next series of tests.

20 Press the FREQ key in the ENTRY area.

21 Using the keypad entry keys, set the test frequency to the RX frequency.

22 Repeat steps 9 through 19 for the RX frequency.

23 Refer to Table 3-31 for assistance in manually setting the cable loss values into the LMF.
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Figure F-14: Cable Calibration using Advantest R3465
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Agilent E4406A Transmitter Tester Self-alignment (Calibration)

The Agilent E4406A requires pre–calibration actions or calibration
verification that are not supported by the LMF. Follow the procedure in
Table F-17 and refer to Figure F-15 to perform the Agilent E4406A
self–alignment (calibration).

Table F-17: Agilent E4406A Self–alignment (Calibration)

Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.

– The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Alignments softkey button to the right of the instrument screen.

– The softkey labels will change.

3 Press the Align All Now softkey button.

– All other instrument functions will be suspended during the alignment.

– The display will change to show progress and results of the alignments performed.

– The alignment will take less than one minute.

Figure F-15: Agilent E4406A Self–alignment
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Notes
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Download ROM Code

Download ROM Code
ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to
OOS_ROM (blue) and remains OOS_ROM (blue). The same R–level
RAM code must then be downloaded to the device. This procedure
includes steps for both the ROM code download and the RAM code
download.

ROM code files cannot be selected automatically. The ROM code file
must be selected manually. Follow the procedure in Table G-1 to
download ROM code.

Prerequisite
S ROM and RAM code files exist for the device to be downloaded.

CAUTION The R–level of the ROM code to be downloaded must be the
same as the R–level of the ROM code for other devices in the
BTS. Code must not be mixed in a BTS. This procedure should
only be used to upgrade replacement devices for a BTS and it
should not be used to upgrade all devices in a BTS. If a BTS is
to be upgraded from one R–level to another, the optimization
and ATP procedures must first be performed with the BTS in the
original configuration. The upgrade should then be done by the
CBSC.

Table G-1: Download ROM Code

Step Action

1 Click on the device to be downloaded.

NOTE
More than one device of the same type can be selected for download by either clicking on each one to
be downloaded or from the BTS menu bar Select pull–down menu, select the device item that applies.

Where:  device  =  the type of device to be loaded (BBX, CSM, GLI, MCC)

2 Click on the Device menu.

3 Click on the Status menu item.

A status report window appears.

4 Make a note of the number in the HW Bin Type column.

NOTE
“HW Bin Type” is the Hardware Binary Type for the device. This code is used as the last four digits in
the filename of a device’s binary ROM code file. Using this part of the filename, the ROM code file
can be matched to the device in which it is to be loaded.

5 Click on the OK button to dismiss the status report window.

NOTE
ROM code is automatically selected for download from the <x>:\<lmf home
directory>\version folder>\<code folder> specified by the NextLoad property in
the bts–#.cdf file. To check the value of the NextLoad property, click on Util > Examine >
Display Nextload. A pop–up message will show the value of the NextLoad.

. . . continued on next page
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Table G-1: Download ROM Code

Step Action

6 From the BTS menu bar Device pull–down menus, select Download > ROM.

– If the file matching the Hardware Binary Type of the device is found in the code folder, a status
report shows the result of the download. Proceed to Step 12.

– If a file selection window appears, select the ROM code file manually.

7 Double–click on the version folder that contains the desired ROM code file.

8 Double–click on the Code folder.

A list of ROM and RAM code files is displayed.

! CAUTION
A ROM code file having the correct hardware binary type (HW Bin Type) needs to be chosen. The
hardware binary type (last four digits in the file name) was determined in step 4. Unpredictable results
can happen and the device may be damaged (may have to be replaced) if a ROM code file with wrong
binary type is downloaded.

9 Choose a ROM code file having the correct hardware binary type (HW Bin Type).
The hardware binary type (last four digits in the file name) was determined in step 4.

10 Click on the ROM code file that matches the device type and HW Bin Type (e.g., bbx_rom.bin.0604
for a BBX having a HW Bin Type of 0604).

The file should be highlighted.

11 Click on the Load button.

A status report window displays the result of the download.

NOTE
If the ROM load failed for some devices, load them individually by clicking on one device, perform
steps 6 through 11 for it, and repeat the process for each remaining device.

12 Click on the Ok button to close the status report window.

13 Click on the Util menu.

14 Select the Tools menu item.

15 Click on the Update NextLoad>CDMA menu item.

16 Select the version number of the folder that was used for the ROM code download.

17 Click on the Save button.

A pop–up message indicates that the CDF file has been updated.

18 Click on the OK button to dismiss the pop–up message.

19 Click on the device that was downloaded with ROM code.

20 Click on the Device menu.

21 Click on the Download Code menu item to download RAM code.

A status report window displays the result of the download.

NOTE
Data is automatically downloaded to GLI devices when the RAM code is downloaded. Use the
Download Data procedure to download data to other device types after they have been upgraded.

22 Click on the Ok button to close the status report window.

The downloaded device should be OOS_RAM (yellow) unless it is a GLI in which case it should be
INS (green).

. . . continued on next page
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Table G-1: Download ROM Code

Step Action

23 Click on the device that was downloaded.

24 Click on the Device menu.

25 Click on the Status menu item.

Verify that the status report window displays the correct ROM and RAM version numbers.

26 Click on the Ok button to close the status report window.
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Introduction

Purpose

This procedure is a guide to expanding your system with multiple
carriers while the system remains in service. This procedure also allows
you to perform on site maintenance (replace defective boards and
recalibrate) while the remainder of the site stays in service.

Motorola recommends that you perform this procedure during a
maintenance window.

This procedure cannot be performed on BTSs with 4–to–1 combiners.
The procedure can only be performed on one side of the BTS at one
time. That is, LPAs 1, 2 ,3, 7, 8, 9 (feed antennas 1, 2, 3) can be
calibrated while LPAs 6, 7, 8, 10, 11, 12 (feed antennas 4, 5, 6) remain
in service and vice versa.

Equipment Warm up

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment  after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

CAUTION If any piece of test equipment (i.e., test cable, RF adapter) has
been replaced, re-calibration must be performed. Failure to do so
could introduce measurement errors, causing incorrect
measurements and degradation to system performance.
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Power Delta Calibration

Power Delta Calibration Introduction
The In–service calibration procedure has several differences from a
normal calibration procedure. One of these is the use of a spectrum
analyzer instead of a power meter to measure power. Power meters are
broadband measurement devices and cannot be used to measure power
during In–service Calibration since other carriers are operating. A
spectrum analyzer can be used because it measures power at a given
frequency. However, measuring power using a spectrum analyzer is less
accurate than using a power meter. Therefore, you must compensate for
the difference (delta) between the power meter and the spectrum
analyzer.

HP8921A Power Delta Calibration
Use the HP8921A Spectrum Analyzer to measure power during
In–Service Calibration for 800 MHz systems. After the offset value has
been calculated, add it to the TX cable loss value.

Follow the procedure in Table H-1 to perform the HP8921A Power Delta
Calibration procedure.

NOTE This procedure requires two HP8921As.

Table H-1: HP8921A Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8921A Duplex Out port and the HP437B power sensor (see
Figure H-1).

2 Set the HP8921A signal source as follows:

– Measure mode to CDMA Generator
– Frequency to the CDMA Calibration target frequency

– CW RF Path to IQ

– Output Port to Dupl

– Data Source to Random

– Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

5 Turn off the source HP8921A signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8921A for convenience in the following steps.

6 Connect the short RF cable between the source HP8921A Duplex Out port and the measuring
HP8921A RF–IN port (see Figure H-2).

. . . continued on next page
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Table H-1: HP8921A Power Delta Calibration Procedure

Step Action

7 Ensure that the source HP8921A settings are the same as in Step 2.

8 Set the measuring HP8921A as follows:

– Measure mode to CDMA Anl
– Frequency to the CDMA calibration target frequency

– Input Attenuation to 0 dB

– Input port to RF–IN

– Gain to Auto

– Analyzer Direction to Fwd

9 Turn on the source HP8921A signal output.

10 Measure and record the channel power reading on the measuring HP8921A as result
B ________________________.

11 Turn off the source HP8921A signal output and disconnect the equipment.

12 Compute the delta between HP437B and HP8921A using the following formula:

Delta = A – B
Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table H-5).

 

Figure H-1: Delta Calibration Setup – HP8921A to HP437B
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Figure H-2: Delta Calibration Setup – HP8921A to HP8921A
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Advantest R3465 Power Delta Calibration

Follow the procedure in Table H-2 to perform the Advantest R3465
Power Delta Calibration procedure.

Table H-2: Advantest Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

On the Advantest R3465:

1 Press the SHIFT and the PRESET keys located below the CRT display.

2 Press the ADVANCE key in the Measurement area of the control panel.

3 Press the CDMA Sig CRT menu key.

4 Press the FREQ key in the Entry area of the control panel.

5 Set the frequency to the desired value using the keypad entry keys.

6 Press the LEVEL key in the Entry area of the control panel.

7 Set the LEVEL to 0 dBm using the keypad entry keys.

8 Verify the Mod CRT menu key is highlighting OFF, if not press the Mod key to toggle it OFF.

9 Verify the Output CRT menu key is highlighting OFF. If not, press the Output key to toggle it OFF.

On the HP 437 Power Meter:

10 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

11 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the power sensor
(see Figure H-3).

12 Press the Output CRT menu key to toggle the Output to ON.

. . . continued on next page
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Table H-2: Advantest Power Delta Calibration Procedure

Step Action

13 Record the Power Meter reading as result A ________________________.

14 Press the Output CRT menu key to toggle the Output to OFF.

15 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the Spectrum
Analyzer INPUT Port (see Figure H-4).

16 Press the Output CRT menu key to change the Output to ON.

17 Press the CW key in the Measurement area of the control panel.

18 Press the LEVEL key in the Entry area of the control panel.

19 Set the REF LEVEL to 10 dBm using the keypad entry keys.

20 Press the dB/div CRT menu key.

21 Press the 10 dB/div CRT menu key.

22 Press the FREQ key in Entry area of the control panel.

23 Set the frequency to the desired value using the keypad entry keys.

24 Press the more 1/2 CRT menu key.

25 Press the Preselector CRT menu key to highlight 3.0G.

26 Press the FORMAT key in the Display Control area of the control panel.

27 Press the TRACE CRT menu key.

28 Press the AVG A CRT menu key.

29 Set AVG to 20 using keypad entry keys.

30 Press the return CRT menu key.

31 Press the SPAN key in the Entry area of the control panel.

32 Press the Zero Span CRT menu key.

33 Press the BW key in the Entry area of the control panel.

34 Press the RBW CRT menu key to highlight MNL.

35 Set RBW to 30 kHz using keypad entry keys.

36 Press the VBW CRT menu key to highlight MNL.

37 Set VBW to 1 MHz using keypad entry keys.

38 Press the Marker ON key in the Display Control area of the control panel.

39 Record the Marker Level reading as result B ________________________.

. . . continued on next page
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Table H-2: Advantest Power Delta Calibration Procedure

Step Action

40 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table H-5).

 

Figure H-3: Delta Calibration Setup – R3561L to HP437B
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HP8935 Power Delta Calibration

Follow the procedure in Table H-3 to perform the HP8935 Power Delta
Calibration procedure.

Table H-3: HP8935 Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8935 Duplex Out port and the HP437B power sensor (see
Figure H-5).

2 Set the HP8935 signal source as follows:

– Measure mode to CDMA Gen
– Frequency to the CDMA Calibration target frequency

– CW RF Path to IQ

– Output Port to Dupl

– Data Source to Random

– Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

5 Turn off the source HP8935 signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8935 for convenience in the following steps.

6 Connect the short RF cable between the source HP8935 Duplex Out port and the RF–IN/OUT port
(see Figure H-6).

7 Ensure that the source HP8935 settings are the same as in Step 2.

8 Set the measuring HP8935 as follows:

– Measure mode to CDMA Anl
– Frequency to the CDMA calibration target frequency

– Input Attenuation to 0 dB

– Input port to RF–IN

– Gain to Auto

– Anl Dir to Fwd

9 Turn on the source HP8935 signal output.

10 Set the Chn Pwr Cal to Calibrate and select to calibrate.

11 Measure and record the channel power reading on the measuring HP8935 as result
B ________________________.

12 Turn off the source HP8935 signal output and disconnect the equipment.

. . . continued on next page
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Table H-3: HP8935 Power Delta Calibration Procedure

Step Action

13 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table H-5).

 

Figure H-5: Delta Calibration Setup – HP8935 to HP437B
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Figure H-6: Delta Calibration Setup – HP8935 to HP8935
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Agilent E4406A Power Delta Calibration

The Agilent E4406A transmitter tester and E4432B signal generator test
equipment combination can be used for ISC of IS–2000 CDMA 1X as
well as IS–95A/B operation modes. The power delta calibration is
performed on the E4406A, but the E4432B is required to generate the
reference signal used to calculate the power delta offset. After the offset
value has been calculated, add it to the TX cable loss value in the LMF.

Follow the procedure in Table H-4 to perform the Agilent E4406A
Power Delta Calibration procedure.

Table H-4: Agilent E4406A Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of the Optimization/Calibration chapter in the SC 4812T
Optimization/ATP manual.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

2 Connect a short RF cable from the E4432B RF OUTPUT connector the HP437 power meter power
sensor (see Figure H-7).

3 Set the E4432B signal generator as follows:

– Press Preset to exit any modes for which the signal generator is configured.

– Press Frequency and enter the frequency of the channel to be calibrated using the numeric
keypad.

– Using the soft keys to the right of the screen, select the frequency range to be measured (for
example, MHz).

– Press Amplitude and, using the numeric keypad, set signal amplitude to 0 (zero).

– Using the soft keys, set the measurement type to dBm.

4 On the E4432B, press RF On/Off to toggle the RF output to RF ON.

– Note that the RF On/Off status in the screen display changes.

5 Measure and record the value reading on the HP437 power meter as result A____________________.

6 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

– Note that the RF On/Off status in the screen display changes.

7 Disconnect the short RF cable from the HP437 power meter power sensor, and connect it to the
RF INPUT connector on the E4406A transmitter tester (see Figure H-8).

. . . continued on next page

H



Power Delta Calibration68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP H-11

Table H-4: Agilent E4406A Power Delta Calibration Procedure

Step Action

NOTE
Do not change the frequency and amplitude settings on the E4432B when performing the following
steps.

8 Set the E4406A as follows:

– Press Preset to exit any modes for which the transmitter tester is configured.

– Press MODE and, using the soft keys to the right of the screen, select cdmaOne.

– Press MEASURE and, using the soft keys, select spectrum.

– Press Frequency and, using the soft keys, select Center Frequency.

– Using the numeric keypad. enter the frequency of the channel to be calibrated.

– Using the soft keys, select the frequency range to be measured (for example, MHz).

– Press Input/Output and, using the soft keys, select Input Atten.

– Using the numeric keypad, set Input Atten to 0 (zero) and, using the soft keys, select dB.

– Using the soft keys, select External Atten and then select Mobile.

– Using the numeric keypad, set Mobile to 0 (zero) and, using the soft keys, select dB.

– Using the soft keys, select Base.

– Using the numeric keypad, set Base to 0 (zero) and, using the soft keys, select dB.

– Press MEASURE and, using the soft keys, select Channel Power.

9 On the E4432B signal generator, press RF On/Off to toggle the RF output to RF ON.

– Note that the RF On/Off status in the screen display changes.

10 Read the measured Channel Power from the E4406A screen display and record it as 
result B____________________.

11 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

– Note that the RF On/Off status in the screen display changes.

12 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Agilent measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see step 4 in
Table H-5).
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Figure H-7: Delta Calibration Setup – Agilent E4432B to HP437
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In–Service Calibration
CAUTION This feature does NOT have fault tolerance at this time. The

system has no safe–guards to stop you from doing something
that will take the BTS out of service. If possible, perform this
procedure during a maintenance window.

Follow the procedures in this section precisely, otherwise the
entire BTS will most likely go OUT OF SERVICE.

At the CBSC, only perform operations on expansion hardware
when it is in the OOS_MANUAL state.

The operator must be trained in the LMF operation prior to
performing this procedure.

Prerequisites
S Expansion hardware has been added in the CBSC database, and the

CDF file has been generated.

S The expansion devices have been inserted into the C–CCP cage and
are in the OOS_MANUAL state at the CBSC.

S The site specific cdf (with the expansion hardware) and cal files have
been loaded onto the LMF.

S The LMF has the same code and dds files as the CBSC to download.

CAUTION Do not download code or data to any cards other than those you
are working on. Downloading code or data to other cards will
take the site OUT OF SERVICE.

The code file version numbers must match the version numbers
on the other cards in the frame. If the numbers do not match, the
site may go OUT OF SERVICE.

The BTS–#.cdf, CBSC–#.cdf, and CAL files for this BTS must
have come from the CBSC.

S Test equipment has been configured per Figure H-9 and Figure H-10.

S An RFDS (or at a minimum a directional coupler), whose loss is
already known, must be in line to perform the in–service calibration.

S Test equipment has been calibrated after 1 hour warm up.

S A short RF cable and two BNC–N adapters are available to perform
Cable Calibration.

S The Power Delta Calibration has been performed (see Table H-1,
Table H-2, or Table H-3).
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Figure H-9: Optimization/ATP Test Setup Using RFDS
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Figure H-10: IS–95 A/B/C Optimization/ATP Test Setup Using RFDS
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Follow the procedure in Table H-5 to perform the In–Service
Calibration.

Table H-5: In–Service Calibration

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Set up the LMF for In–Service Calibration:

– Start the LMF by double–clicking the LMF icon on the Windows desktop.

– Click Tools>Options from the menu bar at the login screen.

– Check the applicable spectrum analyzer check box and the signal generator check box on the Test
Equipment tab.
Ensure that the GPIB address is 18 for the CDMA analyzer and 1 for the signal generator.

– Uncheck any other other equipment that is selected.

– Click the Apply button.

– Select the BTS Options tab in the LMF Option window.

– Check the In–Service Calibration check box.

– Click the Apply button.

– Click the Dismiss button to close the LMF Option window.

2 Login to the target BTS:

– Select the target BTS icon.

– Click the Login button at the login screen.

3 Measure the Cable Loss using the Cable Calibration function:

– Click Util>Cable Calibration from the menu bar at the main window.

– Set the desired channel(s) and select TX and RX CABLE CAL at the cable calibration pop up
window.

– Click the OK button to perform cable calibration.

– Follow the on–screen instructions to complete the cable loss measurement.

NOTE
– The measured value is input automatically to the cable loss file.

– To view the cable loss file, click Util>Examine>Cable Loss>TX or RX.

4 Add the spectrum analyzer power delta to the Cable Loss.

– To view the cable loss file, click Util>Examine>Cable Loss>TX or RX.

– Add the value computed in Table H-1, Table H-2, or Table H-3 to the TX Cable Loss.

NOTE
Be sure to include the sign of the value. The following examples are included to show the mathematics
and do not represent actual readings:

– Example: 5.65 dBm + 0.55 dBm = 6.20 dBm

– Example: 5.65 dBm + (–0.29 dBm) = 5.36 dBm

– Example: –5.65 dBm + 0.55 dBm = –5.10 dBm

– Example: –5.65 dBm + (–0.29 dBm) = –5.94 dBm

. . . continued on next page
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Table H-5: In–Service Calibration

Step Action

5 Input the Coupler Loss for the TX and RX tests:

– Click Util>Edit>Coupler Loss>TX or RX from the menu bar at the main window.

– Input the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

– Click the Save button.

– Click the Dismiss button to close the window.

– To view the coupler loss file, click Util>Examine>Coupler Loss>TX or RX.

6 Have the CBSC operator put the redundant BBX OOS_MANUAL.

! CAUTION
Be sure to download OOS devices only. Loading in–service devices takes them OUT OF SERVICE
and can result in dropped calls.

The code file version numbers must match the version numbers on the other cards in the frame. If the
numbers do not match, the site may go OUT OF SERVICE.

NOTE
Be sure to include the redundant BBX in steps 7, 8, and 9.

7 Download code and data to the target devices:

– Click Tools>Update NextLoad>CDMA to set the code version that will be downloaded.

– Select the BTS(s) you need, check the appropriate code version in the pop up window, and click
the Save button to close.

– Select the target BBX(s) on the C–CCP cage picture.

– Click Device>Download>Code/Data to start downloading code.

– Select the target BBX(s) on the C–CCP cage picture.

– Click Device>Download>Data to start downloading data.

. . . continued on next page
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Table H-5: In–Service Calibration

Step Action

! CAUTION
Perform the In–service Calibration procedure on OOS devices only.

8 Select the desired test:

– Select the target BBX(s) on the C–CCP cage picture.

– Click Tests>[desired test] from the menu bar at the main window.

– Select the target carrier and confirm the channel number in the pop up window.

– Leave the Verify BLO check box checked.

– From the Test Pattern pick list, select a test pattern.

– Click the OK button to start calibration.

– Follow the on–screen instructions, except, do not connect to the BTS antenna port, connect to the
directional coupler (fwd) port associated with the on screen prompt antenna port.

NOTE
S Selecting Pilot (default) performs tests using a pilot signal only.

S Selecting Standard performs tests using pilot, synch, paging and six traffic channels. This requires
an MCC to be selected.

S Selecting CDFPilot performs tests using a pilot signal, however, the gain for the channel elements
is specified in the CDF file.

S Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the gain
for the channel elements is specified in the CDF file.

9 Save the result and download the BLO data to the target BBX(s):

– Click the Save Result button on the result screen.
The window closes automatically.

10 Logout from the BTS and close the LMF session:

– Click BTS>Logout to close the BTS connection.

– Close the LMF window.

11 Restore the new “bts–*.cal” file to the CBSC.

12 Enable the target device(s) from the CBSC.
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Transmit & Receive Antenna VSWR

Purpose

The following procedures will verify that the Voltage Standing Wave
Ratio (VSWR) of all antennas and associated feed lines fall within
acceptable limits. The tests will be performed on all antennas in a
sequential manner (i.e., ANT 1, then ANT 2) until all antennas/feedlines
have been verified.

These procedures should be performed periodically by measuring each
respective antenna’s VSWR (reflected power) to verify that the antenna
system is within acceptable limits. This will ensure continued peak
system performance.

The antenna VSWR will be calculated at the CDMA carrier frequency
assigned to each antenna. Record and verify that they meet the test
specification of less than or equal to 1.5:1.

NOTE Motorola  recommends that the installer be familiar with the
following procedure in its entirety before beginning the actual
procedure. Ensure that the entire site is currently not in service.

This test is used to test RX antennas by substituting RX
frequencies for TX frequencies.

Study the site engineering documents and perform the following tests
only after first verifying that the RF cabling configuration required to
interconnect the BTS frames and antennas meet requirements called out
in the BTS Installation Manual.

Test equipment

The following pieces of test equipment will be required to perform this
test:

S LMF

S Directional coupler

S Communications test set

WARNING Prior to performing antenna tests, insure that no CDMA BBX
channels are keyed. Failure to do so could result in personal
injury or serious equipment damage.
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Equipment Setup – HP Test Set 

Follow the procedure in Table I-1 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table I-1: VSWR Measurement Procedure – HP Test Set

Step Action HP TEST SET

1 If you have not already done so, refer to the procedure in Table 3-5 on page 3-17 to set up test
equipment & interface the LMF computer to the BTS.

2 For manual VSWR testing, using external directional coupler, refer to Figure I-1 (1700/1900 MHz)
or Figure I-2 (800 MHz).

– Connect the communications test set RF OUT ONLY port to the INPUT port of the directional
coupler.

– Connect the RF IN/OUT port of the communication test set to the reverse (RVS) port on the
directional coupler. Terminate the forward port with a 50 ohm load.

– Install the antenna feed line to the output port on the directional coupler.

NOTE
Manual Communications Analyzer test setup (fields not indicated remain at default):

S Set screen to RF GEN.

– For 1900 MHz systems, set the RF Gen Freq to center frequency of actual CDMA carrier
between 1930–1990 MHz for TX and 1850–1910 MHz for RX. For 800 MHz systems, set the
RF Gen Freq to center frequency of actual CDMA carrier between 869–894 MHz for TX and
824–849 MHz for RX. For 1700 MHz systems, set the RF Gen Freq to center frequency of
actual CDMA carrier between 1840–1870 MHz for TX and 1750–1780 MHz for RX.

– Set Amplitude to –30 dBm.

– Set Output Port to RF OUT.

– Set AFGen1 & AFGen2 to OFF.

3 Remove the antenna feed line and install an “RF short” onto the directional coupler output port.

NOTE
Set–up communication test set as follows (fields not indicated remain at default):

S Set  screen to SPEC ANL.

– Under Controls, set input port to ANT.

– Set Ref Level to –40 dBm.

– Under Controls, select Main, select Auxiliary.

– Under Controls, select AVG. Set Avg = 20.

4 – Record the reference level on the communications analyzer and Note as PS for reference. 

– Replace the short with the antenna feedline. Record the reference level on the communications
analyzer and Note for as PA reference.

– Record the difference of the two readings in dB.

. . . continued on next page
I



Transmit & Receive Antenna VSWR 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPI-4

Table I-1: VSWR Measurement Procedure – HP Test Set

Step HP TEST SETAction

5 Calculate the VSWR per the equation shown to the right.
Where:

RL(dB) = PA(dBm) – PS(dBm) 
PA = Power reflected from antenna
PS = Power reflected from short

A calculated value of  –13.98 dB equates to VSWR of better than 1.5:1.

VSWR ���
�

�

1 � 10
RL
20

1 – 10
RL

20

��
�

�

6 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in–line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

7 Repeat steps 2 through 6 for all remaining TX sectors/antennas.

8 Repeat steps 2 through 6 for all remaining RX sectors/antennas.

 

Figure I-1: Manual VSWR Test Setup Using HP8921 Test Set (1700/1900 MHz)
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Figure I-2: Manual VSWR Test Setup Using HP8921 Test Set (800 MHz)
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Equipment Setup – Advantest  Test Set

Follow the steps in Table I-2 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table I-2: VSWR Measurement Procedure – Advantest Test Set

Step Action ADVANTEST

1 If you have not already done so, refer to the procedure in Table 3-5 on page 3-17 to set up test
equipment and interface the LMF computer to the BTS.

2 For manual VSWR testing using external directional coupler, refer to Figure I-3.

– Connect the communications test set RF OUT port to the input port of the directional coupler.

– Connect the INPUT port of the communication test set to the forward port on the directional
coupler. Terminate the forward port with a 50 Ohm load.

– Connect the RF short to the directional coupler output port.

. . . continued on next page
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Table I-2: VSWR Measurement Procedure – Advantest Test Set

Step ADVANTESTAction

3 Preform the following to instruct the calibrated test set to generate a CDMA RF carrier (RVL call)
with all zero longcode at the assigned RX frequency at –10 dBm:

S Push the ADVANCE Measurement key.

S Push the CDMA Sig CRT menu key.

S Push the FREQ Entry key:

– For 1900 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
1930–1990 MHz for  TX and 1850–1910 MHz for RX.

– For 800 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
869–894 MHz for  TX and 824–849 MHz for RX.

– For 1700 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
1840–1870 MHz for  TX and 1750–1780 MHz for RX.

S Push the LEVEL Entry key; set to 0 dBm (by entering 0 and pushing the –dBm key).

S Verify  that ON is active in the Output CRT menu key.

S Verify  that OFF is active in the Mod CRT menu key.

S Push the CW Measurement key.

S Push the FREQ Entry key.

– Push the more 1/2 CRT menu key.

– Set Preselect CRT menu key to 3.0G.

S Push the Transient Measurement key.

– Push the Tx Power CRT menu key.

– Push the LEVEL entry key (set to 7 dBm by entering 7 and pushing the the dBm key).

– Set Avg Times CRT menu key to ON. Set to 20 (by entering 20 and pushing the Hz ENTER
key).

S Push the REPEAT Start key to take the measurement.

4 Record the Burst Power display on the communications analyzer and Note as PS for reference.

5 Install the antenna feedline to the output port of the directional coupler.

6 S Push the Auto Level Set CRT menu key.

S Push the REPEAT Start key to take the measurement.

7 Record the Burst Power on the communications analyzer and Note as PA level for reference.

Record the difference of the two readings in dBm.

8 Calculate the VSWR per the equation shown to the right.
Where:

RL(dB) = PA(dBm) – PS(dBm) 
PA = Power reflected from antenna
PS = Power reflected from short

A calculated value of  –13.98 dB equates to VSWR of better than 1.5:1.

VSWR ���
�

�

1 � 10
RL
20

1 – 10
RL

20

��
�

�
. . . continued on next page
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Table I-2: VSWR Measurement Procedure – Advantest Test Set

Step ADVANTESTAction

9 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in–line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

10 Repeat steps 2 through 9 for all remaining TX sectors/antennas.

11 Repeat steps 2 through 9 for all remaining RX sectors/antennas.

 

Figure I-3: Manual VSWR Test Setup Using Advantest R3465
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Notes
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BTS Router Initial Configuration

Overview

This appendix contains information and operations related to loading an
MWR 1941 BTS router with the minimum standard (canned)
configuration necessary for network communications. Once the router is
communicating on the network, the full, site-specific, operational
configuration can be downloaded to the router over the network. This
appendix includes sections on:

S Terminal Setup

S Downloading canned BTS router configuration files

S Verifying IOS canned version of CF memory card

S Replacing installed BTS router CF memory card IOS version

S Verify and upgrade rommon version

S Recovery from BTS router boot to rommon

S Entering or changing router FE interface IP address

S Preparation for site turn–over

J
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Terminal Setup

General
This section provides the procedures to configure and save a terminal
session for communicating with the MWR 1941 BTS router. Terminal
settings are the same as those used for BTS card and module
Man–Machine Interface (MMI) communication sessions. The procedures
are for a Pentiumr processor–based computer operating with either
Windows 98 Second Edition (SE) or Windows 2000.

Using the LMF computer

LMF computer platforms can be used for communicating with the
routers, and the MMI terminal connection created for BTS card/module
optimization actions will operate with the BTS routers. See the
“Establishing a BTS Router Communication Session” section of this
appendix for additional interface hardware required for BTS router
communication.

Terminal Settings

Follow the procedure in Table J-1 to create a named HyperTerminal
connection for BTS router interface and generate a Windows desktop
shortcut for it.

NOTE There are differences between Windows 2000 and Windows 98 in
the menus and screens used for creating a HyperTerminal
connection. In the following procedure, items applicable to:

S Windows 2000 will be identified with Win2000

S Windows 98 will be identified with Win98

Table J-1: Establish HyperTerminal Connection

Step Action

1 From the Windows Start menu, select Programs > Accessories

2 Perform one of the following:

S For Win2000, select Hyperterminal and then click on HyperTerminal

S For Win98, select Communications, double click the Hyperterminal folder, and then double click
on the Hypertrm.exe icon in the window which opens.

NOTE
S If a Location Information Window appears, enter the required information, then click on the

Close button. (This is required the first time a HyperTerminal connection is configured, even if a
modem is not to be used.)

S If a You need to install a modem..... message appears, click on NO.

3 When the Connection Description box opens:

– Type a name for the connection being defined (for example, BTSRTR Session, MMI) in the
Name: window,

– Highlight any icon preferred for the named connection in the Icon: chooser window, and

– Click  OK.

. . . continued on next page J
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Table J-1: Establish HyperTerminal Connection

Step Action

4 From the Connect using: pick list in the Connect To box displayed, select the RS–232 port to be
used for the connection (e.g., COM1 or COM2 – Win2000 or Direct to Com 1 or Direct to Com 2 –
Win98), and click OK.

5 In the Port Settings tab of the COM# Properties window displayed, configure the RS–232 port
settings as follows:

S Bits per second:  9600

S Data bits:  8

S Parity:  None

S Stop bits: 1

S Flow control: None

6 Click OK.

7 With the HyperTerminal window still open and the connection running, select:

File > Properties

8 Click the Settings tab, click the arrow in the Emulation window, and select VT100 from the
dropdown list.

9 Click the ASCII Setup button, uncheck all boxes in the ASCII Setup window which appears, and
click OK.

10 Click OK for the connection Properties box.

11 Save the defined connection by selecting:

File > Save

12 Close the HyperTerminal window by selecting:

File > Exit

13 Click the Yes button to disconnect when prompted.

14 Perform one of the following:

S If the Hyperterminal folder window is still open (Win98), proceed to step 16, or

S From the Windows Start menu, select Programs > Accessories

15 Perform one of the following:

S For Win2000, select Hyperterminal and release any pressed mouse buttons.

S For Win98, select Communications and double click the Hyperterminal folder.

16 Highlight the newly–created connection icon by moving the cursor over it (Win2000) or clicking on it
(Win98).

17 Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

18 From the popup menu displayed, select Create Shortcut(s) Here.

. . . continued on next page
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Table J-1: Establish HyperTerminal Connection

Step Action

19 If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.

NOTE
The shortcut icon can now be double–clicked to open a BTS router or BTS card/module MMI
HyperTerminal session without the need to negotiate multiple menu levels.

 

BTS Router Serial Communication

For those procedures which require serial communication with BTS
routers, follow the procedures in Table J-2 to initiate the communication
session. This procedure calls out the LMF computer platform, but any
VT100–equivalent terminal or computer equipped with terminal
emulation software and a hardware serial connector may be used.

Required Items

The following items are required to perform the verification:

S LMF computer platform or equivalent (see this manual for
requirements)

S Eight–conductor (four–pair, unshielded twisted pair is acceptable)
rollover cable, two 8–contact modular plugs (see Figure J-1 for cable
wiring requirements)

S Adapter, DB–9 plug–to–8–contact modular plug, Global Computer
Supplies C4717 or equivalent (see Figure J-2 for adapter wiring
requirements)

Figure J-1: Wiring Diagram, BTS Router Communication Rollover Cable
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Figure J-2: Wiring Diagram, DB–9 Plug–to–8–contact Modular Plug Adapter
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Table J-2: Establishing BTS Router Serial Communication

Step Action

1 If it has not been done, start the computer and allow it to complete boot–up.

2 If a named HyperTerminal connection for BTS router serial communication or BTS card/module MMI
communication has not been created on the LMF computer, create one as described in Table J-1 in the
“Terminal Set–up” section of this appendix.

3 Connect the computer to the BTS router as shown in Figure J-3.

4 Start the named HyperTerminal connection for BTS router communication sessions by double clicking
on its Windows desktop shortcut.

NOTE
If a Windows desktop shortcut was not created for the communication session, access the connection
from the Windows Start menu by selecting:

Programs > Accessories > Hyperterminal > HyperTerminal > <Named HyperTerminal
Connection (for example, BTSRTR)>

5 Once the connection window opens, establish communication with the BTS router by pressing the
computer Enter key until the prompt identified in the applicable procedure is obtained.
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Figure J-3: LMF Computer  Connections to BTS Router
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Downloading Minimum Canned BTS Router Configuration Files

Downloading Overview

After they are generated on the OMC–R, the BTS router canned
configuration files must be transferred to another computer platform
from which they can be installed into the BTS routers. A number of
procedures may be used to move the canned configuration files from the
OMC–R to a platform from which they can be loaded into the routers.
Some alternatives are:

1. If a floppy diskette drive is available at the OMC–R, such as the one
for UNO workstations, the configuration files can be transferred to
an LMF computer or similar machine using the CDF file transfer
procedure in the Preparing the LMF section of this manual.
Directories identified in Table J-3 must be used rather than those in
the CDF file transfer procedure.

2. If a Windows–based server connection is available in the operator’s
network and it can provide an FTP or telnet connection to the
OMC–R, files may be transferred by either the FTP or telnet
methods.

3. If a dial–up connection is available for accessing the OMC–R, an
FTP or telnet session may be possible to transfer files to the
computer used to load the CF memory cards.

The procedure provided in this section covers FTP transfer using a
Windows–based server in the operator’s network. Coordinate with the
local network administrator to determine the method and procedure to
use on a specific network.

Prerequisites

The following must be obtained from the local network administrator
before performing the canned configuration file FTP procedure in
Table J-3:

S User ID and password to log onto the OMC–R

S Name of the sub–directory where the specific BTS router group
canned configuration files to be downloaded were created

FTP File Transfer from the OMC–R

This procedure uses the Windows–based LMF computer platform to
download BTS router canned configuration files from the OMC–R.
Follow the procedure in Table J-3.

Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC–R

Step Action

1 If it has not been done, create a directory on the LMF computer where the BTS router canned
configuration files will be stored.

2 If it has not been done, obtain the OMC–R logon user ID and password from the local network
administrator.

. . . continued on next pageJ
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Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC–R

Step Action

3 Connect the LMF computer to the local network and log on.

NOTE
This procedure uses the command line FTP client supplied with Windows 98, Second Edition (Win98
SE) and Windows 2000 (Win2K); however, any commercially available FTP client application can be
used. Follow the manufacturer’s instructions for operation of an alternative application.

4 Open a command line (MS DOS) window by clicking on Start > Programs > Command Prompt.

5 When the command line window opens, change to the directory where the canned configuration files
will be stored on the LMF computer by entering:

cd  pathname

Where pathname  =  the path to the required directory.

A response similar to the following will be displayed:

C:\> cd Can_Cfg
C:\Can_Cfg>

6 Check the contents of the directory by entering the following:

dir

A response similar to the following will be displayed:

C:\Can_Cfg>dir
 Volume in drive C is MAIN
 Volume Serial Number is F2AA–1721

 Directory of C:\Can_Cfg>

08/22/2002  03:46p      <DIR>          .
08/22/2002  03:46p      <DIR>          ..
08/22/2002  03:46p               2,223 btsrtr_canned.blue
08/22/2002  03:47p               2,223 btsrtr_canned.red
               2 File(s)          4,644 bytes
               2 Dir(s)   2,556,045,312 bytes free

C:\Can_Cfg>

7 If either or both of the following files are found in the directory, delete them or move them to another
directory:

S btsrtr_config.blue

S btsrtr_config.red

8 Begin the FTP session by entering the following:

ftp  hostname

Where hostname = the OMC–R hostname or IP address.

A response similar to the following will be displayed:

C:\Can_Cfg> ftp OMCR–1
C:\Can_Cfg>
Connected to OMCR–1.
220 OMCR–1 FTP server (SunOS 5.6) ready.
User (OMCR–1:(none)):

. . . continued on next page
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Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC–R

Step Action

9 Enter  the User ID and password when prompted, pressing the Enter key after each. A response
similar to the following will be displayed:

User (OMCR–1:(none)): scadm
331 Password required for scadm.
Password:
230 User scadm logged in.
ftp>

10 Change to the directory where the BTS router canned configuration file sub–directories are created and
verify the present working directory by entering the following, pressing the Enter key after each:

cd  /home/scadm/btsrtr_canned_configs

pwd

A response similar to the following will be displayed:

ftp> cd /home/scadm/btsrtr_canned_configs
240 CWD command successful.
ftp> pwd
245 ”/home/scadm/btsrtr_canned_configs” is current directory.

11 Enter the ls command to list the contents of the directory and be sure the specific canned configuration
directory name provided by the administrator exists. A response similar to the following will be
displayed:

ftp> ls
200 PORT command successful.
150 ASCII data connection for /bin/ls (10.182.29.117,80) (0 bytes).
Mon_Jul_2_01:55:07_CDT_2002
Wed_Jul_24_09:35:41_CDT_2002
Tue_Aug_04_10:35:22_CDT_2002
226 ASCII Transfer complete.
ftp: 30 bytes received in 0.02Seconds 1.50Kbytes/sec.
ftp>

NOTE
Directory names where canned configuration files are located will consist of the
weekday_month_day_time_year when the canned configuration files were created on the OMC–R.

12 Change to the directory specified for the BTS router group to be configured and list the directory
contents by entering the following, pressing the Enter key after each command:

cd  weekday_month_day_time_year

ls

A response similar to the following will be displayed:

ftp> cd Wed_Jul_24_09:35:41_CDT_2002
250 CWD command successful.
ftp> ls
200 PORT command successful.
150 ASCII data connection for /bin/ls (10.182.29.117,80) (0 bytes).
btsrtr_canned.blue
btsrtr_canned.red
226 ASCII Transfer complete.
ftp: 39 bytes received in 0.05Seconds 0.78Kbytes/sec.
ftp>

. . . continued on next page
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Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC–R

Step Action

13 Change to the binary transfer mode and, if desired, turn on hash mark printing for transfer progress by
entering the following, pressing the Enter key after each command:

bin

hash

A response similar to the following will be displayed:

ftp> bin
200 Type set to I.
ftp> hash
Hash mark printing On  ftp: (2048 bytes/hash mark) .
ftp>

NOTE
With Win98 SE, turning on hash mark printing can slow down file transfer in certain circumstances,
but the canned configuration files are quite small (approximately 2.5 KB) so there should be little
noticeable effect.

14 Download the BTS router canned configuration files to the LMF computer by performing the following:

14a – Enter the following to download the first canned configuration file:

get  btsrtr_canned.blue

A response similar to the following will be displayed:

ftp> get btsrtr_canned.blue
200 PORT command successful.
150 Binary data connection for btsrtr_canned.blue (10.182.29.117,80) (2223 bytes).
#
226 Binary Transfer complete.
ftp: 2223 bytes received in 0.59Seconds 3.76Kbytes/sec.
ftp>

14b – Enter the following to download the second BTS router canned configuration file:

get  btsrtr_canned.red

A response similar to the following will be displayed:

ftp> get btsrtr_canned.red
200 PORT command successful.
150 Binary data connection for btsrtr_canned.red (10.182.29.117,80) (2223 bytes).
#
226 Binary Transfer complete.
ftp: 2223 bytes received in 0.59Seconds 3.76Kbytes/sec.
ftp>

. . . continued on next page
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Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC–R

Step Action

15 Before terminating the FTP session, open Windows Explorer and view the contents of the directory
where the canned configuration files are to be stored to be sure the files are present. Perform the
following:

15a – Click Start > Programs > Windows Explorer.

15b – In the left–hand pane of Windows Explorer, perform one of the following depending on the LMF
computer operating system:
–– Win98 SE: If necessary, expand the directory display for the drive where the canned configu-

ration file storage directory is located by clicking on the  +  next to the drive icon.
–– Win2K: Expand the user profile and directory display for the drive where the canned configu-

ration file storage directory is located by clicking on the  +  next to each icon, respectively.

15c – Expand any sub–directories as required to display the directory folder where the canned
configuration files are to be stored.

15d – Click on  the directory folder icon where the canned configuration files are to be stored.

15e – In the right–hand  pane, verify that the files btsrtr_canned.blue and btsrtr_canned.red
appear.

15f – If the files appear, proceed to step 16.

15g – If the files do not appear, repeat step 14, its sub–steps, step 15 and its sub–steps.

16 Close Windows Explorer, and, in the command line window, enter the bye command to terminate the
FTP session. A response similar to the following will be displayed:

ftp> bye
221 Goodbye.
C:\Can_Cfg>

17 Close the command line window by entering the  exit command.

18 BTS router canned configuration files are now ready for transfer to a BTS router.

 

J
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Verifying IOS Canned Version of the CF Memory Card

Overview

This section covers the procedures and commands required to verify the
IOS version loaded on BTS router CF memory cards and copy standard
canned configuration files to the routers. Because of the set–up required
and the length of some of the procedures, Motorola recommends
performing the actions covered in this section at a central location to
prepare the BTS routers for installation prior to the site visit.

IOS Version Verification and File Sequence Position

Version verification – The IOS version loaded on the BTS router CF
memory card should be verified as the version required for operation on
the network where the routers will be installed. If the loaded IOS version
is not correct, it can be replaced with a different version. There are
several methods available to accomplish version verification. These
depend on the equipment and software applications the user selects to
use in installing the canned configuration files in the BTS routers.
Appropriate verification procedures are included in each of the two
canned configuration installation methods covered in this section.
Methods to change the loaded IOS version are provided in the Change
BTS Router IOS Version section of this appendix and are referenced at
the appropriate places in the canned configuration installation methods.

File sequence position – During initialization, the MWR 1941 router
will first search the startup–config file for a boot system command
line telling it in what directory and file to find the boot loader. If this line
is not found, the router will default to attempting to boot from the first
file in its flash memory. Flash memory for the MWR 1941 is the CF
memory card (software identifier slot0:). The canned configuration files
used for BTS router installation do not contain a boot system command
line because of the need to maintain flexibility for IOS version changes.
Because of this, it is critical that the IOS file is the first file listed on the
CF memory card. The canned configuration installation procedures
contain steps to assure that this is the case, and, if it is not, provide
guidance to correct the condition. It is important to remember that, if the
router boots and displays a rommon 1 > prompt, the IOS file is
missing, out of sequence, has a corrupted flash memory image or the
startup–config file contains a boot system line which specifies a
missing or incorrect IOS pathname/filename.

Canned Configuration File Installation

Filename and installation location requirements – The canned
configuration files for the BTS routers must be copied to the CF memory
card. The filename of the file on the CF memory card must be
canned–config. Canned configuration file location and filename
requirements are a result of Mobile Wireless Center (MWC) actions
during the process of switching a BTS from packet to circuit mode. In
this process, the MWC will query the BTS routers’ slot0: directory for a
file named canned–config. A missing or mis–named file will cause
problems with execution of the mode–switching process. J
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Installation Methods –  The startup–config configuration file used
by the BTS router during initialization is stored in NVRAM. This is a
memory device internal to the router and is separate from the CF
memory card. To install the canned configuration file so the router will
use it during boot–up, the file must be copied into the
startup–config file in NVRAM. There are two methods available to
accomplish this:

1. Using a tftp server application to copy the canned configuration file
from the Windows–based LMF computer to the CF memory card
installed in a router, and then copying it to the startup–config
file in the router’s NVRAM

2. Using a CF memory card reader to copy the canned configuration
file to a CF memory card, and then, once the CF memory card is
installed in the router, using a HyperTerminal communication
session to copy the file from the CF memory card to the
startup–config file in the router’s NVRAM

Comparison of methods –  Preparation for using the tftp server
application method is extensive and requires setting up simultaneous
serial and FE communication sessions with the router. This method
offers the advantage of being able to verify IOS file sequence position
immediately and supporting direct file transfers between the router and
LMF computer without removing the CF memory card. As an
alternative, using a CF memory card reader to copy the canned
configuration file to a CF memory card, and from there to the
startup–config file requires very little set–up. With this method, the
IOS file sequence position can only be verified once the CF memory
card is installed in the router, and any file transfers between the router
and LMF computer require physically moving the CF memory card
between the router and card reader.

Procedures to use each method – Using the tftp server application to
copy the canned configuration file to a CF memory card is covered in the
Method 1 subsection. Performing the transfer process with a card reader
is covered in the Method 2 subsection. The applicable procedures for
verifying the loaded IOS version and file sequence position are included
in each method.

File operations using a CF memory card reader – Only file transfers
should be performed using the CF memory card reader. CF memory card
formatting should be performed in a BTS router using a HyperTerminal
connection. Attempting to format a CF memory card from a
Windows–based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a
Windows–based computer. Only format CF memory cards in a
BTS router.

J
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Method 1: Using a TFTP Server to Load to CF Memory Card

Required Equipment and Software

The following items are required to perform this procedure:

S A Windows–based computer which meets the requirements of the
LMF computer platform as specified in this manual.

S One of the following operating systems for the Windows–based
computer:
– Windows 2000

– Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

S One of the following for the Windows–based computer:

– Internal 10/100baseT Network Interface Card (NIC)
– PCMCIA 10/100baseT NIC

S Cable, Ethernet crossover, Category 5E or better, unshielded twisted
pair, two 8–contact modular plugs, in one of the following lengths, as
determined necessary:
– 0.3 m (11.8 in) (Motorola pn 3088643C07)

– 0.6 m (23.6 in)(Motorola pn 3088643C13)
– 1.0 m (39.4 in) (Motorola pn 3088643C15)

– 2.1 m (84 in) (Motorola pn 3088643C08)

– 3.0 m (120 in) (Motorola pn 3088643C09)

S Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

S DB–9 plug–to–8–contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

S A tftp server software application (refer to the Setting Up the TFTP
Server – Procedure in Cellular System Administration – CDMA
OnLine Documentation) such as:
– Cisco tftp server

– PumpKIN tftp server
– Any other equivalent tftp server application

S A copy of the MWR 1941 router IOS version required for the network
where the routers are to be installed (contact the network administrator
or the Motorola account team for information on obtaining the
required MWR 1941 IOS version)

S A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Materials

The following material is required to perform this method:

S Marking material to identify the BTS router and CF memory card with
the installed configuration (blue or red) J
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Required Publications

The following publications are required to perform procedures in this
section:

S this manual

S Cellular System Administration – CDMA OnLine Documentation

S MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78–13983–01

Preparation for Canned Configuration File TFTP
Transfer to CF Memory Card

Preparation for a canned configuration file tftp transfer consists of the
following activities:

1. Setting the LMF computer NIC IP address

2. Creating a directory (folder) on the LMF computer to be used for all
tftp file transfers

3. Installing the tftp server application on the LMF computer, and
setting the tftp server application root directory to the directory
created in 2, above

4. Connecting the LMF computer to the BTS router for both
HyperTerminal (serial) and Ethernet communication

5. BTS router power–up and initial configuration for Ethernet
communication

The following procedures are used to accomplish all of these preparatory
actions.

Set LMF computer NIC TCP/IP address and create the default
TFTP directory – Follow the procedure in Table J-4 to set the NIC IP
address.

NOTE IMPORTANT! If the IP address for the LAN connection on an
LMF computer is being changed to support tftp downloads to a
BTS router, the BTS 10base–2 LAN IP address and subnet mask
for the NIC must be restored before the LMF can log into a BTS
to perform an optimization or ATP.

NOTE There are differences between Windows 2000 and Windows 98 in
the menus and screens used for setting or changing a NIC
connection. In the following procedure, items applicable
to:Windows 2000 will be identified with Win2000Windows 98
will be identified with Win98

J
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Table J-4: Set LMF Computer NIC IP Address and Create a Default TFTP Directory

Step Action

1 Start the computer.

2 Login and allow the computer to boot to the desktop.

3 Depending on the installed operating system, from the Windows Start menu, select one of the
following:

S Win2000: Settings > Network and Dial–up Connections

S Win98: Settings > Control Panel and double–click  Network.

4 Perform one of the following as applicable for the installed operating system:

S For Win2000, in the list of displayed connections, locate the Local Area Network connection for the
NIC to be used for BTS router Ethernet communication.

S For Win98, in the Configuration tab of the Network dialog box, locate the TCP/IP connection for
the installed NIC.

– If TCP/IP does not appear in the displayed list of installed network components, refer to the
operating system documentation and install TCP/IP.

5 Perform one of the following as applicable for the installed operating system:

S For Win2000,  highlight the connection for the NIC and right click the highlighted connection, and
select Properties from the pop–up menu.

S For Win98:

– Highlight the TCP/IP NIC connection in the displayed list of installed network components.

– Click the Properties button.

– Skip to step 8.

6 For Win2000 , in the Local Area Connection Properties dialog box which appears, if Internet
Protocol (TCP/IP) is not showing in the Components checked are used by this connection: listbox,
refer to the operating system documentation and install TCP/IP.

7 For Win2000, if the checkbox next to the Internet Protocol (TCP/IP) entry is not checked, click in the
box to check it.

8 Perform one of the following:

S Win2000: Highlight the Internet Protocol (TCP/IP) entry, and click on the Properties button below
the Components checked are used by this connection: listbox.

S Win98: From the tabs displayed in the TCP/IP Properties dialog box which opens, select the IP
Address tab if it is not at the front.

. . . continued on next page
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Table J-4: Set LMF Computer NIC IP Address and Create a Default TFTP Directory

Step Action

9 In the Internet Protocol (TCP/IP) Properties dialog box which appears (Win2000) or the IP Address
tab of the TCP/IP Properties dialog box (Win98), perform the following:

9a – If a black dot is not showing in the the radio button circle next to Use the following IP address:
(Win2000) or Specify an IP address (Win98), click on the radio button.
–– A black dot will appear in the circle.

9b – If using an LMF computer, record the IP address and subnet mask used for LMF–BTS
communication so they can be re–entered when tftp transfer activities for the BTS router are
completed.

9c – Enter 100.100.100.1 in the IP address: box.

9d – Enter 255.255.255.252 in the Subnet mask: box.

10 Click the OK button for the Internet Protocol (TCP/IP) Properties dialog box (Win2000) or the
TCP/IP Properties box (Win98).

11 Click the OK button for the Local Area Connection Properties box (Win2000) or the Network box
(Win98).

12 In Win98, click File > Close to close the Control Panel window.

13 Click Start > Programs > Windows Explorer to open Windows Explorer.

14 If the default tftp directory will be the same directory in which the files downloaded from the OMC–R
are stored, proceed to step 22.

15 In the left–hand pane of Windows Explorer, locate the icon for the drive where the default tftp
directory is to be created.

16 Highlight the drive icon and click Files > New > Folder.

17 While observing the new folder icon in the right–hand pane, type the name for the folder (for example,
tftp_files), and press the Enter key.

18 In Windows Explorer, locate the directory where the canned configuration files downloaded from the
OMC–R are stored.

19 In the left–hand pane, highlight the directory where the files are stored.

20 Scroll the  left–hand pane until the newly–created default tftp directory is visible.

21 In the right–hand pane, highlight the canned configuration files and drag them to the default tftp
directory.

22 In the left–hand pane, click on the default tftp directory, and verify that the canned configuration files
appear in the right–hand pane.

23 Load a copy of the required BTS router IOS version into the default tftp directory using FTP, internet
download, or media such as a Zip disk (file size is over 7 MB).

24 Click Files > Close to close Windows Explorer.
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Install and configure tftp server application

To obtain, install, and configure the Cisco or PumpKIN tftp software
applications, refer to the Setting Up the TFTP Server – Procedure in
Cellular System Administration – CDMA OnLine Documentation For
other tftp server applications, install and configure the application
according to the manufacturer’s instructions.

NOTE Important: When entering the name of the tftp server root
directory while configuring the tftp server application, be sure to
use the name of the directory identified in Table J-4, step 14, or
created in Table J-4, step 17, above.

Connect the LMF computer to the BTS router

Connect the LMF computer to the BTS router by following the
procedure in Table J-5 and referring to Figure J-4..

Figure J-4:  LMF Computer TFTP Connections to BTS Router

To BTS router
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Table J-5: Connecting the LMF Computer to the BTS Router for TFTP File Transfer

Step Action

1 If the BTS router has not been connected to a power source, be sure the +27 Vdc power source is not
on, and connect it to the router.

2 Connect the LMF computer to the BTS router as shown in Figure J-4, referring to the list of required
equipment in this section as required.

3 If the LMF computer has not been started, turn it on, login, and allow it to boot to the desktop.

4 Refer to the procedure in Table J-2 of this appendix, and start a HyperTerminal communication session
for the BTS router.

5 Start the tftp server application as specified for the software (refer to the Setting Up the TFTP Server –
Procedure in Cellular System Administration – CDMA OnLine Documentation or the manufacturer’s
instructions).

 

BTS router power–up and initial configuration for
Ethernet communication

 Follow the procedure in Table J-6 to apply power to the router and set
an initial configuration for Ethernet communication.

S The required version of the IOS is loaded on the CF memory card

S The CF memory card is installed in the BTS router

Table J-6: BTS Router Power–up and Initial Ethernet Configuration

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 Be sure a CF memory card loaded with the Cisco IOS is installed in the BTS router (refer to the BTS Router
Card and Module Replacement section of the 1X SC 4812T BTS FRU Guide  68P09258A64  for instructions
to access the CF memory card slot).

2 * IMPORTANT
In this step do not touch the computer keyboard until the router completes the boot process. The router
will buffer any keystrokes made during the boot process and interpret them as commands to be
executed immediately following boot completion.

Apply power to the router and allow it to complete boot–up.

3 If a message similar to the following, is displayed, press the Enter key and proceed to step 5:

Press RETURN to get started!

. . . continued on next pageJ
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Table J-6: BTS Router Power–up and Initial Ethernet Configuration

Step Action

4 If a message similar to the following, is displayed type no and press the Enter key:

Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system

Would you like to enter basic management setup? [yes/no]:

A response similar to the following will be displayed:

Would you like to enter basic management setup? [yes/no]: no

Cisco Internetwork Operating System Software
IOS (tm) 1941 Software (MWR1941–I–M), Version 12.2(20020127:101239
Copyright (c) 1986–2002 by cisco Systems, Inc.
Compiled Sun 27–Jan–02 06:08 by walrobin

Router>

5 At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:

enable

A response similar to the following will be displayed:

Router>enable
Router#

6 At the Router# privileged EXEC mode prompt, enter the following to access the configure submode:

configure  terminal

A response similar to the following will be displayed:

Router#conf t
Enter configuration commands, one per line. End with CNTL/Z.
Router(config)#

The router is now in the global configuration mode and ready to accept configuration changes entered
from the keyboard.

. . . continued on next page
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Table J-6: BTS Router Power–up and Initial Ethernet Configuration

Step Action

7 At the global configuration mode prompt, type each of the following commands, pressing the Enter
key after each command:

hostname  btsrtr1
interface  fa0/0
ip  address  100.100.100.2  255.255.255.252
speed  100
duplex  full
no shutdown
line  con  0
exec–timeout  0  0
no  login
line  vty  0  4
no login

Responses similar to the following will be displayed:

Router(config)#hostname BTSRTR1
BTSRTR1(config)#interface fa0/0
BTSRTR1(config–if)#ip address 100.100.100.2 255.255.255.252
BTSRTR1(config–if)#speed 100
BTSRTR1(config–if)#duplex full
BTSRTR1(config–if)#no shutdown
BTSRTR1(config–if)#line con 0
BTSRTR1(config–line)#exec–timeout 0 0
BTSRTR1(config–line)#no login
BTSRTR1(config–line)#line vty 0 4
BTSRTR1(config–line)#no login
BTSRTR1(config–line)#

8 Once the correct parameters have been set, return to the privileged EXEC mode prompt by holding
down the Ctrl key and pressing z (Ctrl+z). A response similar to the following will be displayed:

BTSRTR1(config–line)#  ^z
01:11:27: %SYS–5–CONFIG_I: Configured from console by console
BTSRTR1#

NOTE
Entering exit twice, pressing the Enter key after each entry, will also complete the configuration
process and return the router to the privileged EXEC mode.

9 Verify  port FE 0 (fa0/0) is configured with the correct IP address by entering the following:

show ip interface brief

A response similar to the following will be displayed:

BTSRTR1#sh ip int br
Interface IP Address OK? Method Status Protocol
FastEthernet0/0 100.100.100.2 YES manual up up
Serial0:0 unassigned YES unset administratively down down
FastEthernet0/1 unassigned YES unset administratively down down
Serial1:0 unassigned YES unset administratively down down

BTSRTR1#

10 The router is now configured for Ethernet communication on FE 0, and the canned configuration file
can be transferred by tftp. Proceed to Table J-7.
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Verifying IOS Version and Canned Configuration File
TFTP Transfer to the BTS Router

Prerequisites – The following is required prior to performing this
procedure:

S A copy of the required MWR 1941 router IOS version file is installed
in the default tftp directory (transfer the file to the LMF computer
using FTP, internet download, or media such as a Zip disk; file size is
approximately 7–8 MB)

IOS verification and canned configuration file transfer – Follow the
procedure in Table J-7 to verify the loaded IOS version and transfer the
canned configuration files from the LMF computer to the BTS router CF
memory card.

NOTE IMPORTANT: MWR 1941 routers must be loaded with IOS
version mwr1900–i–mz.122–8.MC2d.bin or later. This router
model will not function properly with earlier IOS versions.

NOTE This procedure does not cover all aspects of BTS router
operation and programming. Before performing this procedure,
review BTS router initialization, operation, and programming
information and procedures in MWR1941 Wireless Mobile Edge
Router Software Configuration Guide; part number
78–13983–01. Have this publication available for reference
while performing this procedure.

Table J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

CAUTION
If personal firewall and/or intrusion detection software such as Black ICE is running on the LMF computer,
shut it down before performing this procedure. If this is not done, the tftp transfer process will not operate.

1 On the LMF computer, if it has not been done, start the tftp server according to the manufacturer’s
directions (refer to the Setting Up the TFTP Server – Procedure in the Cellular System Administration
– CDMA OnLine Documentation).

* IMPORTANT
MWR 1941 routers must be loaded with IOS version mwr1900–i–mz.122–8.MC2d.bin or later. This
router model will not function properly with earlier IOS versions.

2 If a HyperTerminal communication session with the BTS router is not  running, start one following the
procedure in Table J-2.

3 In the HyperTerminal window, the router must be in  the privileged EXEC mode, as indicated by a
number sign at the end of the prompt:

BTSRTR1#

4 Be sure the Ethernet crossover cable is connected between the LMF computer NIC port and the BTS
router FE 0 port (see Figure J-4).

. . . continued on next page J



Verifying IOS Canned Version of the CF Memory Card 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPJ-24

Table J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

5 Begin verification that the CF memory card contains the correct version of the Cisco IOS by entering
the following:

dir  slot0:

A response similar to the following will be displayed:

BTSRTR1#dir slot0:
Directory of slot0:/

  1  –rw–  7051976   Mar 01 1993 00:11:34  mwr1941–i–mz.122–8.MC2a.bin

31932416 bytes total (24879104 bytes free)
BTSRTR1#

NOTE
1. The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has

been changed using the  cd  command. Determine the present working directory by entering  pwd.
If the present working directory has been changed, enter the command  cd  slot0:  to return to the
default setting.

2. If slot0: is included in the command, be sure to include the colon (:) after slot0 when typing the
command.

3. The IOS filename will be similar to the following:

mwr1941–i–mz.122–8.MC2a.bin

. . . continued on next page
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Table J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

6 Direct the router to show the version information by entering the following:

show version

A response similar to the following will be displayed:

BTSRTR1#sh ver
Cisco Internetwork Operating System Software 
IOS (tm) 1941 Software (MWR1941–I–M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc1)
TAC Support: http://www.cisco.com/tac
Copyright (c) 1986–2002 by cisco Systems, Inc.
Compiled Mon 05–Aug–02 11:07 by nmasa
Image text–base: 0x60008940, data–base: 0x60B54000

ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose–wilma 109], DEVELOPMENT
SOFTWARE
ROM: 1941 Software (MWR1941–I–M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fc1)

Router uptime is 1 minute
System returned to ROM by power–on
System image file is ”slot0:mwr1941–i–mz.122–8.MC2a.bin”

cisco mwr1941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS
R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.
X.25 software, Version 3.0.0.
Primary Rate ISDN software, Version 1.1.
Toaster processor tmc is running.
2 FastEthernet/IEEE 802.3 interface(s)
2 Serial network interface(s)
2 Channelized T1/PRI port(s)
DRAM configuration is 64 bits wide with parity disabled.
55K bytes of non–volatile configuration memory.
31360K bytes of ATA Slot0 CompactFlash (Read/Write)

Configuration register is 0x101

BTSRTR1#

7 Compare the IOS filename returned in step 5 and the second line of the version information in step 6.
Note the correspondence between the filename and IOS version information.

8 If the IOS filename from the CF memory card returned in step 5 is different than the filename of the
required IOS version loaded in the LMF computer default tftp directory, perform the procedure in
Table J-13 to load the required version, and then return to step 9, below.

. . . continued on next page
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Table J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

CAUTION
The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

9 If the IOS version is correct and there is more than one file loaded on the CF memory card, be sure the
IOS file is the first file listed in the directory content display. If it is not, perform the following:

9a – Backup all files on the CF memory card to the LMF computer default tftp directory by performing
steps 3 through 10 of Table J-13.

9b – Perform steps 25 through 29 of Table J-13, as applicable.

9c – Type the following to delete a possible boot system line in the startup–config file, pressing the
Enter key after the command and at each prompt to confirm the filename and deletion operation:

del  nvram:startup–config

A response similar to the following will be displayed:

BTSRTR1#del nvram:startup–config
Delete filename [startup–config]? 
Delete nvram:startup–config? [confirm]
[OK]
BTSRTR1#

NOTE
Be sure to include the colon (:) after nvram when typing the command.

9d – Verify the startup–config file size has been reduced to a minimum by entering the following:

dir  nvram:

A response similar to the following will be displayed:

Router#dir nvram:
Directory of nvram:/

   53  –rw–           5              <no date>  startup–config
   54  ––––           5              <no date>  private–config

57336 bytes total (57274 bytes free)
BTSRTR1#

10 At the privileged EXEC mode prompt, enter the following:

copy  tftp:btsrtr_canned.color  slot0:canned–config

Where color  =  blue  or  red, as applicable.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned–config
Address or name of remote host []?

. . . continued on next page

J



Verifying IOS Canned Version of the CF Memory Card68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP J-27

Table J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

11 At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:

100.100.100.1

A response similar to the following will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned–config
Address or name of remote host []? 100.100.100.1
Destination filename [canned–config]?

12 At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned–config
Address or name of remote host []? 100.100.100.1
Destination filename [canned–config]?
Loading btsrtr_canned.blue from 100.100.100.1 (via Ethernet0/0): !
[OK – 2457/4096 bytes]

2457 bytes copied in 84.724 secs (29 bytes/sec)
BTSRTR1#

13 Verify that the canned configuration file is saved on the CF memory card by entering dir command.  A
response similar to the following will be displayed:

Directory of slot0:/

  1  –rw–  7051976   Mar 01 1993 00:11:34  mwr1941–i–mz.122–8.MC2a.bin
  2  –rw–     2457   Mar 01 1993 00:14:48  canned–config

31932416 bytes total (24877983 bytes free)
BTSRTR1#

14 To allow the BTS router to boot using the canned configuration, enter the following:

copy canned–config  startup–config

A response similar to the following will be displayed:

BTSRTR1#copy canned–config start
Destination filename [startup–config]?

15 When prompted for the destination file name, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy canned–config start
Destination filename [startup–config]?
2457 bytes copied in 3.52 secs
BTSRTR1#

16 Display and note the file size of startup–config by entering the following:

dir  nvram:

A response similar to the following will be displayed:

Directory of nvram:/

   26  –rw–        2457              <no date>  startup–config
   27  ––––           5              <no date>  private–config

29688 bytes total (24774 bytes free)
BTSRTR1#

. . . continued on next page
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Table J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

17 Scroll the HyperTerminal window back to the slot0: directory display obtained in step 13, above.

18 Compare the file size of startup–config to the canned configuration file to verify the copy operation.
File sizes should be the same.

19 If desired, the contents of the startup–config file may be verified against the file listings at the end of
this appendix for the blue or red canned configuration, as applicable, by entering the following:

show  startup–config

NOTE
Pressing the space bar at the MORE prompt will scroll another screen–full of data. Pressing the Enter
key will scroll the screen one line at a time.

20 Verify the router will boot properly on the IOS and revised startup–config files by entering the
following:

reload

A response similar to the following will be displayed:

BTSRTR1#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

21 If prompted to save a modified configuration, enter  n  for “no,” and press the Enter key.

22 When prompted to proceed with reload, press the Enter key to continue the reload operation.

23 Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations. If the router boots to the rommon prompt, proceed to the Recovery from BTS Router
Boot to rommon section of this appendix.

24 Using the tagging materials, tag the router to clearly identify the installed configuration (blue
(BTSRTR1) or red (BTSRTR2)).

25 Remove the CF memory from the router following the procedure in the 1X SC 4812T BTS FRU Guide
, mark the installed configuration (blue or red) on the card label, and install the card in the router
following the procedure in the FRU Guide.

26 If an additional router must have the canned configuration installed, perform the following:

26a – Disconnect the cabling from the BTS router.

26b – Remove power from the router and disconnect it from the power supply.

26c – Repeat the procedures in Table J-5, Table J-6, and this table (Table J-7) using the additional router.

27 If no additional routers must be configured, perform steps 26a and 26b.

28 On the LMF computer, shut down the tftp server application and exit the HyperTerminal session.

29 If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask
back to those for LMF–BTS communication recorded in Table J-4, step 9b.

CAUTION
If the BTS 10base–2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.
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Method 2: Using a CF Memory Card Reader to Load CF Memory Card

Required Equipment and Software

The following items are required to perform this procedure:

S A Windows–based computer which meets the requirements of the
LMF computer platform as specified in this manual.

S One of the following operating systems for the Windows–based
computer:

– Windows 2000

– Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

S Compact Flash memory card reader device and software driver for the
operating system installed on the LMF computer

CAUTION Card readers for other non–volatile, solid–state memory devices
such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

S Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

S DB–9 plug–to–8–contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

S A copy of the MWR 1941 router IOS version required for the network
where the routers are to be installed (contact the network administrator
and the Motorola account team for information on obtaining the
required MWR 1941 IOS version)

S A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Materials

The following material is required to perform this method:

S Tagging and marking material to identify the BTS router and CF
memory card with the installed configuration (blue or red)

Required Publications

The following publications are required to perform procedures in this
section:

S Cellular System Administration – CDMA OnLine Documentation

S MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78–13983–01

File Operations Using a CF Memory Card Reader

Only file transfers should be performed using the CF memory card
reader. CF memory card formatting should be performed in a BTS router J
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using a HyperTerminal connection. Attempting to format a CF memory
card from a Windows–based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a
Windows–based computer. Only format CF memory cards in a
BTS router.

Verifying IOS Version and Loading BTS Router Canned
Configuration File to CF Memory Card Using a CF
Memory Card Reader

The process of transferring a canned configuration file to a BTS router
using a CF memory card reader consists of the following activities:

1. Transfer the canned configuration file to the router’s CF memory
card using a CF memory card reader

2. Copy the file from the CF memory card to the router’s
startup–config file

The following procedures are used to accomplish these actions.

Prerequisites

The following is required prior to performing this procedure:

S A copy of the required MWR 1941 router IOS version file is installed
in the default tftp directory (transfer the file to the LMF computer
using FTP, internet download, or media such as a Zip disk; file size is
approximately 7–8 MB)

Verifying IOS version and transferring canned
configuration file to the router’s CF memory card

NOTE IMPORTANT: MWR 1941 routers must be loaded with IOS
version mwr1900–i–mz.122–8.MC2d.bin or later. This router
model will not function properly with earlier IOS versions.

Transfer canned configuration files from the LMF computer to a BTS
router CF memory card by following the procedure in Table J-8.

Table J-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 If it has not been done, install a CF memory card loaded with the IOS in the BTS router by following the
procedure in the 1X SC 4812T BTS FRU Guide .

* IMPORTANT
MWR 1941 routers must be loaded with IOS version mwr1900–i–mz.122–8.MC2d.bin or later. This
router model will not function properly with earlier IOS versions.

. . . continued on next pageJ
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Table J-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step Action

2 Connect the LMF computer to the BTS router and start a HyperTerminal communication session with
the router by following the procedure in Table J-2.

3 If it has not been done, be sure the +27 Vdc power supply output is  OFF,  and connect the BTS router
to the +27 Vdc power supply.

4 * IMPORTANT
In this step do not touch the computer keyboard until the router completes the boot process. The router
will buffer any keystrokes made during the boot process and interpret them as commands to be
executed immediately following boot completion.

Apply power to the router and allow it to complete boot–up.

5 If a message similar to the following, is displayed, press the Enter key and proceed to step 7:

Press RETURN to get started!

6 If a message similar to the following, is displayed type no and press the Enter key:

Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system

Would you like to enter basic management setup? [yes/no]:

A response similar to the following will be displayed:

Would you like to enter basic management setup? [yes/no]: no

Cisco Internetwork Operating System Software
IOS (tm) 1941 Software (MWR1941–I–M), Version 12.2(20020127:101239
Copyright (c) 1986–2002 by cisco Systems, Inc.
Compiled Sun 27–Jan–02 06:08 by walrobin

Router>

7 CAUTION
Use only a card reader specifically designed for CF memory cards to perform this procedure. Card
readers for other non–volatile, solid–state memory devices such as Smart Media cards will not work
with the CF memory cards used in the MWR 1941 routers.

If it has not been done, follow the CF memory card reader manufacturer’s instructions to load the CF
memory card driver application for the operating system being used onto the LMF computer.

8 Connect the CF memory card reader to the LMF computer following the card reader manufacturer’s
instructions.

9 Remove the CF memory card from the BTS router by following the procedure in the
 1X SC 4812T BTS FRU Guide 

10 Insert the CF memory card into the card reader as specified by the card reader manufacturer’s
instructions.

11 On the LMF computer, click Start > Programs > Windows Explorer to open Windows Explorer.

. . . continued on next page
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Table J-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step Action

12 NOTE
The CF memory card reader will appear as a disk drive in Windows Explorer with a disk drive letter
and icon.

Scroll the left–hand pane of Windows Explorer to locate the icon for the CF memory card.

13 Verify that the CF memory card contains the required version of the IOS by performing the following:

13a – In the left–hand pane of WindowsExplorer, highlight the CF memory card icon.

13b – In the right–hand pane, note the IOS filename loaded on the card, and record it.

NOTE
The IOS filename will be similar to mwr1941–i–mz.122–8.MC2a.bin.

14 Scroll the left–hand pane of Windows Explorer to locate the icon for the directory where the canned
configuration files downloaded from the OMC–R and required IOS version are stored.

15 In the left–hand pane, highlight the directory where the files are stored.

16 In the the right–hand pane, locate the filename of the required IOS version and compare it to the
filename recorded in step 13b, above.

17 If filenames are different, proceed to Table J-11 to replace the IOS on the CF memory card and return
to step 18, below.

18 In the right–hand pane, highlight the canned configuration file to be transferred to the CF memory
card and drag it to the CF memory card disk drive icon.

19 Verify the canned configuration file has been copied to the CF memory card by clicking on the CF
memory card disk drive icon in the left–hand pane, and verifying that the canned configuration file
appears in the in the right–hand pane.

NOTE
Do not be concerned if the canned configuration file appears before the IOS file in the file sequence
displayed by Windows Explorer. The position of the IOS file in the sequence of files on the CF
memory card can not be verified until the CF memory card is installed in the BTS router.

20 With the CF memory card disk drive icon still selected, change the name of the canned configuration
file on the card to canned–config by doing the following:

20a – In the right–hand pane of Windows Explorer, click on the canned configuration filename.
–– The filename will be highlighted.

20b – Wait approximately two seconds, and then click on the canned configuration file filename again.
–– A hair–line rectangle will appear around the highlighted filename.

20c – After the rectangle appears around the highlighted filename, type the following:
canned–config

20d – Press the Enter key or click on the canned configuration file icon.
–– The rectangle around the canned configuration filename will disappear and the filename will

remain highlighted.

21 Click Files > Close to close Windows Explorer.

. . . continued on next page
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Table J-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step Action

22 Remove the CF memory card with the IOS version and canned configuration file from the card reader,
and mark the card label with the canned configuration (blue or red) copied to it.

23 Install the CF memory card in the BTS router by following the procedure in the 1X SC 4812T BTS
FRU Guide .

24 Proceed to Table J-9 to copy the canned configuration from the CF memory card to the BTS router’s
startup–config file.

 

Copy Canned Configuration File from the CF Memory
Card to the BTS Router’s Startup Configuration and
verify IOS file sequence

 To allow the BTS router to automatically boot using the canned
configuration, the configuration must be copied to the the router’s
startup–config file in NVRAM. Follow the procedure in Table J-9 to
accomplish this.

Table J-9: Copy Canned Configuration File to BTS Router Startup 
Configuration and Verify IOS File Position

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 If it has not been done, install the CF memory card with the canned configuration and required IOS
version in the BTS router by following the procedure in the 1X SC 4812T BTS FRU Guide .

2 At this point, the router should be powered up and displaying the Router> prompt in the
HyperTerminal window of the LMF computer communication session. If it is not, perform steps 1
through 6 of Table J-8.

3 At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:

enable

A response similar to the following will be displayed:

Router>enable
Router#

. . . continued on next page
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Table J-9: Copy Canned Configuration File to BTS Router Startup 
Configuration and Verify IOS File Position

Step Action

4 NOTE
The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the  cd  command. Determine the present working directory by entering  pwd. If
the present working directory has been changed, enter the command  cd  slot0:  to return to the default
setting.

Display the directory listing of the CF memory card by entering the following:

dir

A response similar to the following will be displayed:

Router#dir slot0:
Directory of slot0:/

    1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2a.bin
    2  –rw–        2212   Mar 01 1993 00:14:48  canned–config

31932416 bytes total (24885606 bytes free)
Router#

5 Be sure the IOS file is the first file listed in the directory content display. If it is not, perform the
procedure in Table J-12, and then return to step 6, below.

6 Copy the canned configuration to the BTS router’s startup configuration file by entering the following:

copy  slot0:canned–config  startup–config

A response similar to the following will be displayed:

Router#copy slot0:canned–config start
Destination filename [startup–config]?

7 When prompted for the destination file name, press the Enter key. A response similar to the following
will be displayed:

Router#copy slot0:canned–config start
Destination filename [startup–config]?
2218 bytes copied in 3.52 secs
Router1#

8 Check the file size of the startup–config to verify the copy operation by entering the following:

dir  nvram:

A response similar to the following will be displayed:

Directory of nvram:/

   26  –rw–        2218              <no date>  startup–config
   27  ––––           5              <no date>  private–config

29688 bytes total (25247 bytes free)
Router#

NOTE
Be sure to include the colon (:) after nvram when typing the command.

. . . continued on next page
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Table J-9: Copy Canned Configuration File to BTS Router Startup 
Configuration and Verify IOS File Position

Step Action

9 If desired, the contents of the startup–config file may be verified against the file listings at the end of
this appendix for the blue or red canned configuration, as applicable, by entering the following:

show  startup–config

NOTE
Pressing the space bar at the MORE prompt will scroll another screen–full of data. Pressing the Enter
key will scroll the screen one line at a time.

10 Verify the router will boot properly on the IOS and revised startup–config files by entering the
following:

reload

A response similar to the following will be displayed:

Router#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

11 If prompted to save a modified configuration, enter  n  for “no,” and press the Enter key.

12 When prompted to proceed with reload, press the Enter key to continue the reload operation.

13 Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations. If the router boots to the rommon prompt, proceed to the Recovery from BTS Router
Boot to rommon section of this appendix.

14 Using the tagging materials, tag the router to clearly identify the installed configuration (blue
(BTSRTR1) or red (BTSRTR2)).

15 If an additional router must have the canned configuration installed, perform the following:

15a – Disconnect the cabling for the HyperTerminal communications session from the BTS router, and
minimize the HyperTerminal window on the LMF computer.

15b – Remove power from the router and disconnect it from the power supply.

15c – Repeat the procedures in Table J-8 and this table (Table J-9) using the additional router.

16 If no additional routers must be configured, perform steps 15a and 15b.

17 On the LMF computer, exit the HyperTerminal session.
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Replacing Installed BTS Router CF Memory Card IOS Version

Background

BTS routers are supplied with CF memory cards pre–loaded with a
version of the IOS. Prior to installing the routers in a BTS, the loaded
IOS version should be verified as being the one required for the network.
It is critical to also verify that the IOS file is the first file on the CF
memory card. If another file precedes the IOS file, the BTS router will
not boot properly and will not function in the network.

Equipment and Software Required for Verification Methods

The following items are required to perform this procedure:

S A Windows–based computer which meets the requirements of the
LMF computer platform as specified in Chapter 3 of this manual:

S One of the following operating systems for the Windows–based
computer:

– Windows 2000

– Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

S Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

S DB–9 plug–to–8–contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

S A copy of the MWR 1941 router IOS version required for the network
where the routers are to be installed

NOTE Contact the network administrator or the Motorola Account
Team for assistance in determining and obtaining a copy of the
required IOS version.

S The MWR 1941 will accept a voltage from –60 Vdc to + 60 Vdc
during configuration and file operations

Required Publications

The following publication is required to perform procedures in this
section:

S MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78–13983–01

J
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Method 1: Replacement of Installed Router CF Card IOS Data

Description

This procedure covers using an LMF computer equipped with a tftp
server application to perform the following activities:

1. Verify the IOS version loaded on a CF memory card and running on
a BTS router

2. Replace the IOS version installed in a BTS router

3. Ensure the IOS file is the first file on the CF memory card

Additional required equipment/software

For this method, the following software application is required in
addition to the common items required for both methods:

S Cable, Ethernet crossover, Category 5E or better, unshielded twisted
pair, two 8–contact modular plugs, in one of the following lengths, as
determined necessary:

– 0.3 m (11.8 in) (Motorola pn 3088643C07)

– 0.6 m (23.6 in)(Motorola pn 3088643C13)

– 1.0 m (39.4 in) (Motorola pn 3088643C15)

– 2.1 m (84 in) (Motorola pn 3088643C08)

– 3.0 m (120 in) (Motorola pn 3088643C09)

S A tftp server software application (refer to the Setting Up the TFTP
Server – Procedure in Cellular System Administration – CDMA
OnLine Documentation) such as:

– Cisco tftp server

– PumpKIN tftp server

– Any other equivalent tftp server application

Prerequisites

The following are required prior to performing this procedure:

S The LMF computer and BTS router have been prepared for tftp file
transfer and are operating as they would be after performing the
procedures in Table J-4, Table J-5, Table J-6, and steps 1 through 8 of
Table J-7

S A copy of the required IOS version is loaded into the tftp default
directory of the LMF computer

Replacing installed IOS version and verifying file
sequence position

Follow the procedure in Table J-10 to replace the installed IOS version
using the tftp server application, and ensure the IOS file is first in the
stored file sequence on the CF memory card. J
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Table J-10: Using a TFTP Server Application for Replacing Loaded 
IOS Version and Verifying File Sequence Position

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures in Table J-4, Table J-5, Table J-6, and steps 1
through 8 of Table J-7. If necessary, perform these procedures now.

2 NOTE
The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the  cd  command. Determine the present working
directory by entering  pwd. If the present working directory has been changed, enter the command  cd
slot0:  to return to the default setting.

Identify the filename of the currently loaded IOS which must be replaced by entering dir command. A
response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

    1  –rw–     7051844   Sep 23 2002 07:15:08  mwr1941–i–mz.07022002.bin
    2  –rw–        2212   Mar 01 1993 00:11:00  canned–config

31932416 bytes total (24878360 bytes free)
BTSRTR1#

3 Begin to backup the currently installed version of the router’s IOS to the LMF computer’s default tftp
directory by entering the following:

copy  old_IOS_filename  tftp:

Where old_IOS_filename  =  the filename of the IOS currently loaded on the BTS router CF memory
card.

A response similar to the following will be displayed:

BTSRTR1#copy mwr1941–i–mz.07022002.bin tftp:
Address or name of remote host []?

4 At the remote host prompt, enter the following:

100.100.100.1

A response similar to the following will be displayed:

Address or name of remote host []? 100.100.100.1
Destination filename [mwr1941–i–mz.07022002.bin]?

. . . continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded 
IOS Version and Verifying File Sequence Position

Step Action

5 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename.

A response similar to the following will be displayed if the default filename is selected:

Address or name of remote host []? 100.100.100.1
Destination filename [mwr1941–i–mz.07022002.bin]?
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!
7051844 bytes copied in 109.92 secs (64697 bytes/sec)
BTSRTR1#

6 If additional files are stored on the CF memory card, begin backing them up to the LMF computer’s
default tftp directory by entering the following:

copy  additional_filename  tftp:

Where additional_filename  =  the filename of an additional file loaded on the BTS router CF memory
card.

A response similar to the following will be displayed:

BTSRTR1#copy canned–config tftp:
Address or name of remote host [100.100.100.1]?

7 If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer.

A response similar to the following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]? 
Source filename [canned–config]?

8 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename.

A response similar to the following will be displayed if the default filename is selected:

Source filename [canned–config]? 
Destination filename [canned–config]?

. . . continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded 
IOS Version and Verifying File Sequence Position

Step Action

9 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:

Destination filename [canned–config]?
!
[OK – 2212/4096 bytes]

2212 bytes copied in 0.152 secs
BTSRTR1#

10 If more files are stored on the CF memory card, repeat steps 6 through 9 until all files have been
backed up to the LMF computer.

11 Delete all files from the CF memory card by entering the following command:

format  slot0:

A response similar to the following will be displayed:

BTSRTR1#format slot0:
Format operation may take a while. Continue? [confirm]

12 Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”.  Continue? [confirm]

13 Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation will destroy all data in ”slot0:”.  Continue? [confirm]
Format: Drive communication & 1st Sector Write OK...
Writing Monlib
sectors....................................................................
................
Monlib write complete
.
Format: All system sectors written. OK...

Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720
Format: Operation completed successfully.

Format of slot0 complete
BTSRTR1#

14 Verify all files have been deleted from the CF memory card by entering the dir command. A response
similar to the following will be displayed:

Directory of slot0:/

No files in directory

31932416 bytes total (31932416 bytes free)
BTSRTR1#

. . . continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded 
IOS Version and Verifying File Sequence Position

Step Action

15 Begin to copy the required version of the IOS from the LMF computer to the BTS router by entering the
following:

copy  tftp:new_IOS_filename  slot0:

Where new_IOS_filename  =  the filename of the required IOS for the BTS router.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwr1941–i–mz.122–8.MC2a.bin slot0:
Address or name of remote host [100.100.100.1]?

16 If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]? 
Source filename [mwr1941–i–mz.122–8.MC2a.bin]?

17 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Source filename [mwr1941–i–mz.122–8.MC2a.bin]? 
Destination filename [mwr1941–i–mz.122–8.MC2a.bin]?

18 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is not
correct, enter the correct filename. A response similar to the following will be displayed if the default
filename is selected:

Destination filename [mwr1941–i–mz.122–8.MC2a.bin]? 
Accessing tftp://100.100.100.1/mwr1941–i–mz.122–8.MC2a.bin...
Loading mwr1941–i–mz.122–8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading mwr1941–i–mz.122–8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0):
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!
[OK – 7051976/14103552 bytes]

7051976 bytes copied in 145.108 secs (48634 bytes/sec)
BTSRTR1#

. . . continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded 
IOS Version and Verifying File Sequence Position

Step Action

19 Display the CF memory card directory to verify that the new IOS file is there by entering the dir
command.  A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

    1  –rw–     7051976   Sep 23 2002 07:25:36  mwr1941–i–mz.122–8.MC2a.bin

31932416 bytes total (24880440 bytes free)
BTSRTR1#

20 If any additional files previously stored on the CF memory card are to be copied to the card, perform
the following:

copy  tftp:filename  slot0:

Where filename  =  the filename of the file to be copied to the CF memory card

A response similar to the following will be displayed:

BTSRTR1#copy tftp:canned–config slot0:
Address or name of remote host [100.100.100.1]?

21 If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default IP address is selected:

Address or name of remote host [100.100.100.1]? 
Destination filename [canned–config]?

22 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Destination filename [canned–config]? 
Accessing tftp://100.100.100.1/canned–config...
Loading basic_config from 100.100.100.1 (via FastEthernet0/0): !
[OK – 2212/4096 bytes]

2212 bytes copied in 0.152 secs
BTSRTR1#

23 After the additional file is copied to the CF memory card, display the CF memory card directory by
entering the dir command.  A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2a.bin
2  –rw–        2212   Mar 01 1993 00:09:06  canned–config

24 The IOS file must be the first file listed for the BTS router to boot properly. If it is, proceed to step 29.

. . . continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded 
IOS Version and Verifying File Sequence Position

Step Action

CAUTION
The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

25 If another file is listed before the IOS file, delete the file by performing steps 11 through 13 and
display the directory of the CF memory card as described in step 23 to be sure the file is deleted.

26 Copy the file from the LMF computer to the CF memory card again by performing steps 20 through
23.

27 If the file is again listed before the IOS file in the CF memory card directory display, format the CF
memory card by performing steps 11 through 14 of this table.

28 Copy the IOS file and any other required file to the formatted CF memory card by performing steps 15
through 24.

29 If additional files are to be transferred to the CF memory card, perform steps 20 through 24 for each
one.

30 After making sure the IOS file is the first file on the CF memory card, restart the BTS router with the
new IOS version by entering the following:

reload

A response similar to the following will be displayed:

BTSRTR1#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

31 If prompted to save a modified configuration, enter  n  for “no,” and press the Enter key.

32 When prompted to proceed with reload, press the Enter key to continue the reload operation.

33 Once the router has completed rebooting, change to the privileged EXEC mode and confirm the
booted IOS version is correct by entering the following:

show version

A response similar to the following partial example will be displayed:

BTSRTR1#sh ver
Cisco Internetwork Operating System Software 
IOS (tm) 1941 Software (MWR1941–I–M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc1)
.
.
.

BTSRTR1#

34 Verify the version number displayed in the second line of the version information is the correct IOS
version.

35 If this procedure was entered from step 8 of Table J-7, return to Table J-7, step 9.

. . . continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded 
IOS Version and Verifying File Sequence Position

Step Action

36 If no other BTS router file operations or configuration actions are required, perform the following:

36a – Remove power from the router and disconnect it from the power supply.

36b – Disconnect all other cabling from the BTS router.

36c – On the LMF computer, exit the HyperTerminal communications session.

37 If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask
back to those for LMF–BTS communication recorded in Table J-4, step 9b.

CAUTION
If the BTS 10base–2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.

 

Method 2: Using a CF Memory Card Reader for Replacement of Installed IOS
Version and Changing File Sequence Position

This subsection contains the file replacement and file sequence
manipulation procedures to use when transferring files with a CF
memory card reader.

Replace IOS Version Installed on the CF Memory Card

Description – This procedure covers using an LMF computer equipped
with a CF memory card reader to perform the following activities:

1. Verify the IOS version loaded on a CF memory card and running on
a BTS router

2. Replace the IOS version installed in a BTS router

3. Ensure the IOS file is the first file on the CF memory card

Additional required equipment/software – For this method, the
following equipment item and associated software is required in addition
to the common items required for both methods:

S Compact Flash memory card reader device and software driver for the
operating system installed on the LMF computer

CAUTION Card readers for other non–volatile, solid–state memory devices
such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

Prerequisites – The following are required prior to performing this
procedure:

S The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures in steps 1 through 8 of Table J-8

S A copy of the required IOS version is loaded into the desired directory
of the LMF computerJ
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File operations using a CF memory card reader – Only file transfers
should be performed using the CF memory card reader. CF memory card
formatting should be performed in a BTS router using a HyperTerminal
connection. Attempting to format a CF memory card from a
Windows–based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a
Windows–based computer. Only format CF memory cards in a
BTS router.

Replacing installed IOS version – Follow the procedure in Table J-11
to replace the installed IOS version using a CF memory card reader and
to ensure the IOS file is first in the stored file sequence on the CF
memory card.

Table J-11: Using a CF Memory Card Reader for Replacing 
Loaded IOS Version and Verifying File Sequence Position

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures in steps 1 through 17 of Table J-8. If necessary,
perform these procedures now.

2 With the CF memory card in the CF memory card reader and the card reader icon highlighted in the
left–hand pane of Windows Explorer, perform the following to delete the IOS file from the card:

2a – In the right–hand pane of Windows Explorer, highlight the IOS file to be removed.

2b – Right–click and select Delete from the popup menu.

3 CAUTION
When performing the following step and its associated substeps, files should be moved to and from
the CF memory card one by one to reduce the potential for disrupting the the CF memory card file
sequence. Do not attempt to move multiple files by highlighting and dragging and dropping all of
them at one time.

If there are more files on the CF memory card which must be retained, perform the following:

3a – Scroll the left–hand pane of Windows Explorer to locate the LMF computer directory where the
required IOS version and canned configuration files are stored.

3b – In the right–hand pane, highlight the additional file on the CF memory card which is to be
retained.

3c – While holding down the Ctrl key on the LMF computer, drag and drop the highlighted file into
the directory in the left–hand pane where the required IOS and canned config files are stored.

3d – If additional files loaded on the CF memory card must be retained, repeat steps 3b and 3c for each
file until all files have been moved from the CF memory card to the directory on the LMF
computer.

. . . continued on next page J
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Table J-11: Using a CF Memory Card Reader for Replacing 
Loaded IOS Version and Verifying File Sequence Position

Step Action

4 When all files on the CF memory card have been deleted or moved, as applicable, highlight the
directory in the left–hand pane where the required IOS version and canned configuration files are
stored.

5 Verify that all files from the CF memory card which must be retained were moved to the directory by
checking the filenames in the right–hand pane.

6 Scroll the left–hand pane of Windows Explorer to locate the CF memory card reader icon.

7 In the right–hand pane, highlight the icon for the required version of the IOS.

8 Drag and drop the IOS icon to the CF memory card reader icon to copy it to the CF memory card.

9 If an additional file in the LMF computer directory must be moved to the CF memory card, perform
the following:

9a – In the right–hand pane, highlight one additional file which is to be moved to the CF memory card.

9b – While holding down the Ctrl key on the LMF computer, drag and drop the highlighted file into
the CF memory card reader directory in the left–hand pane.

9c – If additional files in the directory must be placed on the CF memory card, repeat steps 9a and 9b
for each file until all files have been moved one at a time from the LMF computer to the CF
memory card.

10 In the left–hand pane, highlight the CF memory card reader icon.

11 Verify that all required files were moved to the CF memory card by checking the filenames in the
right–hand pane.

12 Scroll the left–hand pane of Windows Explorer to locate the LMF computer directory where the
required IOS version and canned configuration files are stored.

13 Highlight the directory in the left–hand pane.

14 If this procedure was entered from step 17 of Table J-8, return to Table J-8, step 18.

15 If no other file transfer activities between the LMF computer and CF memory card are required at this
time, click Files > Close to close Windows Explorer.

16 Remove the CF memory card from the card reader and install it in the BTS router by following the
procedure in the 1X SC 4812T BTS FRU Guide .

17 At this point, the router should be powered up and displaying the user EXEC prompt in the
HyperTerminal window of the LMF computer communication session. If it is not, perform steps 1
through 6 of Table J-8.

18 At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:

enable

A response similar to the following will be displayed:

Router>enable
Router#

. . . continued on next page
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Table J-11: Using a CF Memory Card Reader for Replacing 
Loaded IOS Version and Verifying File Sequence Position

Step Action

NOTE
The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the  cd  command. Determine the present working
directory by entering  pwd. If the present working directory has been changed, enter the command  cd
slot0:  to return to the default setting.

19 Display the directory listing of the CF memory card by entering the following:

dir

A response similar to the following will be displayed:

Router#dir slot0:
Directory of slot0:/

1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2a.bin
2  –rw–        2212   Mar 01 1993 00:14:48  canned–config

31932416 bytes total (24885606 bytes free)
Router#

CAUTION
The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

20 Be sure the IOS file is the first file listed in the directory content display. If it is not, perform the
procedure in Table J-12, and then return to step 21, below.

21 Verify the router will boot properly on the IOS and revised startup–config files by entering the
following:

reload

A response similar to the following will be displayed:

Router#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

22 If prompted to save a modified configuration, enter  n  for “no,” and press the Enter key.

23 When prompted to proceed with reload, press the Enter key to continue the reload operation.

24 Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations.

25 If no other BTS router file operations or configuration actions are required, perform the following:

25a – Remove power from the router and disconnect it from the power supply.

25b – Disconnect all cabling from the BTS router.

25c – On the LMF computer, exit the HyperTerminal communications session.
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Change CF Memory Card File Sequence to Place IOS File First on the Card

This procedure covers using an LMF computer equipped with a CF
memory card reader to perform the following activities:

1. Change the sequence of files on a CF memory card to place the IOS
version file first

2. Formatting the CF memory card, if necessary, to achieve the
required file sequence positioning of the IOS version file

Prerequisites

The following are required prior to performing this procedure:

S The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures in Table J-8 and steps 1 through 5 of
Table J-9

S Copies of the required IOS version and canned configuration files are
loaded into the desired directory of the LMF computer

Optional equipment/software

If they are available, the following items may be used to change the CF
memory card file sequence once the card is installed in the BTS router:

S Cable, Ethernet crossover, Category 5E or better, unshielded twisted
pair, two 8–contact modular plugs, in one of the following lengths, as
determined necessary:

– 0.3 m (11.8 in) (Motorola pn 3088643C07)

– 0.6 m (23.6 in)(Motorola pn 3088643C13)

– 1.0 m (39.4 in) (Motorola pn 3088643C15)

– 2.1 m (84 in) (Motorola pn 3088643C08)

– 3.0 m (120 in) (Motorola pn 3088643C09)

S A tftp server software application (refer to the Setting Up the TFTP
Server – Procedure in Cellular System Administration – CDMA
OnLine Documentation) such as:

– Cisco tftp server

– PumpKIN tftp server

– Any other equivalent tftp server application

Changing CF memory card file sequence

Follow the procedure in Table J-12 to place the installed IOS version file
first in the stored file sequence on the CF memory card.

J
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Table J-12: Use CF Memory Card Reader to Place IOS File 
First in CF Memory Card File Sequence

Step Action

CAUTION
The file sequence on the CF memory card can not be verified with application programs which place the listed
file names in alphabetical order (for example, certain Unix telnet applications, Unix directory listing
commands, and Windows file managers such as Windows Explorer). This procedure is intended for use only
with applications, such as HyperTerminal, which do not list directory contents alphabetically.

1 This procedure assumes that the LMF computer and BTS router have been prepared for CF memory
card reader file transfer and are operating as they would be after performing the procedures in
Table J-8 and steps 1 through 5 of Table J-9. If necessary, perform these procedures now.

2 NOTE
The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the  cd  command. Determine the present working
directory by entering  pwd. If the present working directory has been changed, enter the command  cd
slot0:  to return to the default setting.

With the CF memory card still installed in the router, display a CF memory card directory listing if
one is not showing by entering the dir command. A response similar to the following will be
displayed:

Router#dir slot0:
Directory of slot0:/

2  –rw–        2212   Mar 01 1993 00:14:48  canned–config
1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2a.bin

31932416 bytes total (24878228 bytes free)
Router#

3 Verify that the IOS file is not the first file on the CF memory card.

4 If a tftp server application is not available on the LMF computer, skip to step 23.

5 If a tftp server is available on the LMF computer, connect the Ethernet crossover cable as shown in
Figure J-4.

6 If it has not been done, configure the LMF computer NIC as directed in Table J-4.

. . . continued on next page
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Table J-12: Use CF Memory Card Reader to Place IOS File 
First in CF Memory Card File Sequence

Step Action

7 Configure FE port FE 0 (fa0/0) by performing the following:

7a – At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC
mode:

enable

A response similar to the following will be displayed:

Router>enable
Router#

7b – At the Router# privileged EXEC mode prompt, enter the following to access the configure
submode:

configure  terminal

A response similar to the following will be displayed:

Router#conf t
Enter configuration commands, one per line. End with CNTL/Z.
Router(config)#

7c – At the global configuration mode prompt, type each of the following commands, pressing the
Enter key after each command:

hostname  btsrtr1
interface  fa0/0
ip  address  100.100.100.2  255.255.255.252
speed  100
duplex  full
no shutdown
line  con  0
exec–timeout  0  0
no  login
line  vty  0  4
no login

Responses similar to the following will be displayed:

Router(config)#hostname BTSRTR1
BTSRTR1(config)#interface fa0/0
BTSRTR1(config–if)#ip address 100.100.100.2 255.255.255.252
BTSRTR1(config–if)#speed 100
BTSRTR1(config–if)#duplex full
BTSRTR1(config–if)#no shutdown
BTSRTR1(config–if)#line con 0
BTSRTR1(config–line)#exec–timeout 0 0
BTSRTR1(config–line)#no login
BTSRTR1(config–line)#line vty 0 4
BTSRTR1(config–line)#no login
BTSRTR1(config–line)#

7d – Once the correct parameters have been set, return to the privileged EXEC mode prompt by
holding down the Ctrl key and pressing z (Ctrl+z). A response similar to the following will be
displayed:

BTSRTR1(config–line)#  ^z
01:11:27: %SYS–5–CONFIG_I: Configured from console by console
BTSRTR1#

. . . continued on next page
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Table J-12: Use CF Memory Card Reader to Place IOS File 
First in CF Memory Card File Sequence

Step Action

7e – Verify  port FE 0 (fa0/0) is configured with the correct IP address by entering the following:

show ip interface brief

A response similar to the following will be displayed:

BTSRTR1#sh ip int br
Interface IP Address OK? Method Status Protocol
FastEthernet0/0 100.100.100.2 YES manual up up
Serial0:0 unassigned YES unset administratively down down
FastEthernet0/1 unassigned YES unset administratively down down
Serial1:0 unassigned YES unset administratively down down

BTSRTR1#

8 Be sure the required IOS file and canned configuration file for the BTS router are located in the tftp
server root directory (refer to Table J-4, step 14 or step 17, as applicable)

9 Delete files from the CF memory card by entering the del  filename command.  A response similar to
the following will be displayed:

Router#del canned–config
Delete filename [canned–config]?

10 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Delete filename [canned–config]? 
Delete slot0:canned–config? [confirm]

11 Press the Enter key to confirm the deletion.

A response similar to the following will be displayed if the default filename is selected:

Delete filename [canned–config]? 
Delete slot0:canned–config? [confirm]
Router#

12 Confirm the file deletion by entering the dir  command.  A response similar to the following will be
displayed:

Router#dir
Directory of slot0:/

    1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2a.bin

31932416 bytes total (24887818 bytes free)
Router#

13 Repeat steps 9 through 12 for each file until all files have been deleted from the CF memory card.

. . . continued on next page
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Table J-12: Use CF Memory Card Reader to Place IOS File 
First in CF Memory Card File Sequence

Step Action

14 Use the tftp server to copy the IOS file from the LMF computer to the CF memory card by enteringthe fol-
lowing:

copy  tftp:IOS_filename  slot0:

Where IOS_filenamer  =  required IOS version filename in the LMF computer tftp server root
directory.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwr1941–i–mz.122–8.MC2a.bin slot0:
Address or name of remote host []?

15 At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:

100.100.100.1

A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwr1941–i–mz.122–8.MC2a.bin slot0:
Address or name of remote host []? 100.100.100.1
Destination filename [mwr1941–i–mz.122–8.MC2a.bin]?

16 At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:mwr1941–i–mz.122–8.MC2a.bin slot0:
Address or name of remote host []? 100.100.100.1
Destination filename [mwr1941–i–mz.122–8.MC2a.bin]?
Accessing tftp://100.100.100.1/mwr1941–i–mz.122–8.MC2a.bin...
Loading mwr1941–i–mz.122–8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading mwr1941–i–mz.122–8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0):
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!
[OK – 7051976/14103552 bytes]

7051976 bytes copied in 145.108 secs (48634 bytes/sec)

. . . continued on next page
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Table J-12: Use CF Memory Card Reader to Place IOS File 
First in CF Memory Card File Sequence

Step Action

17 Display the directory of the CF memory card to confirm the IOS file transfer by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

    1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2a.bin

31932416 bytes total (248880440 bytes free)
Router#

18 Copy the canned configuration file to the CF memory card by entering the following:

copy  tftp:btsrtr_canned.color  slot0:canned–config

Where color  =  blue  or  red, as applicable.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned–config
Address or name of remote host [100.100.100.1]?

19 If the default IP address for the LMF computer displayed in the prompt is correct, press the Enter key
to accept it. If it is missing or not correct, enter the correct IP address.

A response similar to the following will be displayed if the default filename is accepted:

Destination filename [canned–config]? 
2212 bytes copied in 0.208 secs
Router#

20 At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned–config
Address or name of remote host []? 100.100.100.1
Destination filename [canned–config]?
Loading btsrtr_canned.blue from 100.100.100.1 (via Ethernet0/0): !
[OK – 2457/4096 bytes]

2457 bytes copied in 84.724 secs (29 bytes/sec)
BTSRTR1#

21 Determine if the IOS file is now the first file displayed in the directory listing by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

    1  –rw–     7051976   Mar 01 1993 00:14:48  mwr1941–i–mz.122–8.MC2a.bin
    2  –rw–        2212   Sep 23 2002 07:24:18  canned–config

31932416 bytes total (24878228 bytes free)
Router#

22 If the IOS file is the first file displayed, as shown in step 21, above, proceed to step 30.

. . . continued on next page
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Table J-12: Use CF Memory Card Reader to Place IOS File 
First in CF Memory Card File Sequence

Step Action

23 If the IOS is not the first file displayed, as shown in step 2, above, format the CF memory card by
entering the following:

format  slot0:

A response similar to the following will be displayed:

BTSRTR1#format slot0:
Format operation may take a while. Continue? [confirm]

24 Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”.  Continue? [confirm]

25 Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation will destroy all data in ”slot0:”.  Continue? [confirm]
Format: Drive communication & 1st Sector Write OK...
Writing Monlib
sectors....................................................................
................
Monlib write complete
.
Format: All system sectors written. OK...

Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720
Format: Operation completed successfully.

Format of slot0 complete
BTSRTR1#

26 If a tftp server is available on the LMF computer, repeat steps 14 through 22 to transfer the IOS and
canned configuration files to the CF memory card.

27 Once the format operation is completed, remove the CF memory card from the router following the
procedure in the 1X SC 4812T BTS FRU Guide , insert it in the card reader connected to the LMF
computer, and copy the IOS file to the card by performing step 4 and steps 6 through 11 of Table J-11,
as required.

28 Remove the CF memory card from the card reader and install it in the router following the procedure
in the BTS FRU Guide.

29 Be sure that the IOS file is now the first file displayed in the directory listing by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

    1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2a.bin
    2  –rw–        2212   Mar 01 1993 00:14:48  canned–config

31932416 bytes total (24885606 bytes free)
Router#

30 If this procedure was entered from step 5 of Table J-9, return to Table J-9, step 6.

. . . continued on next page
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Table J-12: Use CF Memory Card Reader to Place IOS File 
First in CF Memory Card File Sequence

Step Action

31 If this procedure was entered from step 20 of Table J-11, return to Table J-11, step 21.

32 If no other BTS router file operations or configuration actions are required, perform the following:

32a – Remove power from the router and disconnect it from the power supply.

32b – Disconnect all cabling from the BTS router.

32c – On the LMF computer, exit the HyperTerminal communications session.

33 If a tftp server was used in this procedure and no additional tftp transfer activities will be performed,
change the NIC IP address and subnet mask back to those for LMF–BTS communication recorded in
Table J-4, step 9b.

CAUTION
If the BTS 10base–2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.
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Verify and Upgrade rommon Version

Introduction

BTS routers are supplied pre–loaded with a version of the ROM monitor
(rommon) low–level operating system. Along with the IOS version, the
loaded rommon version should be verified as being the one required for
the network. Procedures in this section are used to verify the loaded
rommon version, and, if necessary, change it to the required version.
Methods are provided for using either a tftp server or CF memory card
reader to transfer the required rommon version to a BTS router’s CF
memory card.

Equipment and Software Required for Verification

The following items are required to perform rommon verification:

S A Windows–based computer which meets the requirements of the
LMF computer platform as specified in this manual.

S One of the following operating systems for the Windows–based
computer:

– Windows 2000

– Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

S Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

S DB–9 plug–to–8–contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

S A copy of the MWR 1941 router rommon version required for the
network where the routers are to be installed

NOTE Contact the network administrator or the Motorola Account
Team for assistance in determining and obtaining a copy of the
required rommon version.

S A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Publications

The following publication is required to perform procedures in this
section:

S MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78–13983–01J
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Method 1: In–Router Verification and Replacement of Installed rommon
Version

Description

This procedure covers using an LMF computer equipped with a tftp
server application to perform the following activities:

1. Verify the rommon version loaded and running on a BTS router

2. Replace the rommon version installed in a BTS router

Additional required equipment/software

For this method, the following equipment and software application is
required in addition to the common items required for both methods:

S Cable, Ethernet crossover, Category 5E or better, unshielded twisted
pair, two 8–contact modular plugs, in one of the following lengths, as
determined necessary:

– 0.3 m (11.8 in) (Motorola pn 3088643C07)

– 0.6 m (23.6 in)(Motorola pn 3088643C13)

– 1.0 m (39.4 in) (Motorola pn 3088643C15)

– 2.1 m (84 in) (Motorola pn 3088643C08)

– 3.0 m (120 in) (Motorola pn 3088643C09)

S A tftp server software application (refer to the Setting Up the TFTP
Server – Procedure in Cellular System Administration – CDMA
OnLine Documentation) such as:

– Cisco tftp server

– PumpKIN tftp server

– Any other equivalent tftp server application

Prerequisites

The following are required prior to performing this procedure:

S The LMF computer and BTS router have been prepared for tftp file
transfer and are operating as they would be after performing the
procedures in Table J-4, Table J-5, Table J-6, and steps 1 through 8 of
Table J-7

S A copy of the required rommon version is loaded into the tftp default
directory of the LMF computer

Verifying and replacing installed rommon version

Follow the procedure in Table J-13 to verify and, if necessary, replace
the installed rommon version using the tftp server application.

J
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures in Table J-4, Table J-5, Table J-6, and steps 1
through 4 of Table J-7. If necessary, perform these procedures now.

2 Determine the currently installed rommon version by entering the following at the router privileged
EXEC mode prompt:

show version

A response similar to the following will be displayed:

BTSRTR1#sh ver
Cisco Internetwork Operating System Software 
IOS (tm) 1941 Software (MWR1941–I–M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)
TAC Support: http://www.cisco.com/tac
Copyright (c) 1986–2002 by cisco Systems, Inc.
Compiled Mon 05–Aug–02 11:07 by nmasa
Image text–base: 0x60008940, data–base: 0x60B54000

ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose–wilma 109], DEVELOPMENT
SOFTWARE
ROM: 1941 Software (MWR1941–I–M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fc3)

Router uptime is 1 minute
System returned to ROM by power–on
System image file is ”slot0:mwr1941–i–mz.122–8.MC2b.bin”

cisco mwr1941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS
R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.
X.25 software, Version 3.0.0.
Primary Rate ISDN software, Version 1.1.
Toaster processor tmc is running.
2 FastEthernet/IEEE 802.3 interface(s)
2 Serial network interface(s)
2 Channelized T1/PRI port(s)
DRAM configuration is 64 bits wide with parity disabled.
55K bytes of non–volatile configuration memory.
31360K bytes of ATA Slot0 CompactFlash (Read/Write)

Configuration register is 0x101

BTSRTR1#

3 To determine the currently installed rommon version, examine the ROM: System Bootstrap line in the
response.

. . . continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action

4 Compare the installed rommon version information with the filename of the rommon version required
for the network.

NOTE
1. Rommon filename format is similar to the following:

MWR1941_RM2.srec.122–8r.MC3.bin

2. The rommon filename reflects the version number of the software (122–8r.MC3).

5 If the installed version is the one required for the network skip to step 26.

6 If the installed rommon version is not the one required for the network, backup the current BTS router
configuration to the LMF computer by entering the following:

copy nvram:startup–config tftp

A response similar to the following will be displayed:

BTSRTR1#copy nvram:start tftp
Address or name of remote host []?

NOTE
Be sure to include the colon (:) after nvram when typing the command.

7 At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:

100.100.100.1

A response similar to the following will be displayed:

BTSRTR1#copy copy nvram:start tftp
Address or name of remote host []? 100.100.100.1
Source filename [startup–config]?

8 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Source filename [startup–config]? 
Destination filename [startup–config]?

9 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:

Destination filename [startup–config]?
!
[OK – 2212/4096 bytes]

2212 bytes copied in 0.152 secs
BTSRTR1#

. . . continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action

10 NOTE
The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the  cd  command. Determine the present working directory by entering  pwd. If
the present working directory has been changed, enter the command  cd  slot0:  to return to the default
setting.

Determine the amount of memory available (bytes free) on the CF memory card by entering the dir
command. A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2b.bin
2  –rw–        2212   Mar 01 1993 00:14:48  canned–config

31932416 bytes total (24885606 bytes free)
Router#

11 Be sure there is at least 1 MB (1048580) of free memory.

NOTE
A rommon version file requires approximately 0.7 MB.

12 Begin to copy the required version of the rommon file from the LMF computer to the BTS router by entering
the following:

copy  tftp:new_rommon_filename  slot0:

Where new_rommon_filename  =  the filename of the required rommon version for the BTS router.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:MWR1941_RM2.srec.122–8r.MC3.bin slot0:
Address or name of remote host [100.100.100.1]?

13 If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]? 
Source filename [MWR1941_RM2.srec.122–8r.MC3.bin]?

14 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Source filename [MWR1941_RM2.srec.122–8r.MC3.bin]? 
Destination filename [MWR1941_RM2.srec.122–8r.MC3.bin]?

. . . continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action

15 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is not
correct, enter the correct filename. A response similar to the following will be displayed if the default
filename is selected:

Destination filename [MWR1941_RM2.srec.122–8r.MC3.bin]? 
Accessing tftp://100.100.100.1/MWR1941_RM2.srec.122–8r.MC3.bin...
Loading MWR1941_RM2.srec.122–8r.MC3.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading MWR1941_RM2.srec.122–8r.MC3.bin from 100.100.100.1 (via FastEthernet0/0):
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
[OK – 614306/14103552 bytes]

614306 bytes copied in 13.059 secs (48634 bytes/sec)
BTSRTR1#

16 Display the CF memory card directory to verify that the new rommon version file is there by entering
the dir command. A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

  1  –rw–    7051976   Sep 23 2002 07:25:36  mwr1941–i–mz.122–8.MC2b.bin
  2  –rw–       2212   Mar 01 1993 00:09:06  canned–config
  3  –rw–     614306   Dec 13 2002 14:59:36  MWR1941_RM2.srec.122–8r.MC3.bin

31932416 bytes total (24263922 bytes free)
BTSRTR1#

17 Replace the existing rommon version with the new one copied to the CF memory card by entering the
following:

upgrade rom–monitor file  slot0:MWR1941_RM2.srec.122–8r.MC3

A response similar to the following will be displayed:

BTSRTR1#This command will reload the router. Continue?[yes/no]

18 When prompted to continue, enter  yes  and press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#This command will reload the router. Continue?[yes/no] yes
ROMMON image upgrade in progress
Erasing boot flash
eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee
Programming boot flash pppp
Now reloading

19 When the router has completed initialization, change to the router privileged EXEC mode by entering
the following:

enable

A response similar to the following will be displayed:

BTSRTR1>enable
BTSRTR1#

. . . continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action

20 Verify the router has initialized with the new rommon version by entering the following:

show version

A response similar to the following partial response will be displayed:

BTSRTR1#sh ver
Cisco Internetwork Operating System Software 
IOS (tm) 1941 Software (MWR1941–I–M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)
TAC Support: http://www.cisco.com/tac
Copyright (c) 1986–2002 by cisco Systems, Inc.
Compiled Mon 05–Aug–02 11:07 by nmasa
Image text–base: 0x60008940, data–base: 0x60B54000

ROM: System Bootstrap, Version 12.2(8r)MC3 RELEASE SOFTWARE (fc1)

21 Compare the version displayed in the response ROM: System Bootstrap line to the filename of the
new rommon version file copied to the CF memory card.

22 If the router successfully rebooted with the new rommon version, the rommon file can be deleted from
the CF memory card by entering the following:

delete  slot0:new_rommon_filename

Where new_rommon_filename  =  the filename of the required rommon version copied to the CF
memory card in steps 12 through 15, above.

A response similar to the following will be displayed:

BTSRTR1#del slot0:MWR1941_RM2.srec.122–8r.MC3.bin
Delete filename [MWR1941_RM2.srec.122–8r.MC3.bin]?

23 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Delete filename [MWR1941_RM2.srec.122–8r.MC3.bin]? 
Delete slot0:MWR1941_RM2.srec.122–8r.MC3.bin? [confirm]

24 Press the Enter key to confirm the deletion. A response similar to the following will be displayed if
the default filename is selected:

Delete filename [MWR1941_RM2.srec.122–8r.MC3.bin]? 
Delete slot0:MWR1941_RM2.srec.122–8r.MC3.bin? [confirm]
BTSRTR1#

CAUTION
In this step, do not delete the IOS and canned–config files from the CF memory card. The BTS router
must have these files on the card to properly boot or switch between packet and circuit mode.

25 If additional unnecessary files, such as a backup of the startup–config file, are also on the CF
memory card, delete them by repeating steps 22 through 24 for each file.

26 If no other BTS router file operations or configuration actions are required, perform the following:

26a – Remove power from the router and disconnect it from the power supply.

26b – Disconnect all cabling from the BTS router.

26c – On the LMF computer, exit the HyperTerminal communications session.

. . . continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action

27 If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask
back to those for LMF–BTS communication recorded in Table J-4, step 9b.

CAUTION
If the BTS 10base–2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.

 

Method 2: Verification and Replacement of Installed rommon Version Using
a CF Memory Card Reader

Description

This procedure covers using an LMF computer equipped with a CF
memory card reader to perform the following activities:

1. Verify the rommon version loaded and running on a BTS router

2. Replace the rommon version installed in a BTS router

Additional required equipment/software

For this method, the following equipment item and associated software
is required in addition to the common items required for both methods:

S CF memory card reader device and software driver for the operating
system installed on the LMF computer

CAUTION Card readers for other non–volatile, solid–state memory devices
such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

Prerequisites

The following are required prior to performing this procedure:

S The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures in steps 1 through 8 of Table J-8

S A copy of the required rommon version is loaded into the desired
directory of the LMF computer

File operations using a CF memory card reader

Only file transfers should be performed using the CF memory card
reader. CF memory card formatting should be performed in a BTS router
using a HyperTerminal connection. Attempting to format a CF memory
card from a Windows–based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a
Windows–based computer. Only format CF memory cards in a
BTS router. J
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Verifying and replacing installed rommon version

Follow the procedure in Table J-14 to verify and, if necessary replace the
installed rommon version using a CF memory card reader.

Table J-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures in steps 1 through 8 of Table J-8. If necessary,
perform these procedures now.

2 Determine the currently installed rommon version by entering the following at the router privileged
EXEC mode prompt:

show version

A response similar to the following will be displayed:

BTSRTR1#sh ver
Cisco Internetwork Operating System Software 
IOS (tm) 1941 Software (MWR1941–I–M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)
TAC Support: http://www.cisco.com/tac
Copyright (c) 1986–2002 by cisco Systems, Inc.
Compiled Mon 05–Aug–02 11:07 by nmasa
Image text–base: 0x60008940, data–base: 0x60B54000

ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose–wilma 109], DEVELOPMENT
SOFTWARE
ROM: 1941 Software (MWR1941–I–M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fc3)

Router uptime is 1 minute
System returned to ROM by power–on
System image file is ”slot0:mwr1941–i–mz.122–8.MC2b.bin”

cisco mwr1941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS
R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.
X.25 software, Version 3.0.0.
Primary Rate ISDN software, Version 1.1.
Toaster processor tmc is running.
2 FastEthernet/IEEE 802.3 interface(s)
2 Serial network interface(s)
2 Channelized T1/PRI port(s)
DRAM configuration is 64 bits wide with parity disabled.
55K bytes of non–volatile configuration memory.
31360K bytes of ATA Slot0 CompactFlash (Read/Write)

Configuration register is 0x101

BTSRTR1#

3 To determine the currently installed rommon version, examine the ROM: System Bootstrap line in
the response.

. . . continued on next pageJ
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Table J-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step Action

4 Compare the installed rommon version information with the filename of the rommon version required
for the network.

NOTE
1. Rommon filename format is similar to the following:

MWR1941_RM2.srec.122–8r.MC3.bin

2. The rommon filename reflects the version number of the software (122–8r.MC3).

5 If the installed version is the one required for the network skip to step 25.

6 NOTE
The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the  cd  command. Determine the present working directory by entering  pwd. If
the present working directory has been changed, enter the command  cd  slot0:  to return to the default
setting.

If the installed rommon version is not the one required for the network, determine the amount of
memory available (bytes free) on the CF memory card by entering the following:

dir

A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

    1  –rw–     7051976   Sep 23 2002 07:24:18  mwr1941–i–mz.122–8.MC2b.bin
    2  –rw–        2212   Mar 01 1993 00:14:48  canned–config

31932416 bytes total (24885606 bytes free)
Router#

7 Be sure there is at least 1 MB (1048580) of free memory.

NOTE
A rommon version file requires approximately 0.7 MB, and space must also be available for a backup
of the router’s startup–config file.

8 Create a backup of the current BTS router configuration on the CF memory card by entering the
following:

copy nvram:startup–config slot:0

A response similar to the following will be displayed:

BTSRTR1#copy nvram:startup–config slot0:
Destination filename [startup–config]?

9 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:

Destination filename [startup–config]? 
2212 bytes copied in 4.96 secs (553 bytes/sec)
BTSRTR1#

10 Remove the CF memory card from the router by following the procedure in the 1X SC 4812T BTS
FRU Guide .

. . . continued on next page
J
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Table J-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step Action

11 Insert the CF memory card into the card reader as specified by the card reader manufacturer’s
instructions.

12 On the LMF computer, click Start > Programs > Windows Explorer to open Windows Explorer.

13 NOTE
The CF memory card reader will appear as a disk drive in Windows Explorer with a disk drive letter
and icon.

Scroll the left–hand pane of Windows Explorer to locate the icon for the CF memory card.

14 In the left–hand pane of WindowsExplorer, highlight the CF memory card icon.

15 In the right–hand pane, verify the files displayed in step 6, above, appear.

16 Scroll the left–hand pane of Windows Explorer to locate the icon for the directory where the required
rommon version file is stored.

17 In the right–hand pane, highlight the startup–config file on the CF memory card, note its file size,
and drag it to the icon for the directory where the required rommon version file is stored.

NOTE
After highlighting the startup–config file in the right–hand pane, it may be necessary to scroll the
left–hand pane to see the directory icon where the required rommon version file is stored before
dragging the file.

18 In the left–hand pane, highlight the directory where the required rommon version file is stored.

19 In the right–hand pane, verify the startup–config file is in the directory and the file size is the
same as the original on the CF memory card.

20 In the right–hand pane, highlight the required rommon version file to be transferred to the CF memory
card and drag it to the CF memory card disk drive icon.

NOTE
After highlighting the rommon version file in the right–hand pane, it may be necessary to scroll the
left–hand pane to see the CF memory card disk drive icon before dragging the file.

21 Verify the rommon version file has been copied to the CF memory card by clicking on the CF memory
card disk drive icon in the left–hand pane, and being sure that the rommon version file appears in the
in the right–hand pane.

22 Click Files > Close to close Windows Explorer.

23 Remove the CF memory card with the rommon version file from the card reader.

24 Install the CF memory card in the BTS router by following the procedure in the 1X SC 4812T BTS
FRU Guide .

25 Proceed to Replace installed rommon version, below.

 

J
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Recovery From BTS Router Boot to rommon

Introduction

ROM monitor boot conditions

Under certain circumstances the BTS router will initialize with the ROM
monitor (rommon) operating system rather than the IOS. These
circumstances include:

S IOS file is missing from the CF memory card

S IOS file is not the first file on the CF memory card

S IOS file image on the CF memory card is corrupted

S Startup–config file contains an outdated boot system line specifying
an IOS file which has been replaced with an updated version

S Startup–config file contains boot system line with typographical
error(s) in the IOS filename

Description

Router operation on rommon is signalled by the display of the  rommon
# >  prompt, where # is a number which increments each time a
command is issued. Rommon is a low–level operating system which
provides limited capabilities for router testing and troubleshooting
operations, but does not support any operations on files beyond viewing
directory contents or booting from a specified file. As a result, files can
not be copied or deleted when the router is operating on rommon.

Recovery methods

Two recovery methods are included in this section. The first is the
simplest and requires that a valid, uncorrupted IOS version is installed
on the CF memory card. The second method requires additional
equipment and must be used in instances such as when an IOS file is not
installed on the CF memory card or the installed IOS image is corrupted.

Simple Recovery from Boot to rommon

Requirements

Unless it is certain, that the IOS image on the CF memory card is
corrupted, this method should always be the first attempted to recover
the router from a rommon initialization. This method does not require
any additional equipment beyond the items necessary to load canned
configuration files into the BTS router. To be effective, this method does
require that a valid, uncorrupted IOS image file is installed on the
router’s CF memory card.

Recovery

Follow the procedure in Table J-15 to attempt a simple recovery from a
BTS router rommon initialization. J
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Table J-15: Simple Recovery from BTS Router rommon Boot

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer is set up and connected to the BTS router with an active
HyperTerminal communication session. If it is not, follow the procedure in Table J-2 to establish a
HyperTerminal communication session.

2 With the rommon 1 > prompt displayed in the HyperTerminal window, enter the following to identify
the IOS file on the CF memory card:

dir  slot0:

A response similar to the following will be displayed:

rommon 1 > dir slot0:

program load complete, entry point: 0x80008000, size: 0xb2a0

Directory of slot0:

2      2212      –rw–     canned–config

3      7051976   –rw–     mwr1941–i–mz.122–8.MC2a.bin

rommon 2 >

. . . continued on next page
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Table J-15: Simple Recovery from BTS Router rommon Boot

Step Action

3 Note the IOS filename, and enter the following to begin recovery to an IOS boot:

boot  slot0:IOS_filename

Where IOS_filename  =  the filename of the IOS noted in step 2, above.

A successful IOS re–boot operation will result in display of a response which begins and ends similar
to the following:

rommon 2 > boot slot0:mwr1941–i–mz.122–8.MC2a.bin

program load complete, entry point: 0x80008000, size: 0xb2a0

program load complete, entry point: 0x80008000, size: 0x6b99ac

Self decompressing the image :
################################################################### [OK]

Smart Init is enabled

smart init is sizing iomem

  ID            MEMORY_REQ                 TYPE

00031A          0X005F3C00 MWR1941 Mainboard

                0X000F3BB0 public buffer pools

                0X00211000 public particle pools

TOTAL:          0X008F87B0
.
.
.
Press RETURN to get started!

4 If the router successfully reboots with the IOS, proceed to step 7.

5 If the router does not reboot with the IOS, perform the following:

5a – Scroll the HyperTerminal display down until the directory display from step 2, above, is visible.

5b – Compare the IOS filename from the directory display with the filename entered in performing step
3, above.

5c – If the filename was typed incorrectly, repeat step 3, using care to type the filename correctly.

6 If the router does not reboot with the IOS after typing the filename correctly, proceed to Table J-16 and
perform the extended recovery procedure.

. . . continued on next page
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Table J-15: Simple Recovery from BTS Router rommon Boot

Step Action

CAUTION
The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

7 After a successful reboot with IOS, perform the following to correct the cause of the boot to rommon:

7a – Enter the  dir  slot0:  command to display the CF memory card directory, and, if the IOS file is
not the first file listed, perform the procedure in Table J-10, steps 25 through 32, or Table J-12, as
applicable, to correct the situation.

7b – If the IOS file is the first file, enter the following command to display the contents of the
startup–config file:

show  startup–config

A response which begins similar to the following will be displayed:

BTSRTR1#sh start
Using 1589 out of 57336 bytes
!
version 12.2
service timestamps debug uptime
service timestamps log uptime
no service password–encryption
!
hostname BTSRTR1
!
boot system slot0:mwr1941–i–mz.07132002.bin
no logging console
!
username cisco password 0 cisco
!
redundancy
  mode y–cable
   standalone
!

7c – If the file listing contains a “boot system” line, examine it for the correct IOS filename.

7d – If the boot system slot0: filename is incorrect, enter the following, using care to type the filename
correctly:

boot system slot0:IOS_filename

Where IOS_filename  =  the filename of the IOS noted in step 2, above.

7e – Replace the boot system line in the startup–config file with the line entered in step 7d, above, by
entering the following:

copy  runing–config  startup–config

. . . continued on next page

J



Recovery From BTS Router Boot to rommon68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP J-71

Table J-15: Simple Recovery from BTS Router rommon Boot

Step Action

7f – Verify the correct IOS filename is now included in the listing by entering the following:

show  startup–config

A response which begins similar to the following will be displayed:

BTSRTR1#sh start
Using 1589 out of 57336 bytes
!
version 12.2
service timestamps debug uptime
service timestamps log uptime
no service password–encryption
!
hostname BTSRTR1
!
boot system slot0:mwr1941–i–mz.122–8.MC2a.bin
no logging console
!
username cisco password 0 cisco
!
redundancy
  mode y–cable
   standalone
!

7g – If the filename is correctly written, enter the following to determine if the router will reboot to
IOS:

reload

A response similar to the following will be displayed:

BTSRTR1#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

8 If prompted to save a modified configuration, enter  n  for “no,” and press the Enter key.

9 When prompted to proceed with reload, press the Enter key to continue the reload operation.

10 After a successful reboot with IOS, proceed with other BTS router activities or remove power from the
router and disconnect it

11 If the router still will not successfully boot with IOS, proceed to Table J-16 and perform the extended
recovery procedure.

 

Extended Recovery from Boot to rommon

Requirements

If rommon boot recovery attempts fail using the simple recovery
method, this method must be used to reboot a BTS router which has
initialized with rommon. This method requires additional equipment
beyond the items necessary to load canned configuration files into the
BTS router. Extended recovery requires formatting the CF memory card
from the rommon–initialized router and reloading the reformatted CF
memory card with the required IOS version. J
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Additional equipment required

An additional, formatted, 32 MB CF memory card with the required
version of the IOS installed is required in addition to the equipment and
software required for BTS router canned configuration installation. This
card may be:

S A spare CF memory card which is loaded with the required IOS
version

S A CF memory card from an additional BTS router which is loaded
with the required IOS version

Recovery

Follow the procedure in Table J-15 to perform an extended recovery
from a BTS router rommon initialization.

Table J-16: Extended Recovery from BTS Router rommon Boot

Step Action

1 This procedure assumes the BTS router is powered and operating on rommon with the LMF computer
set up and connected to the router with an active HyperTerminal communication session. If it is not,
follow the procedure in Table J-2 to establish a HyperTerminal communication session.

2 Remove the CF memory card from the BTS router following the procedure in the 1X SC 4812T BTS
FRU Guide .

3 Install the additional CF memory card in the router following the procedure in the BTS FRU Guide.

4 Enter the following to obtain the filename of the IOS version loaded on the CF memory card:

dir  slot0:

A response similar to the following will be displayed:

rommon 1 > dir slot0:

program load complete, entry point: 0x80008000, size: 0xb2a0

Directory of slot0:

1      7051976   –rw–     mwr1941–i–mz.122–8.MC2a.bin

rommon 2 >

5 Note the exact filename displayed for the IOS version.

. . . continued on next page
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Table J-16: Extended Recovery from BTS Router rommon Boot

Step Action

6 Enter the following to initialize the router with the IOS on the additional CF memory card:

boot  slot0:IOS_filename

Where IOS_filename  =  the filename of the IOS noted in step 5, above.

A successful IOS re–boot operation will result in display of a response which begins and ends similar
to the following:

rommon 2 > boot slot0:mwr1941–i–mz.122–8.MC2a.bin

program load complete, entry point: 0x80008000, size: 0xb2a0

program load complete, entry point: 0x80008000, size: 0x6b99ac

Self decompressing the image :
################################################################### [OK]

Smart Init is enabled

smart init is sizing iomem

  ID            MEMORY_REQ                 TYPE

00031A          0X005F3C00 MWR1941 Mainboard

                0X000F3BB0 public buffer pools

                0X00211000 public particle pools

TOTAL:          0X008F87B0
.
.
.

         ––– System Configuration Dialog –––

Would you like to enter the initial configuration dialog? [yes/no]: n

7 If the router prompts with a question to enter the initial dialog as shown in step 6, above, type  no  and
press the Enter key to obtain the user EXEC mode prompt.

8 If the router prompts with Press RETURN to get started!, press the Enter key to obtain the user
EXEC mode prompt.

9 At the user EXEC mode prompt, enter the following to access the privileged EXEC mode:

enable

A response similar to the following will be displayed:

Router> enable
Router#

10 Remove the additional CF memory card from the BTS router following the procedure in the 1X SC
4812T BTS FRU Guide .

11 Install the original CF memory card in the router following the procedure in the BTS FRU Guide.

. . . continued on next page
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Table J-16: Extended Recovery from BTS Router rommon Boot

Step Action

12 Format the original CF memory card by entering the following:

format  slot0:

A response similar to the following will be displayed:

Router#format slot0:
Format operation may take a while. Continue? [confirm]

13 Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”.  Continue? [confirm]

14 Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation will destroy all data in ”slot0:”.  Continue? [confirm]
Format: Drive communication & 1st Sector Write OK...
Writing Monlib
sectors....................................................................
................
Monlib write complete
.
Format: All system sectors written. OK...

Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720
Format: Operation completed successfully.

Format of slot0 complete
Router#

15 Copy the required IOS version to the formatted original CF memory card by performing one of the
following:

S Use the LMF computer and a tftp server following the procedure in Table J-10

S Use the LMF computer and a CF memory card reader following the procedure in Table J-11

16 If applicable, perform IOS initialization troubleshooting as described in Table J-15, steps 7 through 10.
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Entering or Changing Router FE Interface IP Address
It may be necessary to enter or change the IP addresses and/or operating
parameters for BTS router FE interfaces FE 0 and FE1 without making
other changes in the router configuration files. Procedures in this section
cover these operations.

Prerequisites

The following must be accomplished before entering or changing BTS
router FE port IP addresses and/or operating parameters:

S The user has read and understands the content of MWR1941 Wireless
Mobile Edge Router Software Configuration Guide; part number
78–13983–01

S BTS routers must have the required version of the IOS saved on their
installed CF memory card

S BTS routers must have power applied, be operating without alarms
other than span alarms, and have completed boot–up to the user EXEC
mode prompt (BTSRTR–bts#–1–1>)

S The BTS router privileged EXEC mode password has been obtained
from the network administrator

Entering or Changing FE Interface IP Addresses

To enter or change FE interface IP addresses, follow the procedure in
Table J-17.

Table J-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step Action

* IMPORTANT
This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78–13983–01. Have this
publication available for reference while performing this procedure.

1 Obtain the correct IP addresses and subnet masks for the BTS router FE interfaces from the network
administrator.

2 If a HyperTerminal connection for BTS card/module MMI or BTS router (BTSRTR) communication
has not been created, create one as described in Table J-1 of this appendix.

3 Connect the LMF computer to the BTS router, and start a communication session as described in
Table J-2 in this appendix.

. . . continued on next page
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Table J-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step Action

4 NOTE
Examples in this procedure show prompts for BTSRTR–bts#–1–1 and BTSRTR–bts#–1–2, but the
procedure can be used for any router in any BTS router group or a router running the canned
configuration file (BTSRTR1 or BTSRTR2).

At the BTSRTR–bts#–1–1> user EXEC mode prompt, enter the following to access the privileged EXEC
mode:

enable

A response similar to the following will be displayed:

BTSRTR–bts#–1–1> enable
Password:

5 Enter the privileged EXEC mode password. A response similar to the following will be displayed:

BTSRTR–bts#–1–1> enable
Password:

BTSRTR–bts#–1–1#

6 At the BTSRTR–bts#–1–1# privileged EXEC mode prompt, display the FE interface IP addresses by
typing:

show ip interface brief

A response similar to the following will be displayed:

BTSRTR–bts#–1–1#  show ip interface brief
Interface IP Address OK? Method
Status Protocol

FastEthernet0/0 192.168.146.1 YES
NVRAM up up
Serial0:0 unassigned YES unset
administratively down down
FastEthernet0/1 unassigned YES
unset administratively down down
Serial1:0 unassigned YES unset
administratively down down

BTSRTR–bts#–1–1#

7 For a FastEthernet0/0 (fa0/0) or FastEthernet0/1(fa0/1) interface which does not have a correct or an
assigned IP address, enter the following at the router prompt to access the global configuration mode:

configure  terminal

A response similar to the following will be displayed:

BTSRTR–bts#–1–1#  conf t
Enter configuration commands, one per line. End with CNTL/Z.
BTSRTR–bts#–1–1(config)#

. . . continued on next page

J



Entering or Changing Router FE Interface IP Address68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP J-77

Table J-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step Action

8 At the global configure mode prompt, enter the following to access the configure interface submode
for the interface requiring IP address assignment/change:

interface  fastethernetinterface#

Where interface#  =  0/0 or 0/1, as applicable.

A response similar to the following will be displayed:

BTSRTR–bts#–1–1(config)#  int fa0/1

BTSRTR–bts#–1–1(config–if)#

9 At the configure interface submode prompt, assign or change the interface IP address by entering:

ip address  IP_addr  subnet_mask

Where:
IP_addr  =  the required IP address for the interface; for example, 192.168.147.1
subnet_mask  =  the required subnet mask for the interface; for example, 255.255.255.0

A response similar to the following will be displayed:

BTSRTR–bts#–1–1(config–if)#  ip address  192.168.147.1  255.255.255.0

BTSRTR–bts#–1–1(config–if)#

10 To complete configuration of the interface, enter the following parameter settings, one at a time,
pressing Enter after each:

duplex full

speed 100

keepalive 1

no shutdown

11 Return to the global configuration mode by entering the exit command. A response similar to the
following will be displayed:

BTSRTR–bts#–1–1(config–if)#  exit

BTSRTR–bts#–1–1(config)#

12 If the IP address and/or parameters for the other FE interface on the router must be assigned or
changed at this time, repeat steps 8 through 11 for the other FE interface.

13 Once the correct parameters have been set for all FE interfaces, return to the privileged EXEC mode
prompt by holding down the Ctrl key and pressing z (Ctrl +z).  A response similar to the following
will be displayed:

BTSRTR–bts#–1–1(config–if)#  ^z
01:11:27: %SYS–5–CONFIG_I: Configured from console by console
BTSRTR–bts#–1–1#

NOTE
Entering exit twice, pressing the Enter key after each entry, will also complete the interface
configuration and return the router to the privileged EXEC mode.

. . . continued on next page
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Table J-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step Action

14 Save the interface configuration changes to the startup configuration file on the CF memory card by
entering the following:

copy  running–config  startup–config

A response similar to the following will be displayed:

BTSRTR–bts#–1–1#  copy run start
BTSRTR–bts#–1–1#  Destination filename [startup–config]?

15 Press Enter. A response similar to the following will be displayed:

BTSRTR–bts#–1–1#  copy run start
BTSRTR–bts#–1–1#  Destination filename [startup–config]?
Building configuration...
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!![OK]
BTSRTR–bts#–1–1#

16 If all FE IP address entries/changes for the router are complete, enter the following to return the router
to user EXEC mode:

disable

A response similar to the following will be displayed:

BTSRTR–bts#–1–1#  disable
BTSRTR–bts#–1–1>

17 If no other router requires the FE interfaces to be assigned/changed, proceed to step 20.

18 If FE interfaces on another router must be assigned/changed, disconnect the 8–contact modular plug
from the current router CONSOLE port and connect it to the CONSOLE port of the other router.

19 Press the Enter key, and when the router user EXEC mode prompt appears repeat steps 3 through 16
for the other router.

20 When the router is in user EXEC mode, close the HyperTerminal session and disconnect the LMF
computer and additional components from the BTS router.
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BTS Router Canned Configuration File

This section presents listings of the blue and red router canned
configuration file contents for the MWR 1941 BTS routers. The blue
router is the primary router on the BTS LAN subnet 192.168.146.0, and
the red router is the primary on BTS LAN subnet 192.168.147.0. The
canned configuration files allow communication with the BTS routers
for both on–site FE cabling connectivity verification and for
downloading the routers from the network with the full, site–specific
operational configuration.

Obtaining the Latest Configuration File Content

The files included here are for example only. The correct canned
configuration file content for each BTS router should be generated at the
OMC–R using the /screl/active/bin/gen_btsrtr_canned_config.ksh script.

Configuration File Examples

Examples of both configuration files are provided in the following
subsections.

J
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“Blue” BTS Router Canned Configuration

! Canned Config file for BTSRTR1

version 12.2
service timestamps debug uptime
service timestamps log uptime
no service password–encryption
!
hostname BTSRTR1
!
no logging console
!
!
ip subnet–zero 
ip classless
ip pim bidir–enable
!
disable–eadi

!
redundancy
  mode y–cable
    standby use–interface Loopback101 health
    standby use–interface Loopback102 revertive
    standby use–interface Multilink1 backhaul

interface loopback 101
  description  BTSRTR health loopback
  no ip address  

interface loopback 102
  description  BTSRTR revertive loopback
  no ip address  
!
! configure 1 DS0 for BTSRTRLINK
!
controller T1 0/0
  description  1st span on BTSRTR
  framing esf
  linecode b8zs
  cablelength short 133
  clock source line
  channel–group 0 timeslots 1–24 speed 64

! MLPPP bundle with BTSRTRLINK.
! This performs IPCP with RPM when BTSRTR is rebooted
interface Multilink 1
  ip address negotiated
  no ip route–cache
  no cdp enable
  ppp multilink
  multilink–group 1
  no shutdown
!
! Setup Serial Interface for PPP and IPCP, no MLPPP at this time
!
interface Serial0/0:0
  no ip address
  encapsulation ppp
  keepalive 1
  ppp multilink
  multilink–group 1
  no shutdown

!J
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! Setup Ethernet Interfaces and HSRP between them
!
interface FastEthernet0/0
  ip address 192.168.146.1 255.255.255.0
  keepalive 1
  speed 100
  full–duplex
  standby 1 timers 1 3
  standby 1 preempt
  standby 1 priority 100
  standby 1 ip 192.168.146.3 
  standby 1 name one
  standby 1 track Fa0/1 10
  standby 1 track Multilink1 10
  ! Track the MWR 1941 health interface
  standby 1 track Loopback101 10
  ! Track the MWR 1941 revertive (compensation) interface
  standby 1 track Loopback102 5
  no shutdown
!
interface FastEthernet0/1
  ip address 192.168.147.1 255.255.255.0
  keepalive 1
  speed 100
  full–duplex
  standby 2 timers 1 3
  standby 2 preempt
  standby 2 priority 100
  standby 2 ip 192.168.147.3
  standby 2 name two
  standby 2 track Fa0/0 10
  standby 2 track Multilink1 10
  ! Track the MWR 1941 health interface
  standby 2 track Loopback101 10
  ! Track the MWR 1941 revertive (compensation) interface
  standby 2 track Loopback102 5
  no shutdown

!
! Set a default route to RPM thru BTSRTRLINK
!
ip route 0.0.0.0 0.0.0.0 Multilink 1
!

line con 0
 exec–timeout 15 0
 password cisco
line aux 0
 login 
 password cisco
line vty 0 4
 login 
 password cisco

end
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“Red” BTS Router Canned Configuration

! Canned Config file for BTSRTR2

version 12.2
service timestamps debug uptime
service timestamps log uptime
no service password–encryption
!
hostname BTSRTR2
!
no logging console
!
!
ip subnet–zero 
ip classless
ip pim bidir–enable
!
disable–eadi

!
redundancy
  mode y–cable
    standby use–interface Loopback101 health
    standby use–interface Loopback102 revertive
    standby use–interface Multilink1 backhaul

interface loopback 101
  description  BTSRTR health loopback
  no ip address  

interface loopback 102
  description  BTSRTR revertive loopback
  no ip address  
!
! configure 1 DS0 for BTSRTRLINK
!
controller T1 0/0
  description  1st span on BTSRTR
  framing esf
  linecode b8zs
  cablelength short 133
  clock source line
  channel–group 0 timeslots 1–24 speed 64

! MLPPP bundle with BTSRTRLINK.
! This performs IPCP with RPM when BTSRTR is rebooted
interface Multilink 1
  ip address negotiated
  no ip route–cache
  no cdp enable
  ppp multilink
  multilink–group 1
  no shutdown
!
! Setup Serial Interface for PPP and IPCP, no MLPPP at this time
!
interface Serial0/0:0
  no ip address
  encapsulation ppp
  keepalive 1
  ppp multilink
  multilink–group 1
  no shutdown

!J
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! Setup Ethernet Interfaces and HSRP between them
!
interface FastEthernet0/0
  ip address 192.168.146.2 255.255.255.0
  keepalive 1
  speed 100
  full–duplex
  standby 1 timers 1 3
  standby 1 preempt
  standby 1 priority 100
  standby 1 ip 192.168.146.3 
  standby 1 name one
  standby 1 track Fa0/1 10
  standby 1 track Multilink1 10
  ! Track the MWR 1941 health interface
  standby 1 track Loopback101 10
  ! Track the MWR 1941 revertive (compensation) interface
  standby 1 track Loopback102 5
  no shutdown
!
interface FastEthernet0/1
  ip address 192.168.147.2 255.255.255.0
  keepalive 1
  speed 100
  full–duplex
  standby 2 timers 1 3
  standby 2 preempt
  standby 2 priority 100
  standby 2 ip 192.168.147.3
  standby 2 name two
  standby 2 track Fa0/0 10
  standby 2 track Multilink1 10
  ! Track the MWR 1941 health interface
  standby 2 track Loopback101 10
  ! Track the MWR 1941 revertive (compensation) interface
  standby 2 track Loopback102 5
  no shutdown

!
! Set a default route to RPM thru BTSRTRLINK
!
ip route 0.0.0.0 0.0.0.0 Multilink 1
!

line con 0
 exec–timeout 15 0
 password cisco
line aux 0
 login 
 password cisco
line vty 0 4
 login 
 password cisco

end
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Preparation for Site Turn–over
Prepare the BTS site for turn–over to the control of the OMC–R by
performing the procedures in Table J-18 and Table J-19.

Table J-18: Prepare for Site Turn–over

Step Action

1 After disconnecting it from the BTS router, shut down the LMF computer.

2 If any additional external support equipment was used during the installation process, shut it down,
disconnect it from the frame.

3 Account for all tools used and parts removed from the frame during the installation, being sure none
were left inside the frame.

4 Visually inspect the frame for any foreign objects left inside, and remove any discovered.

5 Visually inspect all cable connections, ensuring they are connected as required for normal BTS
operation.

6 Be sure all internal frame cables are routed and secured to prevent damage to them when the frame
doors are closed.

7 Be sure all external frame and BTS router cables are routed and secured so they will not interfere with
normal maintenance and operational activities at the site.

8 Be sure the BTS routers are powered up and not reporting alarms other than span alarms.

 

Returning the Site to OMC–R Control

Follow the procedure in Table J-19 to return the site to OMC–R control.

Table J-19: Returning the Site to Operational Control

Step Action

1 Contact the OMC–R, and notify the operator the installation is complete. Request notification from
the operator when the routers have been downloaded with the full site–specific configurations and are
verified as functioning normally.

2 When notified router operation has been verified and the OMC–R can assume control of the site,
perform the following:

2a – On any frames which were opened, close and secure the cabinet doors.

2b – Verify no alarm conditions are being reported to the OMC–R with the frame doors closed.

2c – Prepare all equipment, tools, and parts removed from the frame for transport from the site.

 

What to Do Next

The installation of the Packet Backhaul option is complete. When the
site is secured, there are no further actions to perform at the BTS site.
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Numbers
10BaseT/10Base2 Converter, 1-8

LMF to BTS connection, 3-17

1700 MHz Center Frequencies, Calculating, E-8

1700 MHz PCS Channels, E-7

1900 MHz Center Frequencies, Calculating, E-3

1900 MHz PCS Channels, E-2

2–way Splitter, 1-11

3C–PC–COMBO CBL, 1-8

800 MHz CDMA Channels, E-5

800 MHz Center Frequencies, Calculating, E-5

A
ACTIVE LED

GLI2, 6-23
MCC, 6-27

Advantest R3267 Spectrum Analyzer GPIB Address,
F-8

Advantest R3465, 3-57
Calibrating Test Cable, F-24

Advantest R3465 Communications Test Set GPIB
Address, F-12

Advantest R3562 Signal Generator GPIB Address,
F-9

Agilent 8935 Series E6380 (formerly HP 8935) Test
Set GPIB Address, F-10

Agilent E4406A, calibration, F-27

Agilent E4406A Transmitter Tester GPIB Address,
F-6

Agilent E4432B Signal Generator GPIB Address, F-7

Alarm Connector Location/Pin Numbering SC
4850/4850E, 3-121

ALARM LED, GLI2, 6-23

Alarm Monitor window, 3-120

alarm redundancy tests, BBX2, 3-114

Alarm Reporting Display, 3-120

Alarm tests, redundancy, 3-109

Alarm/Redundancy Tests, Distribution Shelf, 3-113

All Cal/Audit procedure, 3-92

All Cal/Audit Test, 3-97

AMR, No control, 6-17

AMR CDI Alarm Input Verification, test data sheets,
A-18

Ancillary Equipment Frame identification, 1-15

Ancillary frame, when to optimize, C-2

Antenna Map, 3-104

ATP, 4-2
generate report, 4-16
Report, 4-16
test matrix/detailed optimization, C-3
Test Prerequisites, 4-5
Test Procedure, 4-9

Automated Acceptance Test Procedure, 4-2

B
Backplane DIP switch settings, 2-4

Bay Level Offset calibration failure, 6-7

BBX2
alarm redundancy tests, 3-114
Connector, 6-15
gain set point vs BTS output considerations, D-2
No control in the shelf, 6-17

BLO
Calibration, 3-85
Calibration Audit, 3-94
calibration data file, 3-86
Calibration Failure, 6-7
Download, 3-94

BTS
Ethernet LAN interconnect diagram, 3-33
LMF connection, 3-16, 3-17
system software download, 3-4
test data sheets, redundancy/alarm tests, A-17
when to optimize, C-2

BTS frame
DC Distribution Pre–test, 2-10
DC Power Pre–test, 2-8
initial power–up, 2-15

BTS login, GUI environment, 3-26

BTS router communication session, establishing, J-6

BTS router connections, programming, J-7

Create CAL File, 3-98

C
C–CCP Backplane, Troubleshooting, 6-14, 6-15



Index68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP Index-3

C–CCP Shelf, 1-21
Site Serial Number Check List, A-19

Cable
GPIB, 1-10
LAN Cable, 1-10
Null Modem, 3-45
Setting Loss Values, 3-83
Timimg Reference, 1-10

Cable Calibration
HP8921 with HP PCS Interface (HP83236), F-19
Manual, F-19

cable calibration, automatic, test set–up
Agilent 8935, 3-61
Agilent E4406A/E4432B, 3-63

CAL File, 3-98

Calculating Center Frequencies
1700 MHz, E-8
1900 MHz, E-3
800 MHz, E-5

Calibrate Test Cabling
Communications System Analyzer, 3-80
Signal Generator & Spectrum Analyzer, 3-81

Calibrating, Test Equipment, 3-78

Calibrating Cables, Overview, 3-79

Calibrating Test Cable, Advantest R3465, F-24

Calibration
BLO, 3-85
Cable, 1-6
data file, BLO, 3-86
In–Service, H-16
RF Path, Test Equipment Setup, 3-89
RFDS, 3-106
Test Equipment, 1-6
TX Path, 3-86, 3-89

Test Cable Calibration, 1-6

Test Equipment Calibration, 1-6

Calibration Audit Failure, Troubleshooting, 6-8

Cannot communicate to Communications Analyzer,
6-4

Cannot communicate to Power Meter, 6-3

Cannot download CODE to any device card, 6-5

Cannot Download DATA to any device card, 6-5

Cannot ENABLE device, 6-6

Cannot load BLO, 6-8

Cannot Log into cell–site, 6-3

Cannot perform Code Domain Noise Power
measurement, 6-10

Cannot perform Rho or pilot time offset
measurement, 6-9

Cannot perform Txmask measurement, 6-9

CDF, 3-3
site equipage verification, 3-4
site type and equipage data information, 2-2

CDI Alarm
with Alarms Test Box, 3-122
without Alarms Test Box, 3-124

Cell Site
equipage verification, 2-2
preliminary operations, 2-2
types, 3-3

Cell Site Data File. See CDF

CF Memory Card, J-13
Load, J-15, J-29

Channel elements, No or missing, 6-18

Channels
1700 MHz, E-7
1900 MHz, E-2
800 MHz, E-5

Checksum Failure, 6-12

CIO, Connectors, 6-15

CLI, 3-25
Format Conventions, 3-25
Logging Out, 3-30

Clock Sync Module. See CSM

Cobra RFDS
external housing, 1-35
RF connector panel detail, 1-35

Code Domain Power, 4-7

Code Domain Power and Noise Floor Measurement
Failure, Troubleshooting, 6-10

Code Download Failure, Troubleshooting, 6-5

Command Line Interface, 3-25

command terminal, settings, J-3

Common power supply verification, 2-14

Communications Analyzer Communication Failure,
Troubleshooting, 6-4

communications test set, TX acceptance tests, 4-6

configure tftp server application, J-19

Connect LMF computer to BTS router, J-19

Connector Functionality, Backplane,
Troubleshooting, 6-14
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Copy and Load Cal File to to CBSC, 5-2

Copy CAL Files From Diskette to the CBSC, 5-3

Copy CBSC CDF Files to the LMF, 3-11

Copying CAL files from CDMA LMF to the CBSC,
5-2

Copy CAL files to the CBSC, 5-3

CSM
Clock Source, 3-40
clock source, select, 3-40
Enable, 3-41
frequency verification, 3-45
functions, 3-43
LEDs, 3-43
MMI terminal connection, illustration, 3-47
redundancy/alarm tests, 3-116
Reference Source Configuration Error, 6-12
Troubleshooting, 6-12, 6-13

CSM clock source, select, 3-40

CyberTest, 3-57

D
Data Download Failure, Troubleshooting, 6-5

DC Power Pre–test
+27 V BTS frame detail, 2-8
–48 V BTS frame detail, 2-10
BTS Frame, 2-6
RFDS, 2-12
RFDS detail, 2-12

DC Power Problems, 6-19

DC/DC Converter, LED Status Combinations, 6-21

Device Enable (INS) Failure, Troubleshooting, 6-6

Digital Control Problems, C–CCP Backplane
Troubleshooting, 6-16

Digital Multimeter, 1-10

Directional Coupler, 1-10

Distribution shelf, alarm/redundancy tests, 3-113

Download
BLO, 3-94
BTS, 3-35
BTS system software, 3-4
Non–MGLI2 Devices, 3-39
ROM Code, G-2

Download/Enable MGLIs, 3-38

E
E1, isolate BTS from the E1 spans, 3-15

E4406A, calibration, F-27

Enable
CSMs, 3-41
MCCs, 3-42
Redundant GLIs, 3-42

Equipment setup, VSWR, HP Test Set, I-3

Ethernet LAN
interconnect diagram, 3-33
Transceiver, 1-8

Ethernet maintenance connector interface, illustration,
3-17

External Test Equipment Removal, 5-4

F
Folder Structure Overview, 3-7

Foreword, xxi

Frame Error Rate, 4-8

FREQ Monitor Connector, CSM, 6-23

Frequency counter, optional test equipment, 1-11

Frequency Spectrum
Korean PCS (1700 MHz), E-7
North American Cellular Telephone System (800

MHz), E-5
North American PCS (1900 MHz), E-2

G
Gain set point, BBX, D-2

General Safety, xxiii

Generating an ATP Report, 4-16

General optimization checklist, test data sheets, A-5

Gigatronics 8541C Power Meter GPIB Address, F-15

Gigatronics Power Meter, 3-57

GLI. See Master (MGLI2) and Slave (SGLI2) Group
Line Interface

GLI2
Connector, 6-15
Ethernet Connections, 6-15
LED Status, 6-23
No Control through span line connection, 6-16
No Control via LMF, 6-16

GPIB, set address, HP 437B, F-14

GPIB Cable, 1-10
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GPIB Address
Advantest R3267, F-8
Advantest R3465, F-12
Advantest R3562, F-9
Agilent (formerly HP) 8935, F-10
Agilent E4406A, F-6
Agilent E4432B, F-7
Gigatronics 8541C Power Meter, F-15
Hewlett Packard HP8921a & HP83236A/B, F-11
Motorola CyberTest, F-13

GPIB Interface Box, RS232, F-16

GPS
Initialization/Verification, 3-48
receiver operation, test data sheets, A-6
redundancy alarm tests, 3-116
Test Equipment Setup, 3-46

GPS Bad RX Message Type, 6-12

GPS satellite system, 3-41

Graphical User Interface, 3-19

GUI, 3-19
Logging Out, 3-29

H
Hardware Requirements, 1-7

Hewlett Packard HP8921A and HP83236A/B GPIB
Address, F-11

High Stability 10 MHz Rubidium Standard, 1-11

High–impedance Conductive Wrist Strap, 1-10

HP 437, setting GPIB address, F-14

HP 437B, 3-57

HP 83236 A, F-19

HP 83236A, F-18

HP 8921, 3-57

HP 8921A, System Connectivity Test, F-18

HP 8935, 3-57

HP PCS Interface Test Equipment Setup for Manual
Testing, F-23

HP Test Set, VSWR, I-3

HSO
Initialization/Verification, 3-54
redundancy/alarm tests, 3-116

HSO Initialization/Verification, 3-44

HyperTerminal Connection, Creating, 3-13

I
I and Q values, B-2

In–Service Calibration, H-13, H-16

Individual ATP Test Background
Code Domain Power/Noise Floor, 4-13
Pilot Time Offset, 4-13
RX Frame Error Rate (FER), 4-14
Tx Mask, 4-11
Waveform Quality (Rho), 4-12

Initial Installation of Boards/Modules, preliminary
operations, 2-3

Initial power tests, test data sheets, A-4

Initial power–up
BTS frame, 2-15
RFDS, 2-15

Initialization/Verification
GPS, 3-48
HSO, 3-54
LFR, 3-52

Inter–frame cabling, when to optimize, C-3

IOS Version Verification, J-13

IP Addresses, Agilent E7495A, 3-75

IS–97 specification, B-2

ISB connectors, 6-14

Isolation, T1/E1 Span, 3-15

Itasca Alarms Test Box, 1-11

L
LAN

BTS frame interconnect, illustration, 3-33
Tester, 1-11

LAN Connectors, GLI2, 6-24

LED, CSM, 3-43

LED Status, 6-21
BBX2, 6-27
CSM, 6-22
DC/DC Converter, 6-21
GLI2, 6-23
LPA, 6-28
MCC, 6-27

LFR
Initialization / Verification, 3-52
receiver operation, test data sheets, A-7
redundancy/alarm tests, 3-116

LFR/HSO, Test Equipment Setup, 3-46

LIF, Load Information File, 3-9
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Line Build Out parameters
configure, 5-6
verify, 5-5

LMF, 3-6
1X FER acceptance test, 4-6
BTS connection, 3-17
Ethernet maintenance connector interface detail,

illustration, 3-17
Installation and Update Procedures, 3-10
platform requirements, 1-7
to BTS connection, 3-16, 3-17
TX acceptance tests, 4-6

LMF BTS displays, 3-19

LMF computer and software, 1-7

LMF Operation, 3-18

LMF Removal, 5-8

Load Information File, 3-9

Loading Code, 3-35

Local Maintenance Facility. See LMF

Logging In to a BTS, 3-26

Logging Out, 3-29
CLI, 3-30
GUI, 3-29

Logical BTS, 1-15
Numbering, 1-16

Login, GUI, 3-26

Login Failure, Troubleshooting, 6-3

LPA
redundancy test, 3-118
test data sheets

convergence, A-9
IM Reduction, A-8

LPA Module LED, 6-28

LPAs, Site Serial Number Check List, A-20

M
Manual, overview, 1-3

Manual Scope and Layout, 1-2

MASTER LED, GLI2, 6-23

MCC, Enable, 3-42

MGLI, redundancy test RFM frame, 3-119

MGLI2, board detail, MMI port connections, 5-6

Miscellaneous errors, Troubleshooting, 6-6

MMI Connection, 3-31

MMI Connector
CSM, 6-23
GLI2, 6-24
MCC, 6-27

MMI equipment setup, 3-32

 MMI Interface Kit, 1-9

Module status indicators, 6-21

Motorola CyberTest GPIB Address, F-13

Multi–FER test Failure, Troubleshooting, 6-11

N
NAM, Valid Ranges, 3-103

NECF, 3-3

No DC input voltage to  Power Supply Module, 6-19

No DC voltage +5 +65 or +15 Volts to a specific
GLI2 BBX2 or Switch board, 6-20

No GPS Reference Source, 6-12

Non–GLI2, Download, 3-39

Null Modem Cable, 3-45

O
Online Help, 3-32

Optimization
Process, 3-2
purpose, 1-4
When, 1-5

Optional Test Equipment, 1-11
frequency counter, 1-11

Oscilloscope, 1-11

P
PA Shelves, 1-22

PCMCIA, Ethernet adapter, LMF to BTS connection,
3-17

Pilot Gain, 4-12, 4-13, 4-14

Pilot Time Offset, 4-7

Pin/Signal Information for ARM A Cable, 3-126

Ping, 3-33

PN Offset
programming information, B-2
usage, B-2

PnMask, I and PnMask Q Values, B-3

Power Conversion Shelf (–48 V BTS Only), Site
Serial Number Check List, A-20
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Power Delta Calibration
Advantest, H-5
HP8921A, H-3
HP8935, H-8

Power Input, 6-14

Power Meter, setting GPIB address, HP437B, F-14

Power meter, TX acceptance tests, 4-6

Power Meter Communication Failure,
Troubleshooting, 6-3

Power supply, converter redundancy, 3-111

Power Supply Module Interface, 6-15

power supply/converter redundancy, 3-111

Pre–power tests, test data sheets, A-4

Preliminary operations
cell Site types, 2-2
test data sheets, A-3

Prepare to Leave the Site
BTS Site Span Configuration Verification, 5-5
External Test Equipment Removal, 5-4

Procedures to Copy Files to a Diskette, 5-2

Pushbuttons and Connectors, GLI2, 6-24

PWR/ALM LED
BBX2, 6-27
CSM, 6-22
DC/DC Converter, 6-21
generic, 6-21
MCC, 6-27

R
RDM, 6-14

Reduced ATP, 4-3, 6-9

redundancy/alarm tests, 3-109

Redundant GLIs, Enable, 3-42

Reference Distribution Module, 6-14

Required documents, 1-12

Required test equipment, communications system
analyzer, 1-9

Required Test Equipment and Software, 1-6

RESET Pushbutton, GLI2, 6-24

Revision History, xxv

RF
Adapters, 1-10
Attenuators, 1-10
Load, 1-10

RF Path Calibration, 3-89

RFDS
Calibration, 3-106
DC Power Pre–test, 2-12
Description, 3-99
initial power–up, 2-15
Layout, 1-35
Parameter Settings, 3-99
Set Configuration Data, 3-105

RFDS calibration, procedure, 3-107

RFDS parameters
checking, 3-100
setting, 3-100

RFDS TSU Calibration Channel Frequencies, 3-106

rho, 4-7

ROM Code, Download, G-2

router configuration, initial , J-20

Router Configuration Files, Canned, J-8

Router Initial Configuration, J-2

router power–up, J-20

Router Serial Communication, J-5

RS–232 to GPIB Interface, 1-8

RS232 GPIB Interface Box, F-16

RX, antenna VSWR, test data sheets, A-18

RX Acceptance Tests, Frame Error Rate, 4-8

S
Sector Configuration, 1-30

Selecting Test Equipment, 3-75

Set Antenna Map Data, 3-104

Set RFDS Configuration Data, 3-105

Set–up for TX Calibration, 3-91

Setting Cable Loss Values, 3-83

Setting TX Coupler Loss Value, 3-84

SGLI2, board detail, MMI port connections, 5-6

Shelf Configuration Switch, 2-4

Signal Generator, 3-82

signal generator, 1X FER acceptance test, 4-6

Site, equipage verification, 3-4
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Site checklist, data sheets, A-3

Site equipage, CDF/NECF, 3-3

Site I/O board, T1 span cable connection, 5-9

Site Serial Number Check List, A-19

Software Release caveats, 5-2

Span Framing Format
configure, 5-6
verify, 5-5

Span I/O board
E1 span isolation, illustration, 3-15
T1 span isolation, illustration, 3-15

Span Line
connector , 6-14
T1/E1 Verification Equipment, 1-11

Span line, troubleshooting, 6-29

Span line configuration, troubleshooting, 6-32

Span line traffic, No or missing, 6-17

SPANS LED, GLI2, 6-24

Spectral Purity TX Mask, 4-7

Spectrum Analyzer, 1-11, 3-82

Spectrum Analyzer , HP8594E, 3-57

STATUS LED, GLI2, 6-24

SYNC Monitor Connector, CSM, 6-23

System Connectivity Test, HP8921A, F-18

T
T1

isolate BTS from the T1 spans, 3-15
span connection, 5-9

terminal communication settings, J-3

Test data sheets
AMR CDI Alarm Input Verification, A-18
BTS redundancy/alarm tests, A-17
general optimization checklist, A-5
GPS receiver operation, A-6
initial power tests, A-4
LFR receiver operation, A-7
LPA

convergence, A-9
IM Reduction, A-8

pre–power tests, A-4
preliminary operations, A-3
RX antenna VSWR, A-18
site checklist, A-3
TX antenna VSWR, A-17
TX BLO

Offset/Power Output Verification, A-10
Power Output Verification, A-15

Test Equipment
Automatically Selecting, 3-77
Calibrating, 3-78
Connecting test equipment to the BTS, 3-56
Manually Selecting, 3-76
Reference Chart, 3-58
Selecting, 3-75
verification data sheets, A-2
VSWR, I-2

Test equipment
system analyzer, 1-9
TX acceptance tests, 4-6

Test Equipment Setup, 3-56
GPS & LFR/HSO, 3-46
HP PCS Interface, F-23
RF path  calibration, 3-89

Test Matrix, C-4
ATP optimization, C-3

Timing Reference Cables, 1-10

Top Interconnect Plate, 1-21
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Troubleshooting
BBX2 Control Good – No (or Missing) Span Line

Traffic, 6-17
BLO Calibration Failure, 6-7
C–CCP Backplane, 6-14, 6-15
Calibration Audit Failure, 6-8
Code Domain Power and Noise Floor Measurement

Failure, 6-10
Code Download Failure, 6-5
Communications Analyzer Communication Failure,

6-4
CSM Checklist, 6-12
Data Download Failure, 6-5
DC Power Problems, 6-19
Device Enable (INS) Failure, 6-6
Login Failure, 6-3
MGLI2 Control Good – No Control over AMR,

6-17
MGLI2 Control Good – No Control over

Co–located GLI2, 6-16
Miscellaneous Failures, 6-6
Multi–FER Failure, 6-11
No BBX2 Control in the Shelf – No Control over

Co–located GLI2s, 6-17
No DC Input Voltage to any C–CCP Shelf Module,

6-20
No DC Input Voltage to Power Supply Module,

6-19
No GLI2 Control through Span Line Connection,

6-16
No GLI2 Control via LMF, 6-16
No MCC24 Channel Elements, 6-18
Power Meter Communication Failure, 6-3
Rho and Pilot Time Offset Measurement Failure,

6-9
Set span configuration, 6-32
span problems, 6-29
TX and RX Signal Routing, 6-20
TX Mask Measurement Failure, 6-9

TSU NAM
Parameters, 3-102
Program, 3-108

TX
acceptance tests, equipment setup, 4-6
antenna VSWR, test data sheets, A-17

TX & RX Path Calibration, 3-85

TX and RX Frequency vs Channel
1700 MHz, E-8
1900 MHz, E-3
800 MHz, E-5

TX and RX Signal Routing, C–CCP Backplane
Troubleshooting, 6-20

TX ATP Setup, 3-72

TX Audit Test, 3-95

TX BLO, test data sheets
Offset/Power Output Verification, A-10
Power Output Verification, A-15

Tx BLO Nominal Offset, Setup for TX Cal, 3-91

TX calibration, 3-92
All Cal/Audit, 3-92
set–up, Agilent 8935, 3-65, 3-68

RX Frame Error Rate (FER) ATP Background, 4-14

TX Code Domain Power/Noise Floor ATP
Background, 4-13

TX Mask Verification, spectrum analyzer display,
illustration, 4-12

TX OUT connection, 4-5

TX Output Acceptance Tests
Code domain power, 4-7
Pilot Time Offset, 4-7
Spectral purity TX mask, 4-7
Waveform quality (rho), 4-7

TX Path, calibration, 3-86

TX path
audit, 3-95
calibration, 3-89

TX path calibration, 3-92

TX Pilot Time Offset ATP Background, 4-13

TX Spectral Purity (Tx Mask) ATP Background, 4-11

TX Waveform Quality (Rho) ATP Background, 4-12

U
Updating Calibration Data Files

Copy and Load Cal File to to CBSC, 5-2
Software Release caveats, 5-2

UTP, LMF to BTS connection, 3-17

V
Verification of Test Equipment, data sheets, A-2

Verify GLI ROM code load, 3-37

Voltage Standing Wave Ratio. See VSWR

VSWR
Advantest Test Set, I-5
Calculation, I-4, I-6
Equation, I-4, I-6
manual test setup detail

Advantest illustration, I-7
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HP illustration, I-4, I-5
required test equipment, I-2
transmit and receive antenna, I-2

W
Walsh channels, 4-13

Warm–up, 1-7

Waveform Quality (rho), 4-7

When to optimize
Ancillary – table, C-2
BTS, C-2
inter–frame cabling, C-3

X
Xircom Model PE3–10B2, LMF to BTS connection,

3-17
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